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Intended Readers
This guide is intended for use by the Administrators and Operators of NovaScale 5xx5/6xx5

Servers.

Chapter 1.  Introducing the Server
describes server hardware components and user environment.

Chapter  2.   Getting Started
explains how to connect to and use the server.

Chapter 3.  Managing Domains
describes how to perform straightforward server domain management tasks.

Chapter 4.  Monitoring the Server
explains how to supervise server operation.

Chapter 5. Tips and  Features for Administrators
explains how, as Customer Administrator, you can configure the server to suit your
environment.

Appendix A. Specifications

Appendix B. Server Cabling

Appendix C. Error Messages and Recovery Information

Highlighting
The following highlighting conventions are used in this guide:

Bold Identifies predefined commands, subroutines, keywords, files,
structures, buttons, labels, and icons.

Italics Identifies referenced publications, chapters, sections, figures,
and tables.

<         > Identifies parameters to be supplied by the user.

Abbreviations, acronyms and concepts are documented in the Glossary.
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Related Publications
Site Preparation Guide, 86 A1 87EF 
explains how to prepare a Data Processing Center for Bull NovaScale Servers, in
compliance with the standards in force. This guide is intended for use by all personnel
and trade representatives involved in the site preparation process.

Installation Guide, 86 A1 40EM
explains how to set up and start NovaScale 5xx5/6xx5 Servers for the first time. This
guide is intended for use by qualified support personnel.

Maintenance and Service Guide, 86 A7 42EM
explains how to maintain, service, and upgrade NovaScale 5xx5/6xx5 Servers. This
guide is intended for use by qualified support personnel.

Troubleshooting Guide, 86 A7 91EF
explains how to diagnose and solve any problems occurring during Bull NovaScale
Server operation. This guide is intended for use by qualified support personnel.

Bull 1300H/L & 1100H/L Cabinets, 86 A1 91EM
explains how to install and fit out rack cabinets for Bull NovaScale Servers and peripheral
devices.

Documentation Overview, 86 A2 27EM
describes the hardware, software and online documentation available for Bull NovaScale
Servers, related Operating Systems, and licensed programs.

 Note:
According to server configuration and version, certain features and functions described in
this guide may not be accessible. Please contact your Bull Sales Representative for sales
information.
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Regulatory Specifications and Disclaimers

Declaration of the Manufacturer or Importer
We hereby certify that this product is in compliance with European Union EMC Directive
89/336/EEC, using standards EN55022 (Class A) and EN55024 and Low Voltage Directive
73/23/EEC, using standard EN60950. The product has been marked with the CE Mark to
illustrate its compliance.

Safety Compliance Statement
• UL 60950 (USA)
• IEC 60950 (International)
• CSA 60950 (Canada)

European Community (EC) Council Directives
This product is in conformity with the protection requirements of the following EC Council
Directives:

Electromagnetic Compatibility

• 89/336/EEC

Low Voltage

• 73/23/EEC

EC Conformity

• 93/68/EEC

Telecommunications Terminal Equipment

• 1999/5/EC

Neither the provider nor the manufacturer can accept responsibility for any failure to satisfy
the protection requirements resulting from a non-recommended modification of the product.

Compliance with these directives requires:

• an EC declaration of conformity from the manufacturer

• an EC label on the product

• technical documentation
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Federal Communications Commission (FCC) Statement

 Note:
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC
emission limits. Neither the provider nor the manufacturer are responsible for any radio or
television interference caused by using other than recommended cables and connectors or
by unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

Any changes or modifications not expressly approved by the grantee of this device could
void the user’s authority to operate the equipment. The customer is responsible for ensuring
compliance of the modified product.

FCC Declaration of Conformity
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Canadian Compliance Statement (Industry Canada)
This Class A digital apparatus meets all requirements of the Canadian Interference Causing
Equipment Regulations.

Cet appareil numérique de la classe A est conforme à la norme NMB–003 du Canada.

This product is in conformity with the protection requirements of the following standards:

Electromagnetic Compatibility

• ICES–003
• NMB–003

Laser Compliance Notice
This product that uses laser technology complies with Class 1 laser requirements.

A CLASS 1 LASER PRODUCT label is located on the laser device.

Class 1 Laser Product

Luokan 1 Laserlaite

Klasse 1 Laser Apparat

Laser Klasse 1
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Definition of Safety Notices

 DANGER
A Danger notice indicates the presence of a hazard that has the potential of causing
death or serious personal injury.

 CAUTION:
A Caution notice indicates the presence of a hazard that has the potential of causing
moderate or minor personal injury.

 Warning: 
A Warning notice indicates an action that could cause damage to a program, device,
system, or data.

Electrical Safety
The following safety instructions shall be observed when connecting or disconnecting
devices to the system.

 DANGER
The Customer is responsible for ensuring that the AC electricity supply is compliant
with national and local recommendations, regulations, standards and codes of
practice.
An incorrectly wired and grounded electrical outlet may place hazardous voltage on
metal parts of the system or the devices that attach to the system and result in an
electrical shock.
It is mandatory to remove power cables from electrical outlets before relocating the
system.

 CAUTION:
This unit has more than one power supply cable. Follow procedures for removal of
power from the system when directed.
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Laser Safety Information
The optical drive in this system unit is classified as a Class 1 level Laser product. The
optical drive has a label that identifies its classification.

The optical drive in this system unit is certified in the U.S. to conform to the requirements of
the Department of Health and Human Services 21 Code of Federal Regulations (DHHS 21
CFR) Subchapter J for Class 1 laser products. Elsewhere, the drive is certified to conform to
the requirements of the International Electrotechnical Commission (IEC) 60825–1: 2001 and
CENELEC EN 60825–1: 1994 for Class 1 laser products.

 CAUTION:
Invisible laser radiation when open. Do not stare into beam or view directly with
optical instruments.

Class 1 Laser products are not considered to be hazardous. The optical drive contains
internally a Class 3B gallium–arsenide laser that is nominally 30 milliwatts at 830
nanometers. The design incorporates a combination of enclosures, electronics, and
redundant interlocks such that there is no exposure to laser radiation above a Class 1 level
during normal operation, user maintenance, or servicing conditions.

Data Integrity and Verification

 Warning: 
Bull NovaScale Servers are designed to reduce the risk of undetected data corruption
or loss. However, if unplanned outages or system failures occur, users are strongly
advised to check the accuracy of the operations performed and the data saved or
transmitted by the system at the time of outage or failure.
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Administrator’s Memorandum

Domains

• Manage Domain Schemes, on page 3-5

• Power ON Domain, on page 3-14

• Power OFF Domain, on page 3-16

• Perform a Manual Domain Reset, on page 3-17

• Perform a Domain Force Power OFF, on page 3-18

• Perform a Domain Memory Dump, on page 3-20

• View Domain Functional Status, on page 3-21

• View Domain Power Logs, on page 3-22

• View Domain Powering Sequences, on page 3-23

• View Domain BIOS Info, on page 3-24

• View Domain Request Logs, on page 3-25

• View Domain Configuration, Resources and Status, on page 3-26

• Modify Domain Configuration, on page 3-33*

• Solve Incidents, on page 3-47

*  Reserved for partitioned servers and extended systems.

Monitoring

• Refresh the PAM Display, on page 4-2

• View CSS Availability Status and System Functional Status, on page 4-4

• View Event Message Status, on page 4-4

• Display Hardware Presence / Functional Status, on page 4-5

• View PAM Web Site User Information, on page 4-10

• View PAM Version Information, on page 4-11

• View Server Hardware Status, on page 4-12

• Use the Hardware Search Engine, on page 4-9

• Display Detailed Hardware Information, on page 4-13

• Exclude / Include Hardware Elements, on page 4-21

• View, Manage PAM Event Messages and History Files, on page 4-24

• Understand Message Severity Levels, on page 4-25

• Consult Event Messages, Hardware Faults List, History Files, on page 4-26

• View, Acknowledge WEB Event Messages, on page 4-27

• Sort and Locate Messages, on page 4-28

• View, Archive, Delete History / Archive files, on page 4-29

• Solve Incidents, on page 4-35
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Configuration

• Set up Server Users, on page 5-4

• Use the EFI Boot Manager, on page 5-12

• Use the EFI Shell, on page 5-14

• Set Up and Configure the EFI Network, on page 5-18

• Set up PAP Unit Users, on page 5-21

• Modify Customer Information, on page 5-21

• Configure PAM Autocall Parameters, on page 5-24

• Customize PAM Settings, on page 5-26

• Deploy a New PAM Release, on page 5-27

• Activate a PAM Version, on page 5-28

• Back Up and Restore PAM Configuration Files, on page 5-30

• Configure Domains, on page 5-32*

• Assess Configuration Requirements, on page 5-35*

• Create, Edit, Copy, Delete, Rename a Domain Scheme, on page 5-36*

• Update Test Schemes, on page 5-41*

• Create, Edit, Copy, Delete a Domain Identity, on page 5-42*

• Configure Extended Systems, on page 5-76*

• Clear, Load, Save NVRAM Variables, on page 5-77*

• Update the LUN List, on page 5-78*

• Limit Access to Hardware Resources, on page 5-79*

• Prepare Scheme, Domain Identity and Resources Checklists, on page 5-80*

• Customize the PAM Event Messaging System, on page 5-85

• Set up Event Subscriptions, on page 5-86

• Event Subscription Flowcharts, on page 5-86

• Create, Edit, Delete an E–mail Server, on page 5-88

• Create, Edit, Delete an E–mail Account, on page 5-90

• Create, Edit, Delete a User History, on page 5-93

• Enable / Disable Event Channels, on page 5-96

• Create, Edit, Delete an Event Subscription, on page 5-98

• Understand Event Message Filtering Criteria, on page 5-100

• Preselect an Event Filter, on page 5-110

• Create, Edit, Delet an Event Filter, on page 5-111

*  Reserved for partitioned servers and extended systems.
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PAM Writing Rules

Illegal Characters
The following table lists the illegal characters that must not be used in PAM identifiers.

Illegal Characters

à, é, è, ù, ^, ¨ Accentuated letters

/ Slash

\ Backslash

“ Double quote

’ Simple quote

‘ Inverted comma

& Ampersand

+ Plus

* Asterisk

% Percent

= Equal sign

< Less–than sign

> Greater–than sign

: Colon

! Exclamation mark

? Question mark

; Semi–colon

, Comma

~ Tilde

I Pipe operator

Space. Use – (dash) or _ (underscore)

Table 1. PAM illegal characters

String Lengths
The following table lists authorized string lengths.

String Type Length

CellBlock / System Name 16

Scheme Name 32

History Name 64

Archive Name 75 (History Name: + 11 (_JJMMAA_nnn)

LUN Name 32

Switch Name 32

Event Name 32

Description 256 (Scheme: unlimited)

Domain Identity Name 16

Table 2. String length rules
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Registry Keys
PAM obtains file paths via 2 registry keys:

• ReleaseRoot:
Contains PAP application file paths (DLL, WEB pages, models,...).
Two versions of PAM software can be installed and used indifferently on the same
machine: each new version is installed in a new directory.

• SiteRoot:
Contains site data file paths.
Site data remains valid when the PAM software version changes.

Registry keys are generally stored under:
HKEY_LOCAL_MACHINE\SOFTWARE\BULL\PAM
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AZERTY/QWERTY Keyboard Lookup Table

Figure 1. AZERTY keyboard

Figure 2. QWERTY keyboard
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Operator’s Memorandum

Domains

• Power ON a Domain, on page 3-14

• Power OFF a Domain, on page 3-16

• Perform a Domain Force Power OFF, on page 3-18

• Perform a Manual Domain Reset, on page 3-17

• Perform a Domain Memory Dump, on page 3-20

• View Domain Functional Status, on page 3-21

• View Power Logs, on page 3-22

• View Domain Powering Sequences, on page 3-23

• View BIOS Info, on page 3-24

• View Domain Request Logs, on page 3-25

• View Domain Configuration, Resources and Status, on page 3-26

• Solve Incidents, on page 3-47

Histories

• View, Manage PAM Event Messages, History Files, on page 4-24

• Understand Event Message and History Severity Levels, on page 4-25

• Consult Event Messages, Hardware Faults List, History Files, on page 4-26

• View, Archive, Delete History / Archive files, on page 4-29

• Sort and Locate messages, on page 4-28

Status

• Check System Functional Status, on page 4-4

• Check CSS  Availability, on page 4-4

• View, Acknowledge WEB Event Messages, on page 4-27

• Sort, Locate WEB event messages, on page 4-28
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Chapter 1. Introducing the Server

This chapter describes the main hardware components and user environment for

NovaScale 5xx5/6xx5 Servers. It includes the following topics:

•  Bull NovaScale Server Overview, on page 1-2

• Accessing Server Components, on page 1-20

• Bull NovaScale Server Resources, on page 1-22

• PAM Software Package, on page 1-22

• EFI Utilities, on page 1-23

 Note:
Customer Administrators and Customer Operators are respectively advised to consult the
Administrator’s Memorandum, on page xxi or the  Operator’s Memorandum, on page xxvi for
a detailed summary of the everyday tasks they will perform.
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Bull NovaScale Server Overview
Bull NovaScale Servers for business and scientific applications are based upon the FAME
architecture (Flexible Architecture for Multiple Environments), leveraging the latest
generation of Intel� Itanium� 2 processors.

NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain englobing all the hardware and software resources
managed by the Operating System.

NovaScale 6xx5 Servers are designed to operate as one or two hardware–independent
SMP systems or domains, each running an Operating System instance and a specific set of
applications.

According to version, servers are delivered rack–mounted and ready–to–use in high or low
cabinets.

Figure 3. Bull NovaScale Server cabinets

Dynamic Partitioning
Bull NovaScale 6000 Series servers can be dynamically partitioned into physically
independent ccNUMA (Cache Coherent Non Uniform Memory Access) SMP systems or
domains, each running an Operating System instance and a specific set of applications.
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Extended Configurations
Several Bull NovaScale Servers may be administered through a single instance of PAM
software.

Cluster Configurations
Several Bull NovaScale Servers may be grouped to act like a single system, enabling high
availability, load balancing and parallel processing.
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Server Features
The main features of Bull NovaScale Servers are:

Intel� Itanium� Processor Family architecture:

– Modularity, predictable performance and growth

High availability:

– Component redundancy

– Capacity to isolate or replace a faulty component without service disruption

– Global and unified system visibility

– Round–the–clock operation

Scalability:

– Dynamic partitioning

– Power on demand : capacity to dynamically adapt resources to load requirement

Simultaneous support of multiple environments:

– Microsoft� Windows� Server

– Linux�

High performance computing capabilites:

– Business Intelligence:

. Datawarehousing

. Datamining

– Large enterprise applications:

. ERP

. CRM

. SCM ...

– Large database applications for Internet transactions.

– Large business sector applications:

. Online billing

. Online reservations

. Online banking ...

Built–in Platform Administration and Maintenance (PAM) software suite:

– Proactive administration

– Optimization of resources

– Automatic generation of corrective actions and calls to support centers

– Dynamic configuration

Bull NovaScale Master System Management (NSM) software suite:

– Windows, Linux, and Platform management

– Monitoring, Information, Control, and Event Handling

– Client / Server / Agent architecture

– WEB standard OpenSource solutions
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Server Hardware

 Note:
Abbreviations and acronyms are documented in the Glossary.

Main server hardware components are:

Central SubSystem Module (CSS Module)
Main server hardware components are housed in the CSS Module. For easy access and
servicing, the CSS Module is composed of three interconnected units:

Front Unit Core Unit Rear Unit

1 or 2 QBBs 1 MQB 1 or 2 IOCs

1 or 2 Internal Peripheral Drawers 1 MIO 1 or 2 IOLs

2 MSXs 1 PMB

1 MFL 2 or 4 DPS Units

8 Fanboxes

 Notes:

• The NovaScale 6xx5 Server CSS Module can be logically divided into two Cells, each
with one QBB and one IOC, to allow dynamic partitioning.

• The NovaScale 6165 Server is equipped with two inter–connected CSS modules.

Front Unit

Quad Brick Block (QBB)

The QBB is equipped with 1 to 4 Itanium[  2 processors and 16 DDR DIMMs. The QBB
communicates with the rest of the system the high–speed bidirectional link Scalability Port
Switches (SPS) located on the MSX.

Internal Peripheral Drawer (IPD)

The Internal Peripheral Drawer is equipped with a DVD/CD ROM drive and a USB port. The
Internal Peripheral Drawer is connected to the MQB in the Core Unit via a Device Interface
Board (DIB). Optionally, the Internal Peripheral Drawer can house 2 SCSI Disks for OS
partitions or storage.

Core Unit

Midplane QBB Board (MQB)

The QBBs and the Internal Peripheral Drawers are connected to the MQB.

Midplane IO Board (MIO)

The IOCs and the PMB are connected to the MIO.

Midplane SPS & XPS Board (MSX)

Each MSX houses 1 high–speed directional link Scalability Port Switch (SPS) and is
connected to both the MIO and the MQB. Each QBB and IOC communicates with the rest of
the system through the SPS.

Midplane Fan & Logistics Board (MFL)

16 Fans and various logistics components are implemented on the MFL. The MFL is
connected to both the MIO and the MQB.

Fanboxes

8 Fanboxes, each housing 2 fans, provide redundant cooling.
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Rear Unit

IO board Compact (IOC)

The IOC provides 6 x 133 MHz PCI buses for the connection of up to 6 (2 long and 4 short)
PCI–X boards, and a PCI Hot Plug Board (HPB). The IOC communicates with the rest of the
system through the high–speed bidirectional link Scalability Port Switches (SPS) located
on the MSX.

IO board Legacy (IOL)

The IOL is an IOC daughter board providing legacy IO connections: 2 USB ports, 1 LAN
port, 2 serial ports, and 1 video port.

Platform Maintenance Board (PMB)

The PMB concentrates logistics access and links the platform to the Platform Administration
Processor (PAP Unit) running Platform Administration and Maintenance (PAM) software.

Distributed Power Supply (DPS) Unit

Each DPS Unit supplies 48V AC/DC power to the server. The server is equipped with 2 or 4
DPS units for full redundancy.

Platform Administration Processor (PAP) Unit
The PAP Unit hosts all server administration software, in particular Platform Administration
and Maintenance (PAM) software.

KVM Switch
The KVM Switch allows the use of a single keyboard, monitor and mouse for the local
server domains and the local PAM console.

Console
The Console contains the keyboard, monitor and touch pad / mouse used for local access
to the server domains and to the PAP Unit.

Disk Subsystem
If the disk slots in the Internal Peripheral Drawer are not used for OS disk partitions, a SCSI
RAID or FC disk subsystem is required.

Additional Peripherals
Additional peripherals such as disk subsystems, storage area networks, communication
networks, archiving peripherals etc. can be connected to the server via PCI adapters
located in the IOCs. Such peripherals may either be rack–mounted in the server cabinet (if
free space is available) or in external cabinets.

Server Firmware and Software

Operating Systems (OS)

The server is certified for the following Operating Systems:

• Windows Server 2003, Enterprise Edition

• Windows Server 2003, Datacenter Edition

• Linux Red Hat Advanced Server

• Linux SUSE
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BIOS

The BIOS controls the server startup process, dynamic resource allocation (Domain
reconfiguration, hot–plugging), and error handling. The BIOS also includes:

• The Extended Firmware Interface (EFI), which provides the OS with system services.

• The EFI Shell, an autonomous environment used to run Off–line Test & Diagnostic
suites.

Platform Administration and Maintenance (PAM) suite

The PAM Web–based software suite is used to operate, monitor, and configure the server.
PAM can be accessed locally or remotely through Microsoft Internet Explorer or Mozilla
browsers, under the protection of appropriate access rights. PAM provides the
administration functions needed to manage and maintain the server:

• Domain configuration and resource allocation

• Alert or maintenance requests to the Customer Service Center

• Error logging …

Test & Diagnostics suites

The server is delivered with the following T & D suites:

• Online Test & Diagnostic suite

• Offline Test & Diagnostic suite

• Power–On Self–Test suite

NovaScale Master (NSM) Management suite

The NSM software suite allows you to monitor and manage NovaScale Windows and Linux
systems.

Conformance to Standards

Intel

Bull NovaScale Servers conform to all Intel platform standards:

• ACPI (Advanced Configuration and Power Interface)

• IPMI (Intelligent Platform Management Interface)

• EFI (Extended Firmware Interface)

• SMBIOS (System Management BIOS)

• DIG64 (Developer Interface Guide for Intel[  Itanium[  Architecture)

Windows

Bull NovaScale Servers conform to the standards set out in the Windows Hardware Design
Guide.
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Getting to Know the Server

 Note:
Abbreviations and acronyms are documented in the Glossary.

NovaScale 5085 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1 CSS module with core unit, power supply and AC power cable, including: 8 U1

IO Box (IOC) with: 2 IOL board – legacy ports

8 U

IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional FC disk 3 U

16 Free space for additional components (SCSI or FC disks) 4 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 4. NovaScale 5085 Server components (19 U cabinet example)
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NovaScale 5165 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1,
15

CSS module with core unit, power supply and AC power cable, including: 8 U
x2

1,
15 IO Box (IOC) with: 2 IOL board – legacy ports

8 U
x2IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional SCSI disk 2 U

16 Free space for additional components (SCSI or FC disks) 18 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 5. NovaScale 5165 Server components (40U cabinet example)
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NovaScale 6085 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

XXXXXXXX Front     XXXXXXXXXXXXXXXXXXXX Rear

1 CSS module with core unit, power supply and AC power cable, including: 8 U

2xIO Boxes (IOC) each with: 2 IOL board – legacy ports

3 6xPCI hot plug slots (133Mhz)

2xInternal Peripheral Drawers each with: 4 DVD–ROM drive

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional FC disk 3 U

16 Free space for additional components 4 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 6. NovaScale 6085 Server components (19 U cabinet example)
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NovaScale 6165 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1,
15

CSS module with core unit, power supply and AC power cable, including: 8 U
x2

1,
15 IO Box (IOC) with: 2 IOL board – legacy ports

8 U
x2IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 2 FC disks 6 U

16 Free space for additional components (SCSI or FC disks) 14 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 7. NovaScale 6165 Server components (40U cabinet example)
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Server Components

 Note:
Server components and configuration may differ according to the version chosen.

Central Subsystem (CSS) Module
The CSS module houses main hardware components:

Front     Rear

Front 1 or 2 QBB (Quad Brick Board) subset(s):
Each QBB subset houses:

• 1 mother board
• 2 memory boards
• 1 to 4 processors
• 16 DIMMs

1 or 2 Internal Peripheral Drawer(s):
Each drawer houses:

• 2 internal SCSI RAID system disks
• 1 DVD–ROM drive
• 1 USB port

Rear 1 or 2 IO Box(es) (Input / Output Board Compact):

Each IO Box can house:

• 1 HPB (PCI Hot Plug Board)

• 6 hot–plug 133 MHz PCI–X slots (2 long, 4 short)

• 1 IOL (Input / Output  board Legacy):

– 2 A–type USB ports

– 1 RJ45 10/100/1000 Mbps Ethernet port

– 2 DB9–M RS232 serial ports
– 1 HD15–F VGA port

1 PMB (Platform Management Board):
This active board links the server to the Platform Administration Processor (PAP) Unit
(via an Ethernet link).

Core 1 Core unit
This set of 5 active boards is used to interconnect the QBBs, IOCs, DIBs and the PMB.

Figure 8. CSS module features (full CSS module example)

 Note:
Abbreviations and acronyms are documented in the Glossary.
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Integrated Platform Administration Processor (PAP) Unit

 Warning: 
The PAP unit has been specially configured for Bull NovaScale Server administration
and maintenance. NEVER use the PAP unit for other purposes and NEVER change
PAP unit configuration unless instructed to do so by an authorized Customer Service
Engineer.

The PAP unit is linked to the server via the Platform Management Board (PMB). It hosts
Platform Administration Software (PAM). According to version, the PAP unit is located in the
center of a high cabinet or at the top of a low cabinet.

• 1 P4SCi / 2.6 GHz PC

– 2 x 512 Mb RAM

– 2 x 80 Gb disks (RAID) (3)

– 4 free disk slots

– 1 DVD–ROM drive (1)

– 1 FDD (2)

– 2 serial ports

– 3 PCI slots

– 2 x 1 Gb Ethernet ports (1 free)

– 4 USB ports (2 front  (4)+ 2 rear )

• Microsoft Windows operating system

• Internet Explorer software

• PAM software

• 1 power cable

Figure 9. PAP unit
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Integrated Console
According to version, the console is located in the center of a high cabinet or at the top of a
low cabinet.

The inegrated slideaway Console contains the keyboard, monitor and touch pad used for
local access to the server and to the Platform Administration Processor (PAP) Unit.

• 1 monitor

• 1  QWERTY keyboard and touch pad

• 1 power cable

Figure 10. Slideaway Console features
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Keyboard / Video / Mouse (KVM) Switch
The KVM Switch allows the use of the integrated console for the local server and the local
Platform Administration and Maintenance console.

8–Port KVM Switch

Or

• 8 ports

• 1 power cable

Figure 11. 8–port KVM switch features

16–Port KVM Switch

• 16 ports

• 1 power cable

Figure 12. 16–port KVM switch features
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SR–0812 SCSI RAID / SJ–0812 SCSI JBOD Disk Racks
Optionally, SR–0812 SCSI RAID / SJ–0812 SCSI JBOD Disk Racks are delivered with
pre–installed system disks (two RAID#1 and one spare disk per domain). Empty slots can
be used for data disks. According to version, the Disk Rack is located in the main or I/O
cabinet.

• 8 slots

• 1 RAID controller card

• 2 power cables (redundant power supply)

Figure 13. SR–0812 SCSI RAID / SJ–0812 SCSI JBOD disk rack features

SJ–0812 SCSI JBOD Extension Disk Rack
The SJ–0812 SCSI JBOD Extension Disk Rack offers eight empty slots for Customer data
disks. According to version, the Extension Disk Rack is located in the main or I/O cabinet.

• 8 slots

• 2 power cables (redundant power supply)

Figure 14. SJ–0812 SCSI JBOD extension disk rack features
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FDA 1x00 FC Disk Rack
Optionally, the FDA 1x00 FC Disk Rack is delivered with pre–installed system disks (two
RAID#1 and one spare disk per domain). Empty slots can be used for data disks. According
to version, the Disk Rack is located in the main or I/O cabinet.

• 15 slots

• 2 FC RAID controller cards, 1 FC port per controller

• 3 disks per domain (2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 15. FDA 1x00 FC disk rack features

FDA 2x00 FC Disk Rack
Optionallay, the FDA 2x00 FC Disk Rack is delivered with pre–installed system disks (two
RAID#1 and one spare disk per domain). Empty slots can be used for data disks. According
to version, the Disk Rack is located in the main or I/O cabinet.

• 1 controller unit & 1 disk unit

• 15 slots

• 2 FC RAID controller cards, 2 FC ports per controller

• 3 disks per domain (2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 16. FDA 2x00 FC disk rack features
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FDA 1x00 FC Extension Disk Rack
The FDA 1x00 FC Extension Disk Rack offers15 empty slots for data disks. According to
version, the Disk Rack is located in the main or I/O cabinet.

• 15 slots

• 2 power cables (redundant power supply)

Figure 17. FDA 1x00 FC extension disk rack features
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Ethernet Hub
The optional Maintenance LAN Ethernet Hub is used to connect PMB, PAP Unit and
external FDA FC Disk Rack Ethernet ports.

Ethernet Hub – 8 ports

– 1 power cable

– 1 power bar

Figure 18. Ethernet hub features

USB Modem
The optional USB modem is used to transmit Autocalls to the Remote Maintenance Center,
if your maintenance contract includes the Autocall feature.

USB Modem – 1 USB cable

– 1 RJ11 cable

Figure 19. USB modem features

NPort Server
The Nport Server is used connect the administration port of the SR–0812 SCSI RAID disk
rack to the PAP Unit.

NPort Server – 2 DB9 to Jack cable

– 1 RJ45 – RJ45 Ethernet cable

Figure 20. NPort Server features
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Accessing Server Components
During normal operation, cabinet components can be accessed from the front. Customer
Service Engineers may also remove the rear and side covers for certain maintenance
operations.

  Important: 
Optimum cooling and airflow is ensured when the cabinet door is closed.

Opening the Front Door

Tools Required:

• Cabinet key

Figure 21. Opening the front door

1. Unlock the front door with the key.

2. Pull out the locking mechanism and turn to open.

3. Open the door as required (90° / 180°).

Closing the Front Door
1. Close the door.

2. Turn the locking mechanism to close and push back into place.

3. Lock the front door with the key.
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Opening / Closing the Slideaway Console
The server is equipped with an integrated console for local administration and maintenance
operations.

Figure 22. Slideaway console

To open the slideaway console:

1. Slide the console forward until it clicks into place.

2. Use the front bar to lift the screen panel into position.

To close the slideaway console:

1. Press the 2 buttons marked PUSH on either side of the keyboard panel to release the
console.

2. Lower the front bar to close the screen panel.

3. Slide the console back into the cabinet.
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Bull NovaScale Server Resources

 Note:
According to server configuration and version, certain features and functions described in
this guide may not be accessible. Please contact your Bull Sales Representative for sales
information.

System Resource and Documentation CD–Roms
The Bull NovaScale Server System Resource and Documentation CD–Roms contain all the
firmware and documentation referred to in this guide.

PAM Software Package
The Bull NovaScale Server is equipped with an integrated Platform Administration and
Maintenance software package, otherwise known as the PAM software package.

One part of PAM software is an embedded application (MAESTRO) running on the Platform
Management Board(s) (PMB) and the other is an external application (PAM Kernel / Web
User Interface) running on the Platform Administration Processor (PAP) unit under Microsoft
Windows.

PMB

CSS Module

PAP Unit

Internal Ethernet  Link

(MAESTRO)

(PAM Kernel / Web User Interface)

Access to 
Hardware Elements

Figure 23. PAM software deployment

The PAM Web–based administration and maintenance tools give you immediate insight into
system status and configuration. You will use PAM software to operate, monitor, and
configure your Bull NovaScale Server.

As soon as your system is connected to the power supply, the PAP unit running Microsoft
Windows and PAM software also powers up. For further information about connecting to
PAM, see Connecting to the PAM Web Site, on page 2-2.

PAP Unit Mirroring and Failover Policy
Most configuration, administration, and maintenance activities are carried out from the PAP
unit. To ensure a high level of data integrity and availability, the PAP unit is equipped with
two extractable mirrored disks. Mirroring writes and updates data across both disks,
creating a single logical volume with completely redundant information on each disk. If one
disk fails, it can be replaced without losing data.

 Note:
For enhanced data integrity and availability, the PAP unit can be equipped with a third disk.
Contact your Customer Representative for details.
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EFI Utilities
The Bull NovaScale Server EFI utilities provide a complete set of configuration, operation,
and maintenance tools:

• EFI driver,

• EFI Shell,

• EFI system utility,

• EFI system diagnostic,

• Operating System loader.

For further details, see Chapter 5. Tips and Features for Administrators.
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Chapter 2. Getting Started

This chapter explains how to connect to and start server domains. It includes the following

topics:

• Connecting to the PAM Web Site, on page 2-2

• PAM User Interface, on page 2-5

• Toggling the Local / Integrated Console Display, on page 2-8

• Setting up Users, on page 2-8

• Powering Up / Down the NovaScale 5xx5 Server Domain, on page 2-9

• Powering Up / Down NovaScale 6085 Server Domains, on page 2-11

• Powering Up / Down NovaScale 6165 Server Domains, on page 2-15

• Preparing Server Domains for Remote Access via the Enterprise LAN, on page 2-19

• Preparing Server Domains for Remote Access via the Web, on page 2-21

• Connecting to a Server Domain via the Enterprise LAN, on page 2-22

• Connecting to a Server Domain via the Web, on page 2-23

 Note:
Customer Administrators and Customer Operators are respectively advised to consult the
Administrator’s Memorandum, on page xxi or the  Operator’s Memorandum, on page xxvi for
a detailed summary of the everyday tasks they will perform.
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Connecting to the PAM Web Site
The server is equipped with an integrated Platform Administration and Maintenance
software package, otherwise known as PAM software. One part of PAM software is an
embedded application (MAESTRO) running on the Platform Management Board (PMB) and
the other is an external application running on the Platform Administration Processor (PAP)
unit under Microsoft Windows.

The PAM Web–based administration and maintenance tools give you immediate insight into
system status and configuration. You will use PAM software to operate, monitor, and
configure your server.

 Notes:
Local and remote access rights to the PAP unit and to the PAM Web site must be
configured by the Customer Administrator. For further details, refer to the Microsoft
Windows documentation and to Setting up PAP Unit Users, on page 5-21.
Customer Administrator rights are required for all PAM configuration tasks.

Connecting to the PAM Web Site from the Local / Integrated Console

 CAUTION:
Access to the local / integrated console should be restricted to Customer / Support
Administrators and Operators ONLY to avoid inadvertent damage to software and/or
hardware components.

1. Check that the KVM switch is set to the PAP Unit port. See Toggling the Local /
Integrated Console Display, on page 2-8.

2. From the PAP unit Microsoft Windows desktop, double–click the PAM icon
(http://localhost/PAM).

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.
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Connecting to the PAM Web Site from a Remote Computer

  Important: 
Before connecting to PAM from a remote computer, you are advised to disconnect
from your local Windows session on the PAP unit by clicking Start → Log Off. 

The PAM Software utility can be accessed from any PC running Microsoft Windows with the
Internet Explorer (6 or later) browser installed and/or from any workstation running Linux
with the Mozilla (1.6 or later) browser installed.

 Note:
Do NOT use the Mozilla browser on the PAP unit.

Enabling Remote Access to the PAM Web Site with Internet Explorer
1. From the remote computer, configure Internet Explorer to connect directly to the PAM

Web site:

a. From the Internet Explorer main menu bar, click Tools → Internet Options.

b. Under the General tab, type the PAM Web site URL defined during the PAP
installation procedure in the Home Page Address field:
http://<PAPname>/pam
(where <PAPname> is the name allocated to the PAP unit during setup).

c. Click Advanced → Restore Defaults to validate default settings.

d. Save your changes and close Internet Explorer.

2. Launch Internet Explorer to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.

Enabling Remote Access to the PAM Web Site with Mozilla
1. From the remote computer, configure Mozilla to connect directly to the PAM Web site:

a. From the Mozilla main menu bar, select Edit → Preferences → Navigator.

b. Select the Home Page checkbox and enter the PAM Web site URL defined during the
PAP installation procedure in the location field:
http://<PAPname>/pam
(where <PAPname> is the name allocated to PAP unit during setup).

c. Select the Restore Defaults checkbox to validate default settins.

d. Save your changes and close Mozilla.

2. Launch Mozilla to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.
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Simultaneous Connection to the PAM Web Site
Several users can access the PAM Web site simultaneously.

  Important: 
If configuration changes are made, they may not be visible to other users unless they
refresh the PAM Tree.

As Customer Administrator, you can view the list of PAM users currently logged onto the
PAM Web site by clicking Hardware Monitor → PAM Web Site.

The Web site version and a list of connected users and session details are displayed in the
Control pane.

The  icon indicates the current session.

Figure 24. PAM Web site session details

You can also open several browser sessions from the same computer to obtain different
views of system operation. For example, as Customer Administrator, you may want to open
a first session for permanent and easy access to powering on/off functions, a second
session for access to system histories and archives, and a third session for access to
configuration menus, as shown in the following figure.

Figure 25. Multiple session example
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PAM User Interface

PAM User Interface
The PAM user interface is divided into three areas in the browser window: a Status pane, a
PAM Tree pane, and a Control pane.

Status Pane Control Pane

PAM Tree Pane

Figure 26. PAM user interface

 Note:
For further details about the PAM user interface, please consult the User’s Guide.
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Checking Server Status via PAM
The PAM user interface allows you to check system status at a glance. If the Functional
Status icon in the Status pane and the CSS Availability Status bar are green, the server
is ready to be powered up.

PAM Status Pane
The Status pane, which is automatically refreshed every few seconds, provides quick
access to the following synthetic information:

• Functional Status: if the system is operating correctly, the status icon is green,

• Event Messages: shows the number and maximum severity of pending event messages,

• CSS Availability Status: if the CSS Module is present, configured correctly, and is ready
to operate, the status bar is green.

Figure 27. Status pane

CSS Availability Status

NovaScale 5085 Server / NovaScale 6085 Server

When the CSS Module is operating correctly, the CSS Availabilty Status bar is green. If the
CSS Module is not operating correctly, the bar is red.

NovaScale 5165 Server / NovaScale 6165 Server

The CSS Availabilty Status bar is divided into two zones.

If the CSS Modules are operating correctly, the CSS Availabilty Status bar is green.

If the CSS Modules are not operating correctly, the bar is red.

If one of the CSS Modules is not operating correctly, half the bar is red.

CSS Module_0  not available
Bar red

Figure 28. CSS Module availability status bar (bi–module server)
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PAM Tree Pane

 Note:
The PAM tree builiding process may take one to two minutes. The PAM tree pane is
refreshed on request.

The PAM Tree pane provides access to server administration and maintenance features:

Tree Nodes Function

Domain Manager
to power on / off and manage domains. See Chapter 3. Manag-
ing Domains.

Hardware Monitor
to display the status of hardware components and assemblies.
See Chapter 4. Monitoring the Server.

History Manager
to view logs and manage archives.See Chapter 4. Monitoring
the Server.

Configuration Tasks
to customize server features.See Chapter 5. Tips and Features
for Administrators.

Table 3. PAM Tree nodes

PAM Tree Toolbar

The PAM Tree toolbar, located at the top of the PAM Tree, is used to refresh, expand, or
collapse the tree display.

Toolbar Buttons Explanation

Refresh /rebuild the PAM Tree to view changes.

Expand the complete tree.

Collapse the complete tree.

Expand selected node.

Collapse selected node.

View the related Help topic.

Figure 29. PAM Tree toolbar

PAM Control Pane
When an item is selected in the PAM Tree pane, details and related commands are
displayed in the Control pane, which is automatically refreshed at one minute intervals.

Setting up Users
As Customer Administrator, you must set up user accounts and passwords to control access
to the PAP unit. See Setting up PAP Unit Users, on page 5-21. 
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Toggling the Local / Integrated Console Display
During the powering up / down sequences, you will be requested to toggle the local /
integrated console from the PAP unit display to the server domain display, or vice versa, as
explained below.

 CAUTION:
Access to the local / integrated console should be restricted to Customer / Support
Administrators and Operators ONLY to avoid inadvertent damage to software and/or
hardware components.

The KVM Switch allows the integrated console to be used as the local server domain and
local PAP unit console. KVM ports are configured as shown in Table 4.

8–Port KVM Switch Console Display Domain

Port 1 PAP Unit N/A

Port 2 CSS0–Mod0–IO0 MyOperations–xx–1

Port 3 CSS0–Mod0–IO1 MyOperations–xx–2

or

16–Port KVM Switch Console Display Domain

Port 1 PAP Unit N/A

Port 3 CSS0–Mod0–IO0 MyOperations–xx–1

Port 4 CSS0–Mod0–IO1 MyOperations–xx_2

Port 5 CSS0–Mod1–IO0 MyOperations–xx–3

Port 6 CSS0–Mod1–IO1 MyOperations–xx–4

Table 4. KVM port configuration

You can easily toggle from the server domain display to the PAP unit display, or vice versa:

1. From the keyboard, press the Control key twice to display the KVM Switch Command
Menu.

2. Select the required port with the ↑↓ keys and press Enter.

3. The selected display appears on the Console monitor.
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Powering Up / Down Server Domains
To power up / down the server, see:

• Powering Up / Down the NovaScale 5xx5 Server Domain, on page 2-9

• Powering Up / Down NovaScale 6085 Server Domains, on page 2-11

• Powering Up / Down NovaScale 6165 Server Domains, on page 2-15

Powering Up the NovaScale 5xx5 Server Domain
NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain.

When server status has been checked – functional status icon and CSS availability status
bar green in the Status pane – the server domain can be powered up.

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Managing Domains.

To power up server domains:

1. From the Customer Administrator / Operator PAM Tree, click Domain Manager to open
the Control pane. A dialog box invites you to load the server domain.

2. Click OK to confirm. The domain appears in the Control pane. If the domain is ready to
be powered up, INACTIVE is displayed in the Domain State box and the Power On
button is accessible.

3. Select the domain and click Power On to power up the server domain and associated
hardware components.

Operating System type

CSS availability status indicator 
GREEN

Functional status icon &

Figure 30. Domain Manager Control pane

4. Follow the power–on steps displayed in the Domain State box, until RUNNING is
displayed.
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Figure 31. Domain state

5. Toggle the local / integrated console from the PAP unit display to the server display. See
Toggling the Local / Integrated Console Display, on page 2-8.

6. Wait for the Operating System to load completely. The domain is now fully functional.

7. Check the Operating System environment pre–installed on the domain.

8. As Customer Administrator, you can now prepare each domain for remote access via the
Enterprise LAN and/or via the Web. See Preparing Server Domains for Remote Access
via the Enterprise LAN, on page 2-19 and Preparing Server Domains for Remote Access
via the Web, on page 2-21.

Powering Down the NovaScale 5xx5 Server Domain

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Managing Domains.

1. Shut down the Operating System to power down the domain to the stand–by mode.

2. Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State box and the Power ON button is accessible.

 Note:
For further details about the Power ON / OFF sequences, see Powering ON a Domain, on
page 3-14 and Powering OFF a Domain, on page 3-16.
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Powering Up NovaScale 6085 Server Domains
The NovaScale 6085 Server is designed to operate as two hardware–independent SMP
systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined by the Customer Administrator via the PAM
Domain Scheme wizard.

For further details about domain configuration, see Configuring Domains, on page 5-32.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme–xx containing two domains, MyOperations–xx–1 and
MyOperations–xx–2.your  An Operating System instance is pre–installed on each domain
boot disk (EFI LUN). According to your requirements, identical or different Operating System
instances may be pre–installed on each EFI LUN. The default scheme allows domains to be
booted simultaneously or independently. A brief summary of the organization of physical
and logical resources in MyOperationsScheme–xx is given in the following table.

 Notes:

• xx in the default scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to PMB Code Wheel Settings, on page
4-42.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–xx–1 and an instance of Linux is pre–installed on MyOperations–xx–2.

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.
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MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0

IOC Module0_IOC0

QBBs Module0_QBB0

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU1

IOC Module0_IOC1

QBBs Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO1

* <MyServer> = default server name, e.g.: NS6085–0

** EFI LUN: xLUx = boot LUN device location (ModxLUIOx):
      0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0
      0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1
***CSSx = CSS number, Modx = Module number, IOx = IO box number
Table 5. MyOperationsScheme organization – mono–module server

 Note:
If an error dialog box appears during these sequences, see Chapter 3. Managing Domains.

To power up server domains:

1. From the PAM Tree, click Domain Manager to open the Control pane. You are invited
to load a domain configuration scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.
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3. Select MyOperationsScheme and click Apply.

Figure 32. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1 and MyOperations–2 domains
are loaded in the Control pane.

If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.

CSS availability status indicator 
GREEN

Functional status icon &

Operating System type

Figure 33. Domain Manager Control pane

5. Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components.
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6. Select MyOperations–2 in the Control pane and click Power On to power up the
domain and associated hardware components.

7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in both Domain State boxes.

Figure 34. Domain state

8. Toggle the local / integrated console from the PAP unit display to MyOperations–1
display. See Toggling the Local / Integrated Console Display, on page 2-8.

9. Wait for the Operating System to load completely. MyOperations–1 domain is now fully
functional.

10.Toggle the local / integrated console from MyOperations–1 display to MyOperations–2
display.

11.Wait for the Operating System to load completely. MyOperations–2 domain is now fully
functional.

12.Check the Operating System environment pre–installed on each domain.

13.As Customer Administrator, you can now prepare each domain for remote access via the
Enterprise LAN and/or via the Web. See Preparing Server Domains for Remote Access
via the Enterprise LAN, on page 2-19 and Preparing Server Domains for Remote Access
via the Web, on page 2-21.

Powering Down NovaScale 6085 Server Domains

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Managing Domains.

1. Shut down each Operating System to power down the corresponding domain to the
stand–by mode.

2. Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Note:
For further details about the Power ON / OFF sequences, see Powering ON a Domain, on
page 3-14 and Powering OFF a Domain, on page 3-16.
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Powering Up NovaScale 6165 Server Domains
The NovaScale 6165 Server is designed to operate as four hardware–independent SMP
systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined by the Customer Administrator via the PAM
Domain Scheme wizard. For further details about domain configuration, see Configuring
Domains, on page 5-32.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme–xx, containing up to four domains, MyOperations–xx–1,
MyOperations–xx–2, MyOperations–xx–3, MyOperations–xx–4. An Operating System
instance is pre–installed on each domain boot disk (EFI LUN).  According to your
requirements, identical or different Operating System instances may be pre–installed on
each EFI LUN. The default scheme allows you to simultaneously boot all domains. A brief
summary of the organization of physical and logical resources in
MyOperationsScheme–xx is given in the following table.

 Notes:

• xx in the default scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to PMB Code Wheel Settings, on page
4-42.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–xx–1 and MyOperations–xx–3 and an instance of Linux is pre–installed
on MyOperations–xx–2 and MyOperations–xx–4.

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.
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MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0

IOC Module0_IOC0

QBBs Module0_QBB0

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU1

IOC Module0_IOC1

QBBs Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO1

Domain Identity: MyOperations–3
(NovaScale 6165 Server)

Hardware Cell Cell_2

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU2

IOC Module1_IOC0

QBBs Module1_QBB0

Domain KVM Ports ***CSS0_Mod1_IO0

Domain Identity: MyOperations–4
(NovaScale 6165 Server)

Hardware Cell Cell_3

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU3

IOC Module1_IOC1

QBBs Module1_QBB1

Domain KVM Ports ***CSS0_Mod1_IO1

* <MyServer> = default server name, e.g.: NS6085–0, NS6165–0

** EFI LUN: xLUx = boot LUN device location (ModxLUIOx):
      0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0
      0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1
      0LU2 = LUN device located in Module1_DIB0 or connected to Module1_IOC0
      0LU3 = LUN device located in Module1_DIB1 or connected to Module1_IOC1

***CSSx = CSS number, Modx = Module number, IOx = IO box number
Table 6. MyOperations Scheme organization – bi–module server

 Note:
If an error dialog box appears during these sequences, see Chapter 3. Managing Domains.



2-17Getting Started

To power up server domains:

1. From the PAM Tree, click Domain Manager to open the Control pane. You are invited
to load a domain configuration scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.

3. Select MyOperationsScheme and click Apply.

Figure 35. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1, MyOperations–2,
MyOperations–3, and MyOperations–4 domains are loaded in the Control pane.
If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.

Figure 36. Domain Manager Control pane
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5. Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components.

6. Repeat Step 5 for each domain in the Control pane.

7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in all Domain State boxes.

Figure 37. Domain state

8. Toggle the local / integrated console from the PAP unit display to the first domain display.
See Toggling the Local / Integrated Console Display, on page 2-8.

9. Wait for the Operating System to load completely. The domain is now fully functional.

10.Toggle the local / integrated console from this domain display to the next domain
display.

11.Wait for the Operating System to load completely. The domain is now fully functional.

12.Repeat Steps 10 and 11 for each domain.

13.Check the Operating System environment pre–installed on each domain.

14.As Customer Administrator, you can now prepare each domain for remote access via the
Enterprise LAN and/or via the Web. See Preparing Server Domains for Remote Access
via the Enterprise LAN, on page 2-19 and Preparing Server Domains for Remote Access
via the Web, on page 2-21.

 Note:
If an error dialog box appears during this sequence, see Chapter 3. Managing Domains.

Powering Down NovaScale 6165 Server Domains
1. Shut down each Operating System to power down the corresponding domain to the

stand–by mode.

2. Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Note:
For further details about the Power ON / OFF sequences, see Powering ON a Domain, on
page 3-14 and Powering OFF a Domain, on page 3-16.
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Preparing Server Domains for Remote Access via the
Enterprise LAN

 CAUTION:
Access to the local / integrated console should be restricted to Customer / Support
Administrators and Operators ONLY to avoid inadvertent damage to software and/or
hardware components.

 Note:
Required networking data is indicated in the Read Me First document delivered with the
server and is also recorded under the corresponding PAM Domain Identity.
Customer Administrator rights are required for all PAM configuration tasks.

Microsoft Windows Domain
1. Toggle the integrated console to the corresponding Windows domain port. See Toggling

the Local / Integrated Console Display, on page 2-8.

2. From the Windows desktop, right click My Computer and select Properties → Remote.

3. Check the Allow remote connection box.

4. Share the <system root>\system32\clients\tsclient directory via the Explorer.

5. Toggle the integrated console to the PAP unit port.

6. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Identities to open the Identities page.

7. Select the corresponding Windows domain from the list and click Edit to open the Edit
an Identity dialog.

8. Check that the Network Name, IP Address, and URL fields are completed. If not,
complete these fields with the networking data entered during the Windows setup
completion procedure and click OK.

Linux Redhat Domain
1. Toggle the integrated console to the corresponding Linux domain port. See Toggling the

Local / Integrated Console Display, on page 2-8.

2. From the Linux desktop, enable remote connection via telnet, rlogin, ftp, ...:

3. From the PAP unit Internet Explorer or Mozilla browser, enter the Webmin URL:
http://<networkname>:10000, where <networkname> is the network name given to
the server domain during the Linux setup completion procedure.
The Login to Webmin dialog box opens.

4. Click the Networking icon. The Networking main page opens.

5. Click Extended Internet Services to display the list of available services.

6. From the service list, check that Yes is displayed in the status column. If No is displayed
in the status column, proceed as follows to enable the service:

a. Select the required service from the list.

b. Complete the fields accordingly.

c. Click Yes after Service enabled?

d. Click Save.

7. Repeat step 3 for each required service.
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8. Click Apply changes to apply all changes.

9. Click Return to index.

10.Click Log Out to exit Webmin.

11.Toggle the integrated console to the PAP unit port.

12.From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Identities to open the Identities page.

13.Select the corresponding Windows domain from the list and click Edit to open the Edit
an Identity dialog.

14.Check that the Network Name, IP Address, and URL fields are completed. If not,
complete these fields with the networking data entered during the Windows setup
completion procedure and click OK.

Linux SuSE Domain
1. Toggle the integrated console to the corresponding Linux domain port. See Toggling the

Local / Integrated Console Display, on page 2-8.

2. From the Linux desktop, enable remote connection via telnet, rlogin, ftp, ...:

3. Launch the yast2 command to open the Yast Control Center screen.

4. Click the Network/Basic icon in the left pane.

5. Click Start/stop services (inetd).

6. From the Network Services page, select On with customer configuration and click
Next to open the Enable/disable network services page.

7. From the service list, check that Active is displayed in the status column. Proceed as
follows to enable the service:

a. Select the required service from the list.

b. Click Activate.

8. Repeat step 5 for each required service.

9. Click Finish to apply all changes.

10.Click Close to exit yast2.

11.Toggle the integrated console to the PAP unit port.

12.From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Identities to open the Identities page.

13.Select the corresponding Windows domain from the list and click Edit to open the Edit
an Identity dialog.

14.Check that the Network Name, IP Address, and URL fields are completed. If not,
complete these fields with the networking data entered during the Windows setup
completion procedure and click OK.
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Preparing Server Domains for Remote Access via the Web

 CAUTION:
Remote access via the Web is a potential security hazard. Customers are strongly
advised to protect their systems with up–to–date protection devices such as
virus–prevention programs and firewalls, and to maintain a detailed record of
authorized users.

Microsoft Windows Domain
1. Toggle the integrated console to the corresponding Windows domain port. See Toggling

the Local / Integrated Console Display, on page 2-8.

2. Left click Start → Control Panel → Add or Remove Programs.

3. Select Add / Remove Windows Components.

4. Click Web Application Services → Details → Internet Information Services →
Details → World Wide Web Services → Details → Remote Desktop Web
Connection. Validate where required by clicking OK or Next.

5. Insert the the Microsoft Windows CD–ROM in the CD–ROM / DVD drive.

6. The Microsoft Windows setup wizard is launched automatically and guides you through
the setup completion procedure.

7. Toggle the integrated console to the PAP unit port.

8. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Identities to open the Identities page.

9. Select the corresponding Windows domain from the list and click Edit to open the Edit
an Identity dialog.

10.Check that the Network Name, IP Address, and URL fields are completed. If not,
complete these fields with the networking data entered during the Windows setup
completion procedure and click OK.

Linux Domain
Virtual Network Computing (VNC) remote control software allows users to interact with the
server from a remote computer via Internet.

The server domain is ready for remote connection.

1. Toggle the integrated console to the PAP unit port.

2. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Identities to open the Identities page.

3. Select the corresponding Linux domain from the list and click Edit to open the Edit an
Identity dialog.

4. Check that the Network Name, IP Address, and URL fields are completed. If not,
complete these fields with the networking data entered during the Linux setup completion
procedure and click OK.



2-22 User’s Guide

Connecting to a Server Domain via the Enterprise LAN

Microsoft Windows Domain
1. Check that Client for Microsoft Networks is installed on the remote computer and that

the remote computer is connected to the same LAN as the server domain.

2. Check that Client for Remote Desktop is installed on the remote computer. If the
Remote Desktop Connection menu does not exist:

a. Click Start → Run.

b. Type \\<networkname>\tsclient\win32\setup.exe in the box, where
<networkname> is the network name given to the server domain during the
Windows setup completion procedure. 

3. Connect to the server domain by running:

a. Microsoft Windows XP (and later):
All Programs → Accessories → Communication → Remote Desktop
Connection.

b. All other versions of Microsoft Windows:
Programs → Remote Desktop Connection → OK.

4. Type Administrator (default administrator user name) in the User name field.

5. Type the administrator password defined during the Windows setup completion
procedure in the Password field.

6. The remote computer connects to the server domain.

Linux Domain
1. Enter the following command:

ssh <networkname> –l user_name, where <networkname> is the network name given
to the server domain during the Linux setup completion procedure. 

2. The remote computer connects to the server domain.
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Connecting to the Server via the Web

Microsoft Windows Domain
1. Check that Internet Explorer (6 or later) and Terminal Server Client are installed on

the remote computer.

2. Launch the Internet Explorer or Netscape browser and connect to the server desktop,
url: http://<networkname>/tsweb/, where <networkname> is the network name given
to the server domain during the Windows setup completion procedure. See the
Read Me First document delivered with the server.

Linux Domain
Virtual Network Computing (VNC) remote control software allows users to interact with the
server from a remote computer via Internet.

1. Check that VNC Server is installed.

2. Execute the vncpasswd command to initialize the password.

3. Execute the vncserver command to start the process.

4. Record the <networkname> display number for the remote computer, where
<networkname> is the network name given to the server domain during the Linux setup
completion procedure.
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Chapter 3. Managing Domains

This chapter explains how, as Customer Administrator and/or Customer Operator, you can

manage server domains. It includes the following topics:

• Introducing PAM Domain Management Tools, on page 3-2

• Managing Domain Configuration Schemes, on page 3-5

• Synchronizing NovaScale 5xx5 Server Domains, on page 3-6

• Powering On a Domain, on page 3-14

• Powering Off a Domain, on page 3-16

• Manually Resetting a Domain, on page 3-17

• Forcing a Domain Power Off, on page 3-18

• Performing a Domain Memory Dump, on page 3-20

• Viewing Domain Functional Status, on page 3-21

• Viewing Domain Power Logs, on page 3-22

• Viewing Domain Powering Sequences, on page 3-23

• Viewing Domain BIOS Info, on page 3-24

• Viewing Domain Request Logs, on page 3-25

• Viewing Domain Configuration, Resources and Status, on page 3-26

• Modifying Domain Configuration, on page 3-33

• What to Do if an Incident Occurs, on page 3-47

 Note:
Customer Administrators and Customer Operators are respectively advised to consult the
Administrator’s Memorandum, on page xxi or the  Operator’s Memorandum, on page xxvi for
a detailed summary of the everyday tasks they will perform.

For further information about user accounts and passwords, see Setting up PAP Unit Users,
on page 5-21.
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Introducing PAM Domain Management Tools

  Important: 
Certain domain configuration and management tools are reserved for use with
partitioned servers and extended systems.  Please contact your Bull Sales
Representative for sales information.

A Bull NovaScale Server domain englobes all the hardware and software resources
managed by an Operating System instance.

NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain.

NovaScale 6xx5 Servers are designed to operate as one, two, three or four
hardware–independent SMP systems or domains, each running an Operating System
instance and a specific set of applications.

The PAM Domain Manager is at the heart of server operation. Customer Administrators
and Operators have equal access rights to Domain Manager functions and the Control
pane is frequently used during operation. The Domain Manager Control pane gives access
to all domain commands and domain details.

What You Can Do

Via the Domain Manager Control pane, you can:

• Manage domain configuration schemes

• Power on a domain

• Powering off a domain

• Perform a domain reset

• Perform a domain force power off

• Request a domain memory dump

• View functional status

• View power logs

• View powering sequences

• View BIOS info

• View request logs

• View domain configuration, resources and status

 Note:
Access to certain hardware resources, such as system disks can be limited by using the
Exclusion / Inclusion function. See Limiting Access to Hardware Resources, on page 5-79
and Excluding / Including Hardware Elements, on page 4-21. This function must be used
with care.
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From the PAM Tree, click Domain Manager to open the Control pane.

Toolbar

Command Bar

Status Panel

Toolbar

Powering View Dynamically displays domain power sequences and gives ac-
cess to Power Logs, see details on page 3-22 and BIOS Info,
see details on page 3-24.

Expand All Expands the list of domains included in the current domain con-
figuration.

Schemes Loads a selected scheme and displays Scheme Properties, see
details on page 3-8.

Save Snapshot Saves current domain configuration as a new scheme for future
use, see details on page 3-11.

Status Panel

Domain Identities The names given to clearly identify domains, see details on page
5-32.

Domain State Power sequence state. See Powering ON a Domain, on page
3-14 and Powering OFF a Domain, on page 3-16.

Functional Status Status of the last action performed on a domain. See Viewing
Domain Functional Status, on page 3-21.
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Command Bar

Power On Powers on the selected domain, see details on page 3-14.

Power Off Powers off the selected domain, see details on page 3-16.

Reset Resets the selected domain, see details on page 3-17.

Force Power Off Forcibly powers off the selected domain, see details on page
3-18.

Power Logs Displays power sequence logs, see details on page 3-22.

Request Logs Displays Power On, Power Off, and Reset requests and request-
ors, see details on page 3-25.

Dump Performs a domain memory dump, see details on page 3-20.

View Displays Domain Resources, see details on page 3-26 and
BIOS Info, see details on page 3-24 and gives access to the
Domain Modification dialog, see details on page 3-33.

Modify Used to change current domain settings, see details on page
3-33.

 Delete Removes the selected domain from the current domain configu-
ration, see details on page 3-44.

Table 7. PAM Domain Manager tools
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Managing Domain Configuration Schemes

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.

What You Can Do

Via the Schemes tool in the Domain Manager Control pane toolbar, you can:

• Synchronize domains

• View a domain configuration scheme

• Load a domain configuration scheme

• Add domains to the current domain configuration

• Replace the current domain configuration

• Save the current domain configuration snapshot

A Domain Configuration Scheme is the template or configuration file used to define and
manage a set of domains that can be active simultaneously. For easy configuration and
optimum use of the physical and logical resources required for simultaneous operation,
domains are defined via the PAM Domain Configuration Scheme wizard.

 Note:
Server components and configuration may differ according to site requirements.

NovaScale 5xx5 Server

NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain.

NovaScale 6085 Server

The NovaScale 6085 Server is designed to operate as one or two hardware–independent
domains. The server is delivered with a pre–configured domain configuration scheme called
MyOperationsScheme containing two domains, MyOperations–1 and MyOperations–2,
allowing you to manage and administer all server resources.

NovaScale 6165 Server

The NovaScale 6165 Server is designed to operate as one, two, three or four
hardware–independent domains. The server is delivered with a pre–configured domain
configuration scheme called MyOperationsScheme containing four domains,
MyOperations–1, MyOperations–2, MyOperations–3 and MyOperations–4, allowing you
to manage and administer all server resources.

 Note:
As Customer Administrator, you may configure other schemes for domain management. For
further details about domain configuration options, see Configuring Domains, on page 5-32.

To power on server domains, you must first load the required Domain Configuration
Scheme from the Domain Manager Control pane. Once the domain configuration scheme
has been loaded, domains can be powered up simultaneously or independently.
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Synchronizing NovaScale 5xx5 Server Domains
The Synchronize Domains command is used to load the NovaScale 5xx5 Server domain.
Each NovaScale 5xx5 Server is delivered with one pre–configured domain.

To load the server domain:

Click Synchronize Domains in the toolbar. The server domain(s) appear(s) in the Control
pane for management.

The other Schemes tool options are reserved for partitioned (NovaScale 6xx5 Servers) or
extended systems. See Configuring and Managing Extended Systems, on page 5-76.

Viewing a Domain Configuration Scheme
Before loading a domain configuration scheme, you may want to know more about its
scope.

To view a scheme:

1. Click Domain Manager to open the Control pane.

2. Click Schemes in the Toolbar to open the Schemes List dialog.

Figure 38. Schemes list dialog

3. Select the required Scheme from the list and click Preview to view scheme properties.
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NovaScale 6085 Server

NovaScale 6165 Server

CellBlocks Shows the Central Subsystems included in the scheme and how
they are partitioned into domains.

D Identifies physical partitions.

Identities Shows the Identities allocated to each domain.

EFI LUNs Indicates the EFI LUNs used to boot each domain.

S Indicates domain configuration status. A Green status icon indicates
that the domain is configured correctly and is ready for use, a Red
status icon indicates that the domain is not configured correctly and
is not ready for use. If the status icon is Red, see Configuring Do-
mains, on page 5-32.

Figure 39. Scheme properties dialog
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Loading a Domain Configuration Scheme
To power on server domains, you must first load the required Domain Configuration
Scheme from the Domain Manager Control pane. Once the domain configuration scheme
has been loaded, domains can be powered up simultaneously or independently.

To load a scheme:

1. Click Domain Manager to open the Control pane. If a scheme has not been previously
loaded, you are invited to load one.

 Note:
If the required scheme is already loaded, it is available for domain management.
If a scheme is already loaded, but is not the required scheme, see Adding Domains to the
Current Domain Configuration and Replacing the Current Domain Configuration below.

2. Click Schemes in the Toolbar to open the Schemes List dialog.

Figure 40. Schemes list dialog

3. Select the required Scheme from the list and click Preview to view scheme properties.
See Viewing Domain Configuration Schemes, on page 3-6.

4. Click Apply. A dialog box informs you that the selected scheme will replace the current
domain configuration.

5. Click Yes to confirm. All the domains included in the selected scheme are loaded in the
Control pane and are available for management.
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If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes. The Power On button becomes accessible once a domain has been selected.

NovaScale 6085 Server

CSS availability status indicator 
GREEN

Functional status icon &

Operating System type
Domain selected

Power On button accessible

NovaScale 6165 Server

CSS availability status indicator 

GREEN

Functional status icon &

Operating System type

Select a domain
to access the Power On button

Figure 41. Domain Manager control pane
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Adding Domains to the Current Domain Configuration
A scheme can include domains from one or more Central Subsystems. More domains can
be made available for domain management by adding one or more schemes to the current
domain configuration.

 Notes:

• New domains must only include resources that are INACTIVE in the current domain
configuration.

• The current domain configuration can be partially replaced by first deleting INACTIVE
domains and then adding a new domain scheme

• New domains must be configured via Configuration Tasks before they are available for
domain management. For further details, see Configuring Domains, on page 5-32.

To add domains:

1. Click Domain Manager to open the Control pane.

2. Click Schemes in the Toolbar to open the Schemes List dialog.

3. Select the required Scheme from the list and click Preview to view scheme properties.
See Viewing Domain Configuration Schemes, on page 3-6.

4. Click Add. All the domains included in the scheme added are now available for
management in the Control pane.

Replacing the Current Domain Configuration

 Note:
All domains must be INACTIVE before the current domain configuration can be replaced.

To replace the current domain configuration:

1. Click Domain Manager to open the Control pane.

2. Check that all domains are INACTIVE. If a domain is not INACTIVE, it must be powered
down before the current domain configuration can be replaced. See Powering OFF a
Domain, on page 3-16.

3. If required, save the current domain configuration. See Saving the Current Domain
Configuration Snapshot, on page 3-11.

4. Click Schemes in the Toolbar to open the Schemes List dialog.

5. Select the required scheme from the list and click Preview to view scheme properties.
See Viewing Domain Configuration Schemes, on page 3-6.

6. Click Apply. A dialog box informs you that the selected scheme will replace the current
domain configuration.

7. Click Yes to confirm. All the domains included in the selected scheme are loaded in the
Control pane and are available for management.
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Saving the Current Domain Configuration Snapshot
You may want to save the current domain configuration, in particular if more than one
scheme has been loaded and/or if you have modified domain configuration. When you save
the current domain configuration, you create a new domain configuration scheme which is
then available for domain management.

To save the current domain configuration snapshot:

1. Click Domain Manager to open the Control pane.

2. Click Save Snapshot. The Save Snapshot dialog opens.

Figure 42. Save Snapshot dialog

3. Enter a name and description for the new domain configuration scheme and click Save.
The Snapshot is now available as a scheme for domain management. For further
details, see Configuring Domains, on page 5-32.
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MyOperationsScheme Organization – NovaScale 6xx5 Servers

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0

IOC Module0_IOC0

QBBs Module0_QBB0

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU1

IOC Module0_IOC1

QBBs Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO1

Domain Identity: MyOperations–3
(NovaScale 6165 Server)

Hardware Cell Cell_2

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU2

IOC Module1_IOC0

QBBs Module1_QBB0

Domain KVM Ports ***CSS0_Mod1_IO0

Domain Identity: MyOperations–4
(NovaScale 6165 Server)

Hardware Cell Cell_3

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU3

IOC Module1_IOC1

QBBs Module1_QBB1

Domain KVM Ports ***CSS0_Mod1_IO1

* <MyServer> = default server name, e.g.: NS6085–0, NS6165–0

** EFI LUN: xLUx = boot LUN device location (ModxLUIOx):
      0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0
      0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1
      0LU2 = LUN device located in Module1_DIB0 or connected to Module1_IOC0
      0LU3 = LUN device located in Module1_DIB1 or connected to Module1_IOC1

***CSSx = CSS number, Modx = Module number, IOx = IO box number

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.

Table 8. MyOperations Scheme organization – NovaScale 6xx5 Servers
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 Notes:

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

• xx in the default scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to PMB Code Wheel Settings, on page
4-42.
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Powering On a Domain

What You Can Do

During the domain power–on sequence, you can:

• View functional status

• View power logs

• View powering sequences

• View BIOS info

• View request logs

• View domain configuration, resources and status

  Important: 
Certain domain configuration and management tools are reserved for use with
partitioned servers and extended systems.  Please contact your Bull Sales
Representative for sales information.

Once connected to the Customer’s site power supply, the server initializes to the stand–by
mode and the integrated PAP unit powers up. The server is not equipped with a physical
power button and server domains are powered up from the PAM Domain Manager Control
pane.

Check server functional status via the PAM Status Pane. If functional status is normal and
the CSS Availability bar is green, server domains can be powered up.

 Note:
Server domains may be powered up even if the server presents a minor fault. See System
Functional Status, on page 4-4. However, you are advised to contact your Customer Service
Engineer so that the fault can be repaired.

To power up a domain:

NovaScale 5xx5 Servers

1. Click Domain Manager to open the Control pane. If the domain is already loaded, it is
available for domain management. Go to Step 2 below.

 Note:
If the domain is not already loaded, click Synchronize Domains in the toolbar to load the
domain.

NovaScale 6xx5 Servers

1. Click Domain Manager to open the Control pane. If the required domain configuration
scheme is already loaded, the corresponding domain(s) are available for domain
management. Loaded domains can be powered up simultaneously. Go to Step 2.

 Notes:

– If a scheme has not been previously loaded, you are invited to select and load a
scheme. See Viewing Domain Configuration Schemes, on page 3-6 and Loading a
Domain Configuration Scheme, on page 3-8.

– If a Scheme is already loaded, but is not the required Scheme, see Adding a Domain
Configuration Scheme and Replacing a Domain Configuration Scheme, on page
3-10.
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2. Select the required domain. If the domain is in the stand–by mode, INACTIVE is
displayed in the Domain Status panel and the Power On button is accessible.

  Important: 
If INACTIVE is not displayed in the Domain Status panel and the Power On button is
not accessible, check whether another user has already launched the power–up
sequence on this domain. If the power–up sequence is not already in progress, see
What To Do if an Incident Occurs, on page 3-47.

3. Click Power On to power up the domain and associated hardware components. The
Power On Confirmation dialog opens.

4. Select the View Power–On Logs checkbox if you want power–on logs to be
automatically displayed during the power–on sequence and click Yes to confirm.

Domain hardware is powered up from the stand–by mode to the main mode and the
Operating System is booted. As the power–on sequence progresses, power–on steps
and domain state are displayed in the Domain Status panel, as shown in the following
table.

Power On States

POWERING ON

POWERED ON – LOADING BIOS

BIOS READY – STARTING EFI

EFI STARTED – BOOTING OS

RUNNING

Table 9. Power–on states

Once the Power On sequence has been successfully completed, RUNNING is displayed
in the Domain Status panel and the Power Off, Reset and Force Power Off buttons
become accessible.

For a detailed view of the Power On sequence, click Powering View in the Toolbar. See
Viewing Powering Sequences, on page 3-23.

5. Repeat Steps 2 to 4 for each domain to be powered up.

 Note:
If an error message is displayed in the Domain Status panel, the Power On sequence has
failed. See What To Do if an Incident Occurs, on page 3-47.
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Powering Off a Domain

What You Can Do

During the domain power–off sequence, you can:

• View functional status

• View power logs

• View powering sequences

• View BIOS info

• View request logs

• View domain configuration, resources and status

Server domains can either be powered off from the Operating System (RECOMMENDED)
or from the PAM Domain Manager, according to Operating System power settings.

The PAM Power Off command is a shutdown request to the Operating System. If the
Operating System is configured to accept a PAM power off request, it will save data, close
open applications and shut down. Domain hardware will power down to the stand–by mode.
The Operating System may also be configured to request Operator confirmation before
accepting a PAM power off request. Refer to the applicable documentation delivered with
the Operating System for further details.

To power off a domain from the PAM Domain Manager:

1. Click Domain Manager to open the Control pane.

2. Select the required domain. If the domain is in the powered–on mode, RUNNING is
displayed in the Domain Status panel and the Power OFF button is accessible.

3. Click Power Off to power down the domain and associated hardware components. The
Power Off Confirmation dialog opens.

4. Select the View Power–Off Logs checkbox if you want power–off logs to be
automatically displayed during the power–off sequence and click Yes to confirm.

The Operating System saves data, closes open applications and shuts down. Domain
hardware is powered down from the main mode to the stand–by mode. As the power–off
sequence progresses, power–off steps and domain state are displayed in the Domain
Status panel, as shown in the following table.

Power Off States

POWERING DOWN

INACTIVE

Table 10. Power–off states

Once the Power Off sequence has been successfully completed, INACTIVE is displayed
in the Domain Status panel and the Power On button becomes accessible.

For a detailed view of the Power Off sequence, click Powering View in the Toolbar. See
Viewing Powering Sequences, on page 3-23.

5. Repeat Steps 2 to 4 for each domain to be powered down.

 Note:
If an error message is displayed in the Domain Status panel, the Power Off sequence has
failed. See What To Do if an Incident Occurs, on page 3-47.
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Manually Resetting a Domain

What You Can Do

During the domain reset sequence, you can:

• View functional status

• View power logs

• View powering sequences

• View BIOS info

• View request logs

• View domain configuration, resources and status

The Reset command is used to restart the current Operating System without powering
off/on the domain.

 Warning: 
The Reset  command should only be used if the Operating System is not running or
is not able to respond to a standard Power Off command. The Reset command may
result in domain data loss and file corruption. The Reset command does not power
down domain hardware (warm reboot).

To manually reset a domain:

1. Click Domain Manager to open the Control pane.

2. Select the required domain. If INACTIVE is NOT displayed in the Domain Status panel,
the Reset button is accessible.

3. Click Reset to override the Operating System and forcibly perform a warm reboot of the
domain BIOS, EFI and Operating System without closing running applications and
saving data. The Reset Confirmation dialog opens.

4. Click Yes to confirm the Reset command.

As the reset sequence progresses, reset steps and domain state are displayed in the
Domain Status panel, as shown in the following table.

Reset States

POWERING ON

POWERED ON – LOADING BIOS

BIOS READY – STARTING EFI

EFI STARTED – BOOTING OS

RUNNING

Table 11. Reset states

Once the Reset sequence has been successfully completed, RUNNING is displayed in
the Domain Status panel and the Power Off, Reset and Force Power Off buttons
become accessible.
For a detailed view of the Reset sequence, click Powering View in the Toolbar. See
Viewing Powering Sequences, on page 3-23.

5. Repeat Steps 2 to 4 for each domain to be reset.

 Note:
If an error message is displayed in the Domain Status panel, the Power On sequence has
failed. See What To Do if an Incident Occurs, on page 3-47.
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Forcing a Domain Power Off

What You Can Do

During the domain force power–off sequence, you can:

• View functional status

• View power logs

• View powering sequences

• View BIOS info

• View request logs

• View domain configuration, resources and status

The Force Power Off command powers down domain hardware to the standby mode
independently of the Operating System. This command should only be used if the Operating
System is not running or is not configured / not able to respond to a standard power off
command.

 Note:
A standard power off command is a shutdown request to the Operating System. Refer to the
applicable documentation delivered with the Operating System for further details.

In the event of a critical fault, PAM software automatically forces a domain power off.

 Warning: 
The Force Power Off command may result in domain data loss and file corruption.
NEVER use the Force Power Off command if a RECOVERING BIOS error message is
displayed. (The BIOS recovery program automatically re–flashes the BIOS when
certain problems occur during initialization).

To force a domain power off:

1. Click Domain Manager to open the Control pane.

2. Select the required domain. If INACTIVE is NOT displayed in the Domain Status panel,
the Force Power Off button is accessible.

3. Click Force Power Off to override the Operating System and forcibly power down the
domain and associated hardware components without closing running applications and
saving data. The Force Power Off Confirmation dialog opens.

4. Select the View Power–Off Logs checkbox if you want power–off logs to be
automatically displayed during the power–off sequence and click Yes to confirm.

Domain hardware is powered down from the main mode to the stand–by mode. As the
force power–off sequence progresses, power–off steps and domain state are displayed
in the Domain Status panel, as shown in the following table.

Force Power Off States

POWERING DOWN

INACTIVE

Table 12. Force power–off states

Once the Force Power Off sequence has been successfully completed, INACTIVE is
displayed in the Domain Status panel and the Power On button becomes accessible.
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For a detailed view of the Force Power Off sequence, click Powering View in the
Toolbar. See Viewing Powering Sequences, on page 3-23.

5. Repeat Steps 2 to 4 for each domain to be forcibly powered down.

 Note:
If an error message is displayed in the Domain Status panel, the Power Off sequence has
failed. See What To Do if an Incident Occurs, on page 3-47.
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Performing a Domain Memory Dump
The Dump command is used when the Operating System hangs and allows technicians to
diagnose software problems by saving domain memory.

 Warning: 
The Dump command should only be used if the Operating System is not able to
respond to a standard Power OFF command. The Dump command may result in
domain data loss and file corruption.
The Dump command does not power down domain hardware (automatic warm
reboot).

To perform a domain memory dump:

1. Click Domain Manager to open the Control pane.

2. Select the required domain. If RUNNING is displayed in the Domain Status panel, the
Dump button is accessible.

3. Click Dump to override the Operating System and forcibly clear domain core memory
which will be copied to the PAP unit hard disk for analysis. The Dump Confirmation
dialog opens.

4. Click Yes to confirm the Dump command.

The Dump sequence results in a warm reboot of the domain BIOS, EFI and Operating
System (without closing running applications and saving data).

As the dump sequence progresses, dump steps and domain state are displayed in the
Domain Status panel, as shown in the following table.

Dump States

POWERING ON

POWERED ON – LOADING BIOS

BIOS READY – STARTING EFI

EFI STARTED – BOOTING OS

RUNNING

Table 13. Dump states

Once the Dump sequence has been successfully completed, RUNNING is displayed in
the Domain Status panel and the Power Off, Reset and Force Power Off buttons
become accessible.

5. Repeat Steps 2 to 4 for each domain on which you want to perform a memory dump.

 Note:
If an error message is displayed in the Domain Status panel, the Dump sequence has
failed. See What To Do if an Incident Occurs, on page 3-47.
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Viewing Domain Functional Status
The Domain Functional Status indicator in the Domain Manager Control pane shows the
functional status of the last action performed on each domain, e.g. if the last Power
ON/OFF sequence was successful, the indicator is green.

As Customer Administrator, you can toggle the PAM Tree to display the synthetic functional
status (round, colored indicator next to the  Domain Manager node) of all the domains
loaded in the Domain Manager Control pane , e.g. if the last Power ON/OFF sequence
was successful on all domains, the indicator is green; if the last Power ON/OFF sequence
failed on at least one domain, the indicator is red. See PAM Status Pane, on page 2-6.

Table 14 explains possible domain functional status indications.

Indicator Status Explanation

Green
NORMAL

Control Pane

The last command on this domain was successful.

PAM Tree

The last command on all domains was successful.

Yellow
WARNING

Control Pane

An automatic Recovery command has been launched on this
domain.

PAM Tree

An automatic Recovery command has been launched on at
least one domain.

Note:
The BIOS recovery program automatically re–flashes the BIOS
when certain problems occur during initialization

Orange
CRITICAL

Control Pane

The last command on this domain was not successful
(Timeout).

PAM Tree

The last command on at least one domain was not successful
(Timeout).

    Red
FATAL

Control Pane

The last command on this domain failed or the Operating
System has been halted.

PAM Tree

The last command on at least one domain failed or the
Operating System on at least one domain has been halted.

Table 14. Domain functional status indicators

 Notes:

• The domain functional status indicator does NOT show the functional status of domain
hardware. The synthetic functional status of CSS hardware is indicated by the System
Functional Status icon in the Status Pane. See Introducing PAM Software, on page 2-5
for further details.

• When, as Customer Administrator, you are informed of a hardware incident, you can use
the PAM Hardware Monitor to obtain CSS hardware presence / functional status details
and to logically Exclude a redundant hardware element from the domain until it has been
repaired or replaced. See Viewing Server Hardware Status, on page 4-12 and
Excluding/Including Hardware Elements, on page 4-21.
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Viewing Domain Power Logs
Power logs are recorded during domain power ON/OFF sequences. This information is
particularly useful for troubleshooting. See What To Do if an Incident Occurs, on page 3-47.

During a Power ON/OFF Sequence

1. Click Domain Manager to open the Control pane.

2. Select the required domain and launch the domain power ON/OFF sequence, as
required.

3. Select the View Power Logs checkbox in the Power Confirmation dialog to
automatically display power logs during the powering sequence.

Figure 43. Power logs dialog

Outside a Power ON/OFF Sequence

• Click Powering View → Power Logs in the Domain Manager Toolbar.

 Note:
Existing power logs are erased when a new power ON sequence is launched.
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Viewing Domain Powering Sequences
A detailed view of powering sequences can be displayed by clicking Powering View in the
Domain Manager Toolbar after a power request.

Status Panel Item Explanation

Domain Selected domain identity.

Central Subsystem Name of the Central Subsystem containing the domain.

Domain State Current power sequence step.

Functional Status Functional status of the last action performed on the domain. 
See Domain Functional Status Indicators, on page 3-21.

Power Steps Dynamic, graphic representation of power sequence steps.

Cell Composition Graphic representation of the core hardware elements in each
cell (hardware partition): QBB(s), IOC(s) – Master / Slave. 
See Configuring Domain Conifguration Schemes and Identi-
ties, on page  5-32.

Figure 44. Powering view dialog

 Note:
An Infotip can be obtained by hovering the mouse over the required element.
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Viewing Domain BIOS Info
BIOS information is particularly useful for troubleshooting. See What To Do if an Incident
Occurs, on page 3-47.

To view BIOS information:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click:

– View → BIOS Info in the Command bar.

or
– Powering View → BIOS Info in the Toolbar.

The BIOS Info dialog opens, displaying the following information:

– BIOS version used by the domain,

– BIOS boot post codes. See BIOS POST Codes, on page C-1.

4. Click Refresh to update BIOS information.

Figure 45. BIOS Info dialog
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Viewing Domain Request Logs
The Request Logs dialog gives direct access to a trace of major domain operations
(requests) and indicates their initiators (requestors).

To view Request logs:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click Request Logs in the Command bar.

The Request Logs dialog displays the following information:

– Power On requests and requestors,

– Power Off requests and requestors,

– Reset requests and requestors.

Figure 46. Request Logs dialog

 Note:
Existing request logs are erased when a new power ON sequence is launched.
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Viewing Domain Configuration, Resources and Status

 Notes:

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

Information about the resources allocated to each domain is permanently accessible from
the Domain Manager Control pane:

• Graphic representation of domain configuration.
• Non–graphic summary of the hardware resources allocated to a domain.
• Graphic summary of the hardware resources allocated to a domain and their status.
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Viewing Domain Configuration
1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click View in the Command bar to open the View Domain dialog.

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 47. View Domain dialog
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View Domain Dialog Items

Domain Item Explanation

Central Subsystem Name of the Central Subsystem containing the domain.

Domain Identity Logical name and profile given to the domain.

EFI LUN Boot LUN device location:

NovaScale 5xx5 Server
0LU0 located in Module0_DIB0 or connected to Module0_IOC0
NovaScale 6085 Server
0LU0 located in Module0_DIB0 or connected to Module0_IOC0
0LU1 located in Module0_DIB1 or connected to Module0_IOC1
NovaScale 6165 Server
0LU0 located in Module0_DIB0 / connected to Module0_IOC0
0LU1 located in Module0_DIB1 or connected to Module0_IOC1
0LU2 located in Module1_DIB0 or connected to Module1_IOC0
0LU3 located in Module1_DIB1  or connected to Module1_IOC1

CPU Number of processors used by the domain.

Memory Size of memory used by the domain.

Composition Graphic representation of the main hardware elements used by
the domain. See Note below.

Module Module housing the cell(s) used by the domain.

Module0 = Cell_0 and Cell_1
Module1 = Cell_2 and Cell_3*

Cell Cell(s) or hardware partition(s) used by the domain.

NovaScale 5085 Server
Cell_0 = Mod0_QBB0, Mod0_IOC0, DIB0
Cell_1 =  Mod0_QBB1
NovaScale 5165 Server
Cell_0 = Mod0_QBB0, Mod0_IOC0, DIB0
Cell_1 =  Mod0_QBB1
Cell_2 =  Mod1_QBB0
Cell_3 =  Mod1_QBB1
NovaScale 6085 Server
Cell_0 = Mod0_QBB0, Mod0_IOC0, DIB0
Cell_1 = Mod0_QBB1, Mod0_IOC1, DIB1
NovaScale 6165 Server
Cell_0 = Mod0_QBB0, Mod0_IOC0, DIB0
Cell_1 = Mod0_QBB1, Mod0_IOC1, DIB1
Cell_2 = Mod1_QBB0, Mod1_IOC0, DIB0
Cell_3 = Mod1_QBB1, Mod1_IOC1, DIB1

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 48. View Domain dialog

 Note:
When the domain is RUNNING, an Infotip identifying the Master QBB / IOC can be obtained
by hovering the mouse over the QBB / IOC icons.
Master IOC = IOC to which the domain boot LUN device is connected (where applicable).
Master QBB = QBB required to start the domain.
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Viewing Domain Hardware Resources
1. Click Domain Manager to open the Control pane.

2. Select the required domain and click View Resources in the View Domain dialog to
open the Domain Hardware Resources dialog.

Figure 49. Domain Hardware Resources dialog
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Viewing Domain Details and Status
1. Click Domain Manager to open the Control pane.

2. Select the required domain and click Resources → More Info... in the Command bar to
open the Domain Hardware Details dialog.

1. Click Domain Manager to open the Control pane.

2. Click View → View Resources → More Info... in the Command bar to open the Domain
Hardware Details dialog.

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 50. Domain Hardware Details dialog
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Domain Hardware Details icons are explained in the following table.

Item Icon Meaning

Memory Memory available per QBB.

Green
No problem detected, operating correctly.

Green
No problem detected, operating correctly.

Minor problem reported, still operational.
Yellow

Minor problem reported, still operational.

Functional Status
Serious problem reported, no longer capable of
operating correctly. PAM may generate an OSFunctional Status

Orange
operating correctly. PAM may generate an OS
shutdown request.

Major problem reported. PAM may automatically shut
down the OS. System integrity is jeopardized.Red

Major problem reported. PAM may automatically shut
down the OS. System integrity is jeopardized.

Cannot be computed (detection circuit error).
Purple

Cannot be computed (detection circuit error).

Green
Physically present and accessible.

Presence Status
Was present in a previous configuration but has
disappeared.Presence Status

Red

Was present in a previous configuration but has
disappeared.

Cannot be computed (detection circuit error).
Purple

Cannot be computed (detection circuit error).

Green
Main power is ON.

Red
Main power is OFF. Stand–by power is ON.

Power Status Pink
Main power is OFF. Stand–by power is OFF.

Blinking
red

Main power is Faulty.
Stand–by power may be ON, OFF or Faulty.

Gray
Main power status is Unknown.

Green

Logically included.

Red/
white

Logically excluded.

Excluded State
Red/

green
To be logically included at the next domain power ON.

Excluded State

Green/
red

To be logically excluded at the next domain power ON.

Yellow
IOC HubLink logically included.

Red
IOC HubLink logically excluded.

Locked State This feature is reserved for future use.

Table 15. Domain hardware details icons
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 Note:
When the domain is INACTIVE, the Domain Hardware Details dialog indicates the
resources that PAM will try to initialize for the domain during the next Power ON sequence.
When the domain is RUNNING, the Domain Hardware Details dialog indicates the
resources that PAM successfully initialized for the domain during the last Power ON or
Reset sequence.

For more information about domain hardware, see:

• Presence Status Indicators, on page 4-6

• Functional Status Indicators, on page 4-7

• Viewing Server Hardware Status, on page 4-12

• Domain Functional Status Indicators, on page 3-21

• Excluding/Including Hardware Elements, on page 4-21

• Limiting Access to Hardware Resources, on page 5-79
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Modifying Domain Configuration

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.

What You Can Do

• Add Cells to a Domain

• Remove Cells from a Domain

• Change a Domain EFI boot LUN

• Delete a Domain

During operation, you may want to re–define server domains to meet variations in workload,
for example. As Customer Administrator or Operator you can modify the configuration of
any INACTIVE domain loaded in the Domain Manager Control pane, at any time, provided
that the required resources are available (IO boxes and QBBs) and that they are supported
by the domain Operating System.

The NovaScale 6xx5 Server server is designed around a flexible, cell–based, midplane
architecture for enhanced performance, scalability and availability. Each CSS Module is
divided into two Cells or hardware partitions, as shown in the following table.

NovaScale 6085 Server

Hardware Cell Cell_0 Cell_1

EFI LUN <MyServer>_0LU0 <MyServer>_0LU1

IOC Mod0_IOC0 Mod0_IOC1

QBB Mod0_QBB0 Mod0_QBB1

DIB Mod0_DIB0 Mod0_DIB1

NovaScale 6165 Server

Hardware Cell Cell_0 Cell_1

EFI LUN <MyServer>_0LU0 <MyServer>_0LU1

IOC Mod0_IOC0 Mod0_IOC1

QBB Mod0_QBB0 Mod0_QBB1

DIB Mod0_DIB0 Mod0_DIB1

Hardware Cell Cell_2 Cell_3

EFI LUN <MyServer>_0LU0 <MyServer>_0LU1

IOC Mod1_IOC0 Mod1_IOC1

QBB Mod1_QBB0 Mod1_QBB1

DIB Mod1_DIB0 Mod1_DIB1

Table 16. NovaScale 6xx5 Server server cell configuration
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Your server is designed to operate as:

NovaScale 6085 Server

• two SMP systems, one using the hardware resources in Cell_0, the other using the
hardware resources in Cell_1 (default configuration),
or

• a single SMP system, using the hardware resources in both Cell_0 and Cell_1,
or

• a single SMP system, using the hardware resources in Cell_0 only,
or

• a single SMP system, using the hardware resources in Cell_1 only.

NovaScale 6165 Server

• four SMP systems, each using the hardware resources in one cell (default configuration),
or

• a single SMP system, using the hardware resources in all cells,
or

• a single SMP system, using the hardware resources in a selection of cells.

As Customer Administrator, you are advised to configure schemes for domain management
via the PAM Domain Configuration Scheme wizard. For further details about domain
configuration options, see Configuring Domains, on page 5-32.

 Notes:

• xx in the default configuration scheme and domain names represents the Central
Subsystem HW identifier (from 00 to 16). For further details, refer to PMB Code Wheel
Settings, on page 4-42.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–xx–1 and MyOperations–xx–3 and an instance of Linux is pre–installed
on MyOperations–xx–2 and MyOperations–xx–4.

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.
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Adding Cells to a Domain

 Notes:

• At least one Cell, containing one IOC and one QBB, must be available.

• The Operating System must support added hardware.

• The domain must be INACTIVE before configuration changes can be made.

• When you add a Cell to a NovaScale 6085 Server domain, the server will operate as a
single SMP system, using all hardware resources.

To add Cells to a domain:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click Modify in the Command bar to open the Modify Domain dialog.

 Note:
The Modify Domain dialog can also be accessed from the View Domain dialog.

Add Cell button

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 51. Modify Domain – Add Cell dialog

4. Click Add Cell. The Add Cells to Domain dialog opens.

 Note:
If a No CELL available message appears, you must first delete the domain using the cell.
See Deleting a Domain, on page 3-44.
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NovaScale 6085 Server

Figure 52. Add Cells to Domain dialog (mono–module server)

NovaScale 6165 Server

Figure 53. Add Cells to Domain dialog (bi–module server)

5. Select the required configuration and click OK. The letter A indicates the cell that will be
added to the domain.
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The new domain configuration is displayed in the Modify Domain dialog.

NovaScale 6085 Server

Cell_1 is added

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 54. Modify Domain – Add Cell confirmation dialog (mono–module server)

NovaScale 6165 Server

Cells_1, _2,
and _3 are added

Figure 55. Modify Domain – Add Cell confirmation dialog (bi–module server)

6. If required, click View Resources for hardware details. See Viewing Domain Hardware
Resources, on page 3-29.

7. Click Apply to apply changes. The selected domain is now extended to the specified
number of Cells.

 Note:
Domain modifications are not saved and are only applicable while the selected domain is
loaded in the Domain Manager Control pane. If required, the new configuration can be
saved for future use. See Saving the Current Domain Configuration Snapshot, on page 3-11.
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Removing Cells from a Domain

 Notes:

• At least one Cell, containing one IOC and one QBB, must remain.

• The domain must be INACTIVE before configuration changes can be made.

• When you remove a Cell from a NovaScale 6085 Server domain,  the server can either
operate as a single SMP system, using only the hardware resources in the remaining
Cell, or as two SMP systems if the removed Cell is allocated to another domain.

 Warning: 
When you remove a Cell from a domain, the devices attached to the corresponding
IOC board are no longer available for this domain.

To remove Cells from a domain:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click Modify in the Command bar to open the Modify Domain dialog.

 Note:
The Modify Domain dialog can also be accessed from the View Domain dialog.
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NovaScale 6085 Server

Remove Cell button

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 56. Modify Domain – Remove Cell dialog (mono–module server)

NovaScale 6165 Server

Remove Cell button

Figure 57. Modify Domain – Remove Cell dialog (bi–module server)
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4. Click Remove Cell. The Remove Cells from Domain dialog opens.

NovaScale 6085 Server

Figure 58. Remove Cells from Domain dialog (mono–module server)

NovaScale 6165 Server

Figure 59. Remove Cells from Domain dialog (bi–module server)

5. Select the required configuration and click OK. The letter R indicates the cell that will be
removed from the domain.
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The new domain configuration is displayed in the Modify Domain dialog.

NovaScale 6085 Server

Cell_1 is free

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 60. Modify Domain – Remove Cell confirmation dialog (mono–module server)

NovaScale 6165 Server

Cell_1 is free

Figure 61. Modify Domain – Remove Cell confirmation dialog (bi–module server)

6. If required, click View Resources for hardware details. See Viewing Domain Hardware
Resources, on page 3-29.

7. Click Apply to apply changes. The selected domain is now reduced to the specified
number of Cells.

 Note:
Domain modifications are not saved and are only applicable while the selected domain is
loaded in the Domain Manager Control pane. If required, the new configuration can be
saved for future use. See Saving the Current Domain Configuration Snapshot, on page 3-11.
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Changing the Domain EFI Boot LUN

 Notes:

• At least two Cells must be included in the Domain.

• The domain must be INACTIVE before configuration changes can be made.

• When you change the EFI boot LUN, you will also change the Operating System
instance.

To change the domain EFI boot LUN:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click Modify in the Command bar to open the Modify Domain dialog.

 Note:
The Modify Domain dialog can also be accessed from the View Domain dialog.

Current boot LUN

Swap LUN button

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 62. Modify Domain – Configure LUN dialog

4. Click the top arrow to display the LUN menu.

5. Click Configure LUN. The Select LUN dialog opens.

Figure 63. Select LUN dialog
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6. Select the required LUN and click OK.

New domain configuration is displayed in the Modify Domain dialog.

New boot LUN

* Module 1 (Cell_2 & Cell_3): does not equip mono–module servers

Figure 64. Modify Domain – Configure LUN confirmation dialog

7. Click Apply to apply changes.

 Note:
Domain modifications are not saved and are only applicable while the selected domain is
loaded in the Domain Manager Control pane. If required, the new configuration can be
saved for future use. See Saving the Current Domain Configuration Snapshot, on page 3-11.
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Deleting a Domain

 Note:
The domain must be INACTIVE to be deleted.

Once loaded in the Domain Manager Control pane, a domain can be deleted from the
current configuration. When the domain has been deleted, the corresponding resources can
be re–allocated to another domain.

To delete a domain from the current configuration:

1. Click Domain Manager to open the Control pane.

2. Select the required domain.

3. Click Delete in the Command bar. The Confirm Remove Domain dialog opens.

NovaScale 6085 Server

Figure 65. Delete domain dialog – mono–module server
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NovaScale 6165 Server

Figure 66. Delete Domain dialog – bi–module server

4. Click Yes to confirm deletion of the selected domain from the current configuration.
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An information box opens, informing you that the domain has been successfully deleted.
The domain is no longer visible in the Control pane.

Figure 67. Domain deleted information box

5. Click OK to continue.

You can now re–allocate the resources of the deleted domain. See Adding a Cell to a
Domain, on page 3-35

 Note:
Domain modifications are not saved and are only applicable while the selected domain is
loaded in the Domain Manager Control pane. If required, the new configuration can be
saved for future use. See Saving the Current Domain Configuration Snapshot, on page 3-11.
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What To Do if an Incident Occurs
When an incident occurs during a domain Power ON / Power OFF / Force Power OFF /
Reset sequence, a message is displayed in the Domain Status panel and a trace is
recorded in the Domain POWER Logs. Table 17 indicates the messages that may be
displayed during an incorrect power sequence.

SEQUENCE ERROR MESSAGE

POWERING ON FAILED

POWERING ON
TIMEOUT DURING POWER ON

POWERING ON
POWERING ON SUSPENDED

DOMAIN HALTED

POWERED ON – LOADING BIOS
RECOVERING BIOS

POWERED ON – LOADING BIOS
BIOS LOADING TIMEOUT

BIOS READY – STARTING EFI TIMEOUT DURING START EFI

POWERING DOWN
POWER DOWN FAILED

POWERING DOWN
TIMEOUT DURING POWER DOWN

Table 17. Domain power sequence error messages

PAM software also informs connected and non–connected users via:

• the PAM Web interface (Status Pane and/or User History files),

• e–mail (users with an appropriate Event Message subscription),

• an autocall to the Bull Service Center (according to your maintenance contract) for
analysis and implementation of the necessary corrective or preventive maintenance
measures, where applicable.

As Customer Administrator, you have access to the System History files and associated
Help Files. As Customer Operator, you have access to the User History and/or Web Event
Messages, and associated Help Files, pre–configured by your Customer Administrator.

You will find all the advice you need in the Help Files associated with the System / User
History and Web Event Messages you are authorized to view.

Whether you open a Web Event Message or a System / User History file, the resulting
display and utilities are the same. See Viewing and Managing Event Messages and History
Files, on page 4-24.

 Note:
All incidents are systematically logged in the System History files, which you can view as
Customer Administrator at any time.
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Dealing with Incidents
When you open the incident Help File, you may be requested to contact your Customer
Service Engineer or perform straightforward checks and actions:

Checking POST Codes

If you are requested to check POST Codes, see Viewing Power Logs, on page 3-24.

Checking Hardware Exclusion Status

If you are requested to check hardware exclusion status, see Excluding / Including
Hardware Elements, on page 4-21.

Checking Hardware Connections

If you are requested to check hardware connections, use Appendix  Cabling Diagrams to
manually and visually ensure that all cables are correctly inserted in their corresponding
hardware ports.

Rebooting Maestro / Resetting the PMB

If you are requested to reboot Maestro or to reset the PMB, see Checking, Testing, and
Resetting the PMB , on page 4-41.

Rebooting the PAP Application

If you are requested to reboot the PAP application:

1. From the Microsoft Windows home page, click Start → Programs → Administrative
Tools → Component Services.

2. From Component Services, click Console Root → Component Services →
Computers → My Computer → COM+ Applications → PAP.

3. Right click PAP to open the shortcut menu. Click Shutdown.

4. Activate the required PAM version to reboot the PAP application. See Deploying a PAM
Release, on page 5-27 and Activating a PAM Version, on page 5-28.

Powering OFF/ON the Domain

If you are requested to Power OFF/ON or Force Power OFF a domain, ensure that you
have saved data and closed open applications. See Powering ON a Domain, on page 3-14,
Powering OFF a Domain, on page 3-16, and Forcing a Domain Power OFF, on page 3-18.

Resetting a Domain

If you are requested to Reset a domain, see Resetting a Domain, on page 3-17.

Performing a Domain Memory Dump

If you are requested to perform a domain memory Dump, see Performing a Domain Memory
Dump, on page 3-20.

Turning the Site Breaker Off

The server is not equipped with a physical power button and can only be completely
powered down by turning the site breaker off.
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Chapter 4. Monitoring the Server

This chapter explains how, as Customer Administrator, you can supervise server operation.

It includes the following topics:

• Introducing PAM Monitoring Tools, on page 4-2

• Using the Hardware Search Engine, on page 4-9

• Viewing PAM Web Site User Information, on page 4-10

• Viewing PAM Version Information, on page 4-11

• Viewing Server Hardware Status, on page 4-12

• Displaying Detailed Hardware Information, on page 4-13

• Excluding / Including Hardware Elements, on page 4-21

• Viewing and Managing PAM Event Messages and History Files, on page 4-24

• Understanding Event Message and History Severity Levels, on page 4-25

• Consulting Event Messages, the Hardware Faults List, and History Files, on page 4-26

• Sorting and Locating Messages, on page 4-28

• What to Do if an Incident Occurs, on page 4-35

 Note:
Customer Administrators and Customer Operators are respectively advised to consult the
Administrator’s Memorandum, on page xxi or the  Operator’s Memorandum, on page xxvi for
a detailed summary of the everyday tasks they will perform.

For further information about user accounts and passwords, see Setting up PAP Unit Users,
on page 5-21.
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Introducing PAM Monitoring Tools
Main Central SubSystem (CSS) hardware components are managed by the comprehensive
Platform Administration and Maintenance (PAM) software specifically designed for Bull
NovaScale Servers.

 Note:
Peripheral devices such as disk racks, PCI adapters, KVM switch, local console, and the
PAP unit are managed by the Operating System and/or by dedicated software.
For details on how to monitor these devices, please refer to the user documentation
provided on the Bull NovaScale Server Resource CD–Rom.

PAM software permanently monitors and regulates CSS hardware during operation,
ensuring automatic cooling for compliance with environmental requirements, power ON /
OFF sequences, component presence and functional status checks, and event handling
and forwarding.

In–depth monitoring is a Customer Administrator function and the PAM Hardware Monitor
is only available to users with administrator access rights. However, all connected users are
permanently and automatically informed of CSS functional status via the PAM Status pane
and of domain status via the PAM Domain Manager Control pane.

The PAM Event Messaging system offers comprehensive event message subscription
options allowing both connected and non–connected users to be informed of server status.
See Customizing the PAM Event Messaging System, on page 5-85 for details.

To refresh the PAM display:

• Click the Refresh Tree button in the PAM Tree toolbar to refresh the PAM Tree.

• Click a node in the PAM Tree to refresh the corresponding Control pane display.

• Click the Refresh Web Page button to return to the PAM Home Page.

 Note:
DO NOT use the Refresh option obtained by right clicking the mouse in the browser window.



4-3Monitoring the Server

Viewing System / Component Status

What You Can Do

• Check system status

• Check CSS module availability status

• Check event message status

• View hardware presence status

• View hardware functional status

• View server hardware status

• View FRU information

• View firmware information

• View thermal status

• View power status

• View temperature status

• View fan status

• View jumper status

• View PCI slot status

PAM Status Pane
When you log onto the PAM Web site, you are able to check system status at a glance via
the Status pane which provides quick access to CSS Module availability status, server
functional status, and pending event message information.

Figure 68. PAM Status pane
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CSS Availability Status

NovaScale 5085 Servers and NovaScale 6085 Servers

When the CSS Module is operating correctly, the CSS Availabilty Status bar is green. If the
CSS Module is not operating correctly, the bar is red.

NovaScale 5165 Servers and NovaScale 6165 Servers

The CSS Availabilty Status bar is divided into two zones.

If the CSS Modules are operating correctly, the CSS Availabilty Status bar is green.

If the CSS Modules are not operating correctly, the bar is red.

If one of the CSS Modules is not operating correctly, half the bar is red.

CSS Module_0  not available
Bar red

Figure 69. CSS Module availability status bar

System Functional Status
If the system is operating correctly, the System Functional Status icon is green. Table 18.
explains possible system functional status indications.

Icon Status Explanation

Green
NORMAL No problem detected. The system is operating correctly.

Yellow
WARNING Minor problem reported. The system is still operational.

CRITICAL
Serious problem reported. The system is no longer
capable of operating correctly. PAM may generate an OS

Orange
CRITICAL capable of operating correctly. PAM may generate an OS

shutdown request.

FATAL
Major problem reported. PAM may automatically shut
down the OS. The system is partially or totally stopped.   Red

FATAL
Major problem reported. PAM may automatically shut
down the OS. The system is partially or totally stopped.

Purple
NOT ACCESSIBLE Status cannot be computed (detection circuit error).

Table 18. CSS hardware functional status icons

  Important: 
If the system functional status icon and/or CSS availability status bar is/are not
green, see What to Do if an Incident Occurs, on page 4-35.

Event Message Status
The New Event Message icon informs you that new messages have arrived and that you
can click the View Event Message icon to view them (the number of unprocessed event
messages is also displayed). See Consulting Event Messages, the Hardware Faults List,
and History Files, on page 4-26.

The Event Message Severity icon indicates the set maximum severity level of
unprocessed event messages. See Understanding Event Message and History Severity
Levels, on page 4-25.
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PAM Tree Pane
As Customer Administrator, you can view the presence and functional status of each
hardware element from the PAM Tree pane. The PAM Tree pane is refreshed at your
request. Use the Refresh PAM Tree button to update the display when required.

  Important: 
To maintain a trace of transient faults, PAM Tree functional and/or presence status
indicators will not change color until the domain has been powered OFF/ON, even if
the error has been corrected.

Displaying Presence Status
When, as Customer Administrator, you log onto the PAM Web site, server hardware
presence status is displayed in the PAM Tree by default (square, colored indicator next to
the Hardware Monitor node). If you expand the PAM Tree, the presence status of all
hardware elements is displayed.

Expand PAM Tree
button

Presence status
indicators

Figure 70. PAM Tree hardware presence status display

When hardware presence status is normal, all presence status indicators are green.
Table 19. explains possible hardware presence status indications.
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Presence Status Indicators

Indicator Status Explanation

NORMAL
This hardware element:

Green
NORMAL

This hardware element:

– is physically present and accessible.

MISSING

This hardware element:

– was present in a previous configuration but has
Red

MISSING – was present in a previous configuration but has
disappeared.

MISSING

A sub–component of this hardware element:

– was present in a previous configuration but has
Red/white

MISSING – was present in a previous configuration but has
disappeared.

NOT ACCESSIBLE
This hardware element:

Purple
NOT ACCESSIBLE

This hardware element:

– cannot be computed (detection circuit error).

NOT ACCESSIBLE
A sub–component of this hardware element:

Purple/white

NOT ACCESSIBLE
A sub–component of this hardware element:

– cannot be computed (detection circuit error).

Purple/red

MISSING AND

NOT ACCESSIBLE

A sub–component of this hardware element:

– was present in a previous configuration but has
disappeared.

A sub–component of this hardware element:

– cannot be computed (detection circuit error).

Table 19. Hardware presence status indicators

  Important: 
If a PAM Tree hardware presence status indicator is not green, this could be normal if
a hardware element has been removed for maintenance. See What to Do if an Incident
Occurs, on page 4-35.
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Displaying Functional Status
You can toggle the PAM Tree to view system / hardware functional status (round, colored
indicator next to the Hardware Monitor node). If you expand the PAM Tree, the functional
status of all hardware elements is displayed. Functional Status is a composite indicator
summarizing Failure Status, Fault Status, Power Status, and Temperature Status indicators,
where applicable.

Presence/Functional

toggle button
status

Expand PAM Tree
button

Functional status
indicators

Figure 71. PAM Tree functional status display

When hardware functional status is normal, all functional status indicators are green.
Table 20. explains possible hardware functional status indications.

Functional Status Indicators

Indicator Status Explanation

NORMAL
No problem detected. This hardware element is
operating correctly.Green

NORMAL
No problem detected. This hardware element is
operating correctly.

WARNING
Minor problem reported. This hardware element is still
operational.Yellow

WARNING
Minor problem reported. This hardware element is still
operational.

CRITICAL
Serious problem reported. This hardware element is no
longer capable of operating correctly. PAM may generate

Orange
CRITICAL longer capable of operating correctly. PAM may generate

an OS shutdown request.

FATAL
Major problem reported. PAM may automatically shut
down the OS. System integrity is jeopardized.   Red

FATAL
Major problem reported. PAM may automatically shut
down the OS. System integrity is jeopardized.

NOT ACCESSIBLE
The functional status of this hardware element cannot be
computed (detection circuit error).Purple

NOT ACCESSIBLE
The functional status of this hardware element cannot be
computed (detection circuit error).

Table 20. Hardware functional status indicators
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  Important: 
To maintain a trace of transient faults, PAM Tree functional and/or presence status
indicators will not change color until the domain has been powered OFF/ON, even if
the error has been corrected. Overall server functional status is indicated by the
system Functional Status icon in the Status pane. For further details, see What to Do
if an Incident Occurs, on page 4-35.

 Note:
If, when you toggle the PAM Tree to view hardware functional status, the functional status of
a hardware element is not normal, the Hardware Monitor node will automatically expand to
the level of the malfunctioning hardware element, as shown in Figure 72.

Functional status: Warning

faulty CPU

PAM Tree automatically expanded to 

Figure 72. PAM Tree – automatically expanded functional status display
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Using PAM Utilities

What You Can Do

• Search for excluded hardware elements

• Search for missing hardware elements

• View PAM Web site information

• View PAM version information

• Exclude / include hardware elements

Using the Hardware Search Engine
The Hardware Search engine allows you to search for and view hardware elements
corresponding to selected criteria, for example Excluded or Missing hardware elements.

 Notes:

• Excluded hardware elements are those that have been logically excluded from the
server. See Excluding / Including Hardware Elements, on page 4-21.

• Missing hardware elements are those that have been physically removed from the
server (e.g. for maintenance).

To search for specific hardware:

1. Click Hardware Monitor in the PAM tree to open the Hardware Search page.

Figure 73. Hardware Search engine

2. Select the required search criteria from the dropdown box and click OK.
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3. Once the search is complete, results are displayed in the control pane.

Figure 74. Hardware Search result list (example)

Viewing PAM Web Site User Information
As Customer Administrator, you can view the list of PAM users currently logged onto the
PAM Web site by clicking Hardware Monitor → PAM Web Site.

The Web site version and a list of connected users and session details are displayed in the
Control pane.

 Note:

The  icon indicates the current session.

Figure 75. PAM Web Site user information
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Viewing PAM Version Information
PAM version information may be useful to help your Customer Service Engineer solve
software–related problems.

To view PAM version information, click Hardware Monitor → PAP. Complete PAM resource
file information is displayed in the Control pane.

Figure 76. PAM version information

The PAP unit information page indicates PAM software version details along with PAM Site
Data and Release Data directory paths.

The PAM Release Data directory is used for all the files delivered as part of PAM software
to ensure configuration consistency.

The PAM Site Data directory is used for all the the files produced by PAM software (history
files, configuration files) concerning Customer site definition and activity.

If you want to deploy a new PAM release or activate another PAM version, see Deploying a
PAM Release, on page 5-27 and Activating a PAM Version, on page 5-28.
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Viewing Server Hardware Status
When you click the CSS Name in the PAM tree (e.g. MYSERVER in the figure), the
Hardware Monitor displays a visual representation of the presence and functional status of
CSS module components in the Control pane. Each primary hardware element functional
status indicator is a clickable hotspot leading directly to the detailed Hardware Status page.

Clickable hotspots
Functional Status

(after toggle)

CSS Name

Presence Status
(default display)

Presence/Functional
Status Tree Toggle

Figure 77. PAM Hardware Monitor

As you click a hardware element hotspot in the Control pane, you will notice that the PAM
Tree automatically expands to the selected component level.

 Note:
If a component is not part of your configuration, it is grayed out in the display.
If a component is part of your configuration but has been detected as “missing”, it is
displayed in red.

The meanings of presence and functional status indicators are explained in  Table 19.
Hardware Presence Status Indicators, on page 4-6 and  Table 20. Hardware Functional
Status Indicators, on page 4-7.

  Important: 
If a functional status indicator is not green, see What to Do if an Incident Occurs, on
page 4-35.

 Note:
The NovaScale 6165 Server Hardware Monitor Control pane displays a visual
representation of the presence and functional status of the components of both CSS
modules.
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Viewing Detailed Hardware Information
For detailed information about module / component / sub–component  status, you can either
click the corresponding hotspot in the Hardware Monitor Control pane or click the required
hardware element in the PAM Tree to open the Hardware Status page.

General Tab
The General tab gives access to the following information:

Presence Status Indicates if the hardware element is physcially present and correctly
configured. See Presence Status Indicators, on page 4-6.

Functional Status Indicates if the hardware element is functioning correctly.
See Functional Status Indicators, on page 4-7.
NOTE:
Functional Status is a composite indicator summarizing Failure
Status, Fault Status, Power Status, and Temperature Status
indicators, where applicable.

Failure Status Indicates if a failure has been detected on the hardware element.
NOTE:
This feature is reserved for future use.
See Failure Status Indicators, on page 4-14.

Fault Status Indicates if a fault has been detected on the hardware element.
See Fault Status Indicators, on page 4-14.

Display Faults List When a fault is detected, a fault message is generated and the
Display Faults List button gives direct access to the list of faults
recently encountered by this hardware element.
See Consulting Event Messages, the Hardware Faults List, and
History Files, on page 4-26.

Exclude Status The Exclude checkbox is used to logically exclude/include hardware
elements from the domain.
See Excluding / Including Hardware Elements, on page 4-21.

Locked State This feature is reserved for future use.

Figure 78. General Hardware Status page (example)



4-14 User’s Guide

Failure Status Indicators:

Indicator Status Explanation

NORMAL
PAM software has detected no failures on this hardware
element.Green

NORMAL
PAM software has detected no failures on this hardware
element.

DEGRADED
PAM software has detected that this hardware element
is running at sub–standard capacity but is not

Orange
DEGRADED is running at sub–standard capacity but is not

jeopardizing system performance.

FAILED
PAM software has detected a failure that may be
jeopardizing system performance.   Red

FAILED
PAM software has detected a failure that may be
jeopardizing system performance.

Gray

UNKNOWN
PAM software is not receiving diagnostic information
from this hardware element.

Fault Status Indicators

Fault Status, accessible via the General tab,

Indicator Status Explanation

NORMAL
PAM software has detected no faults on this hardware
element.Green

NORMAL
PAM software has detected no faults on this hardware
element.

FAULTY
PAM software has detected 1 or more fault(s) on this
hardware element.   Red

FAULTY
PAM software has detected 1 or more fault(s) on this
hardware element.

   Gray
UNKNOWN

PAM software is temporarily meaningless (e.g. hardware
element missing).

Table 21. Fault status indicators

FRU Info Tab
The FRU Info tab gives access to Field Replaceable Unit identification data for the
hardware element, such as Manufacturer’s name, product name, part number, ... .

Figure 79. FRU data (example)



4-15Monitoring the Server

Firmware Tab (Core MFL & PMB only)
The Firmware tab gives access to firmware version data for the hardware element.

 Note:
Firmware versions may differ.

Figure 80. Firmware data (example)

Thermal Zones (CSS module only)
Thermal Zones, accessible via the Thermal zones tab, shows the thermal zones monitored
by PAM software. A cooling error in a thermal zone will affect all the hardware elements in
that zone. See Functional Status Indicators, on page 4-7.

Figure 81. CSS module thermal zone details

 Note:
When a thermal fault is detected, a fault message is generated and the General tab
Display Faults List  button gives direct access to the corresponding logs.
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Power Tab
The Power tab gives access to power status data for the hardware element, indicating main
and standby power state and/or power–specific faults for each converter. See Functional
Status Indicator, on page 4-7.

Once connected to the Customer’s site power supply, server hardware elements initialize to
the stand–by mode. Server hardware elements initialize to the main mode when the domain
is powered up.

Nominal values

Measured values

Figure 82. Converter power status details (example)

Indicator Status Explanation

MAIN POWER ON
Green

MAIN POWER ON

Hardware element main / standby power is on.

Green
STANDBY POWER ON

Hardware element main / standby power is on.

MAIN POWER OFF
White

MAIN POWER OFF

Hardware element main / standby power is off.
STANDBY POWER

Hardware element main / standby power is off.

White

STANDBY POWER

OFF

MAIN POWER

   Red

MAIN POWER

FAULT/FAILED PAM software has detected 1 or more main / standby
power fault(s) on this hardware element.STANDBY POWER

PAM software has detected 1 or more main / standby
power fault(s) on this hardware element.

   Red

STANDBY POWER

FAULT/FAILED

Gray

MAIN POWER

MISSING/UNKNOWN
PAM software cannot read main / standby power status
on this hardware element.STANDBY POWER

PAM software cannot read main / standby power status
on this hardware element.

Gray

STANDBY POWER

MISSING/UNKNOWN

Table 22. Power tab status indicators
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CSS Module Power Tab
The Power tab gives access to power status data for the CSS module DPS units.

48V Presence Meaning

PRESENT At least 1 DPS unit is ON.

ABSENT All DPS units are OFF.

Not Found PAM software cannot read CSS module power status.

48V Value Current intensity in Amperes (varies according to configuration).

Figure 83. CSS module power status details

 Note:
When a power–specific fault is detected, a fault message is generated and the General tab
Display Faults List  button gives direct access to the corresponding logs.
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Temperature Tab
The Temperature tab gives access to temperature status data for the hardware element,
indicating overtemperature or temperature–specific faults.

Figure 84. Temperature probe status details (example)

Indicator Status Explanation

Green
NORMAL Hardware element temperature is normal.

WARNING
PAM software has detected a rise in temperature on this
hardware element, but it is still operational and is not

Yellow
WARNING hardware element, but it is still operational and is not

jeopardizing system performance.

CRITICAL
PAM software has detected a critical rise in temperature on this
hardware element. PAM will generate an OS shutdown

Orange

CRITICAL hardware element. PAM will generate an OS shutdown
request.

FATAL
PAM software has detected a fatal rise in temperature on this
hardware element. PAM will automatically shut down the OS.   Red

FATAL
PAM software has detected a fatal rise in temperature on this
hardware element. PAM will automatically shut down the OS.

Gray
UNKNOWN

PAM software cannot read temperature status on this
hardware element.

Table 23. Temperature tab status indicators

 Note:
When a temperature–specific fault is detected, a fault message is generated and the
General tab  Display Faults List  button gives direct access to the corresponding logs.
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Fan Status (Fanboxes only)
Fan Status, accessible via the Fans tab, indicates fan status, speed and supply voltage.
See Functional Status Indicator , on page 4-7.

During normal operation, the display depicts fan rotation.

Each fanbox is equipped with 2 hot–swap, redundant, automatically controlled fans.

 Note:
If all fans are halted in the display, check that your browser allows you to play animations in
Web pages.

Figure 85. Fanbox details (example)

Jumper Status (IOC only)
Reserved for Customer Service Engineers.

Jumper Status, accessible via the Jumpers tab, indicates the current position of BIOS
Recovery, ClearCMOS, and ClearPassword jumpers. Reserved for Customer Service
Engineers.

Figure 86. IOB jumpers tab
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PCI Slots (IOC only)
PCI Slot Status, accessible via the PCI Slots tab, shows PCI board type and the functional
and power status of PCI slots at the last domain power–on.

When a fault is detected on a PCI slot, a fault message is generated and an IOC Faults
List button gives direct access to the list of faults recently encountered on the IOC.
The Exclude checkboxes are used to exclude / include one or more PCI slots in the domain
at the next power–on. See Excluding / Including Hardware Elements, on page 4-21.

Power status indicators

Figure 87. PCI slots tab

Clicking a PCI board gives access to PCI Slot Details: such as Minor and Signal status,
Logical, Bus and Device numbers, Bus and Board frequencies, Vendor, Device and
Revision identifiers, and Class code.

Figure 88. PCI slot details dialog (example)
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Excluding / Including  Hardware Elements
As Customer Administrator, if a redundant hardware element is faulty, you can logically
Exclude it from the domain until it has been repaired or replaced. To be taken into account,
exclusion requires domain power OFF/ON.

The Exclusion / Inclusion function can also be used to logically limit access to certain
hardware resources, such as system disks. See Limiting Access to Hardware Resources,
on page 5-79.

A complete list of logically excluded hardware elements can be obtained via the Hardware
Monitor search engine. See Using the Hardware Search Engine, on page 4-9.

  Important: 
Hardware elements must be excluded with care. The exclusion of non–redundant
hardware elements will prevent the server domain from booting. Exclusion guidelines
are given in the Hardware exclusion guidelines table, on page 4-23.

Excluding a Hardware Element

  Important: 
The exclusion of a hardware element is only taken into account at the next domain
power ON. A complete list of logically excluded hardware elements can be obtained
via the Hardware Monitor search engine. See Using the Hardware Search Engine, on
page 4-9.

1. Check that the hardware element is “excludable” and that exclusion will not affect
domain availability. See Hardware Exclusion Guidelines, on page 4-23.

2. Click the required hardware element in the PAM Tree to open the Hardware Status
page.

Exclude checkbox

Figure 89. Example Hardware Status page

3. Select the Exclude checkbox and click Apply. The Exclude dialog box opens.

4. Click Yes to confirm exclusion of the selected hardware element. Exclusion will be taken
into account at the next domain power ON.
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 Note:
If you want to check domain hardware status, click Domain Manager → Resources →
More info... to open the Domain Hardware Details page. Hardware elements to be

logically excluded at the next domain power ON are marked with a green  icon in the
Excluded State column. See Viewing Domain Hardware Resources, on page 3-26.

Including a Hardware Element

  Important: 
The inclusion of a hardware element is only effective once the domain has been
powered OFF/ON.

1. Click the required hardware element in the PAM Tree to open the Hardware Status
page.

Exclude checkbox

Figure 90. Example Hardware Status page

2. Deselect the Exclude checkbox and click Apply. The Include dialog box opens.

3. Click Yes to confirm inclusion of the selected hardware element. Inclusion will be taken
into account at the next domain power ON.

 Note:
If you want to check domain hardware status, click Domain Manager → Resources →
More info... to open the Domain Hardware Details page. Hardware elements to be

logically included at the next domain power ON are marked with a red   icon in the
Excluded State column. See Viewing Domain Hardware Resources, on page 3-26.
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Hardware Exclusion Guidelines

Hardware Element Exclusion Guidelines

IMPORTANT:
If the following hardware elements are excluded, the corresponding server domain will
not power up:
• Master IOC
• Master IOC HubLink 1
• Master IOC PCI Slots 1 & 2
• Master IOL
Note:
When a domain comprises more than one cell (therefore more than one IOC), the Master IOC
is the one hosting the boot disk. The other IOCs in the domain are Slave IOCs.

IOC • Slave IOCs can be safely excluded from a domain, but

connected peripherals will no longer be accessible.
• If the Master IOC is excluded from a domain, the domain will

not power up.

IOC HubLink • All IOC HubLinks not connected to a boot disk can be safely

excluded from a domain, but connected peripherals will no
longer be accessible.
IOC HubLinks are organized as follows:
HubLink_1 controls PCI Slots 1 & 2 (Master IOC boot disk)

HubLink_2 controls PCI slots 3 & 4
HubLink_3 controls PCI slots 5 & 6
Note:
If Master IOC HubLink_1 is excluded, the domain will not power
up.

PCI Slot • All PCI slots not connected to a boot disk can be safely

excluded from a domain, but connected peripherals will no
longer be accessible.
Note:
If Master IOC PCI Slots 1, 2 are excluded, system disks will no

longer be accessible and the domain will not power up.

IOL • Slave IOLs can be safely excluded from a domain, but

connected peripherals will no longer be accessible.
Note:
If the Master IOL is excluded, the domain will not power up.

QBB • At least one QBB must be “included” in a domain.

CPU • At least one CPU must be “included” in a QBB.

Note:
If all CPUs are excluded from a QBB, the QBB itself is
excluded.

SPS • At least one SPS must be “included” in a Core Unit.

Note:
MSX_0 SPS all CPUs are excluded from a QBB, the QBB itself
is excluded.

Clock • At least one Clock must be “included” in a Core Unit.

DPS Unit • Only one DPS unit can be safely excluded at a given time.

Fanbox • Only one Fanbox can be excluded from a domain at a given

time.
Note:
If more than one Fanbox is excluded, the domain may not
power up.

Table 24. Hardware exclusion guidelines
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Viewing and Managing PAM Event Messages and History Files

What You Can Do

• View Web event messages

• Acknowledge Web event messages

• Sort and locate Web event messages

• View e–mailed event messages

• Display the hardware faults list

• View history files online

• View archive files online

• View history files offline

• View archive files offline

• Manually archive history files

• Manually delete archive files

A comprehensive set of Event Message subscriptions allows connected and non–connected
users to be notified of system status and activity. Pre–defined Event Message
Subscriptions forward event messages for viewing/archiving by targeted individuals and/or
groups, with an appropriate subscription, via:

• the PAM Web interface (connected Customer Administrator / Operator),

• User History files (connected Customer Administrator / Operator),

• e–mail (non–connected recipients – Customer Administrator / Operator / other)

• SNMP traps (non–connected recipients – Customer Administrator / Operator / other),

• an autocall to the Bull Service Center (according to your maintenance contract).

 Note:
Subscriptions can be customized to suit your working environment. For further details, see
Customizing the PAM Event Messaging System, on page 5-85.



4-25Monitoring the Server

Understanding Message Severity Levels
Messages are graded into four severity levels as shown in the following table.

Icon Severity Level Explanation

SUCCESS An action requested by a user has been performed
correctly or a function has been completed successfully.
Information message, for guidance only.

INFORMATION System operation is normal, but status has changed.
Information message, for guidance and verification.

WARNING An error has been detected and overcome by the
system or a processed value is outside standard limits
(e.g. temperature).
System operation is normal, but you are advised to
monitor the hardware concerned to avoid a more
serious error.
See What to Do if an Incident Occurs, on page 4-35.

ERROR An error has been detected and has not been overcome
by the system.
System integrity is jeopardized. Immediate action is
required.
See What to Do if an Incident Occurs, on page 4-35.

Table 25. Message severity levels

During normal operation, messages will be marked with the SUCCESS or INFORMATION
icon.

 Note:
A single message may have different severity levels. For example, the message
<Unit absent> may be the result of a:

• Presence Status request, indicating component status (information level).

• Action request, indicating an error. The command cannot be executed because the
component is absent (error level).

  Important: 
If a message is marked with the WARNING or ERROR symbol, see What to Do if an
Incident Occurs, on page 4-35.
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Consulting Event Messages, Hardware Faults and History/Archive Files
Whether you consult a Web Event Message, the Hardware Faults List, a System / User
History or Archive, the resulting display and utilities are the same.

Access to Help Message

Button Use

Acknowledge selected events To remove viewed messages from the pending event list.

Select all events To select all Ack checkboxes.

Unselect all events To deselect all Ack checkboxes.

Help To access context sensitive help.

Search

– String
– Contained in attribute
– Case sensitive

To search for specific messages, according to:

– Alphanumeric identifier (ID), e.g. 2B2B2214 above.
– Message Source, Target, String, Data attributes.
– Upper case / lower case letters.

Reset To delete the current search history.

Ack To select the message for acknowledgement.

+ To view the message and access context sensitive help.

Help on message To view the related help message.

Column Header* Use

Type To sort messages according to severity level.

ID To sort messages according to Message IDentifier, e.g.
2B2B2214 above.

Local Time To sort messages according to message local time and
date.

Target To sort messages according to the component referred
to in the message.

String To sort messages according to message text string.

* Double click the column header to sort messages
Figure 91. Display Events page

  Important: 
If a message is marked with the WARNING or ERROR symbol, see What to Do if an
Incident Occurs, on page 4-35.
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Specimen Message Help File

The Help File explains the message and indicates related actions, where applicable, as
shown in  Figure 92.

Figure 92. Specimen message help file

Viewing and Acknowledging PAM Web Event Messages
To consult Web event messages:

1. From the Status pane, click the  icon to open the Display Events page. See Figure
91. Display Events page, on page 4-26.

2. Click the + sign to expand the required message.

3. Click the Help on message <xxx> button at the bottom of the message page for direct
access to the corresponding Help File. See Table 92 Specimen message help file, on
page 4-27.

In addition to standard utilities, the Web Event Message display allows users to
acknowledge messages.

  Important: 
A maximum of 100 messages are accessible from the Status Pane. Users are advised
to regularly acknowledge processed messages to allow the arrival of new messages.
Acknowledged messages are stored in the PAMHistory file and can be viewed when
required.
See Viewing, Archiving, and Deleting History Files, on page 4-29.
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To acknowledge Web event messages:

1. Select the required checkbox(es) in the Ack column or click Select all events to
automatically select all checkboxes in the Ack column.

2. Click Acknowledge selected events.
Acknowledged messages are removed from the pending event list and are no longer
accessible via the Status pane. The Pending Event Message Indicator in the Status
pane is updated automatically.

Sorting and Locating Messages
From the message display, when you hover the mouse in the Type column, an InfoTip
gives a brief summary of the message allowing you to rapidly scan the list for the required
message(s). Use the standard + and – signs to expand and collapse selected messages.

It may be difficult to locate a message if the list is long, the following short–cuts can be used
to organize the display and to locate required messages.

Sorting Messages

Messages can be sorted by clicking a column header to sort the column, e.g. by Severity
(SV), ID, Time, Target, String. Once sorted, messages will be displayed according to the
selected column header.

Locating messages

The Search engine can be used to filter the number of displayed logs according to Source,
Target, String, Data attributes. All four attributes are selected by default, but a single
attribute can be selected from the dropdown menu.

To search the message list:

1. If known, enter an alphanumeric message string in the String field.

2. Select the required attribute field from the contained in attribute dropdown menu.

3. Case sensitive is selected by default, deselect if required.

4. Click Search to display search results.

5. If you want to carry out another search, click Reset to delete the search history.

Viewing E–mailed Event Messages
These messages contain the same information as those available to connected users, but
do not contain the corresponding help file.  See Figure 91. Display Events page, on page
4-26.

Displaying the Hardware Faults List
The Faults List page allows you to view messages corresponding to the faults recently
encountered by a given hardware element.

To access the Faults List page:

1. Toggle the PAM Tree to display hardware functional status.

2. Click the faulty element node to open the Hardware Status page.

3. Click Display Faults List to open the Faults List page.

4. Click the + sign to expand the required message.

5. Click the Help on message <xxx> button at the bottom of the message page for direct
access to the corresponding Help File.
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Viewing, Archiving and Deleting History Files
History and archive files are systematically stored in the PAMSiteData directory:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\<DataCompatibilityRelease>

The PAM History Manager allows you to view, archive and delete history files online and
provides you with the tools required to download and view history and archive files offline.

As Customer Administrator / Operator, you will frequently consult PAMHistory files for
information about system operation.

 Note:
System histories and/or archives are only accessible to members of the Customer
Administrator group, whereas User histories and/or archives are accessible to members of
both the Customer Administrator and Customer Operator groups. For further details about
histories and archives, see Creating a User History, on page 5-93 and Editing History
Parameters, on page 5-94.

Viewing History Files Online

 Note:
Empty history files cannot be viewed.

To view a history file online:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Histories tab.

Figure 93. History Manager Control pane – Histories tab

3. Highlight the required type of history and click View. All the messages contained in the
selected history are displayed.

4. Select the message you want to view in detail. The resulting display is the same as for
event messages. See Table 91 Display Events list, on page 4-26.
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Viewing History Properties

To view history properties:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Histories tab.

3. Highlight the required type of history and click Properties. The History Properties
dialog opens.

Name History name.

Description Optional description of history contents.

Directory Pathname of the directory used to store histories. If this field is
blank, the default Histories directory is used.

Automatic Archiving Policy

Type Number of days:
The system will automatically create an archive for this history after
the number of days specified in the Value field.

Size in KBytes:
The system will automatically create an archive when this history
reaches the size in KBytes specified in the Value field.

Number of Records:
The system will automatically create an archive when this history
reaches the number of records specified in the Value field.

Value Number of days / KBytes / records – according to archiving type.

Archive Properties

Duration Regular interval at which the archive is automatically deleted.

Figure 94. History properties

 Note:
As Customer Administrator, you can modify History properties from the Histories Control
pane. See Editing History Parameters, on page 5-94.
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Manually Archiving History Files
In general, history files are automatically archived at regular periods. However, you can
choose to manually archive a history file at any time, if required.

 Note:
Empty history files cannot be archived.

To manually archive a history file:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Histories tab.

3. Select the required type of history checkbox or select the Archive All checkbox to
archive all histories.

4. Click Archive checked histories. A dialog box opens, requesting you to confirm file
archiving.

5. Click OK to confirm. The selected history(ies) are archived.

Viewing Archive Files Online

 Note:
Empty archive files cannot be viewed.

To view an archive file online:

1. From the PAM Tree pane, click History Manager to open the Control pane.

1. Select the Archived histories tab.

Figure 95. History Manager Control pane – Archived histories tab

2. Use the scroll–down menu to select the type of history archive you want to display. The
corresponding list of archived histories appears in the Archiving date zone.

3. Highlight the required archiving date and click View. All the messages contained in the
selected archive are displayed.
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4. Select the message you want to view in detail. The resulting display is the same as for
event messages. See Table 91 Display Events list, on page 4-26.

Viewing Archive Properties

To view archive properties:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Archived histories tab.

3. Use the scroll–down menu to select the type of history archive you want to display. The
corresponding list of archived histories appears in the Archiving date zone.

4. Highlight the required archiving date and click Properties. The Archive Properties
dialog opens.

Name History name, archiving date and time.

Description Optional description of history contents.

Directory Pathname of the directory used to store histories. If this field is
blank, the default Histories directory is used.

Date Archiving date and time.

Duration Regular interval at which the archive is automatically deleted.

Number of messages Number of messages in the archive.

File Size (Kb) Archive size in Kb.

Figure 96. Archive properties

 Note:
As Customer Administrator, you can modify Archive properties from the Histories Control
pane. See Editing History Parameters, on page 5-94.
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Manually Deleting a History Archive File
In general, history archive files are automatically deleted at regular periods. However, you
can choose to manually archive a history archive file at any time, if required.

To manually delete a history archive file:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Archived histories tab.

3. Use the scroll–down menu to select the type of history archive you want to delete. The
corresponding list of archived histories appears in the Archiving date zone.

4. Select the required archive checkbox or select the Delete All checkbox to delete all
archives.

5. Click OK to confirm. The selected archives are deleted.

Downloading History / Archive Files for Offline Viewing
The PAM History Manager allows you to compress and download history and/or archive
files to a local or network directory for offline viewing. The downloaded files can then be
viewed with the History Viewer tool which displays all the sort options available online, but
does not contain the corresponding help file.

 Note:
Empty history / archive files cannot be downloaded.

Downloading History Viewer

Before downloading history and/or archive files for offline viewing, you are advised to
download the History Viewer tool:

1. From the PAM Tree pane, click History Manager → Tools.

2. Click History Viewer to download the HistoryViewer.zip file.

3. Unzip all the files in the HistoryViewer.zip file.

Downloading History / Archive Files

To download history / archive files:

1. From the PAM Tree pane, click History Manager to open the Control pane.

2. Select the Histories or Archived histories tab, as required.

3. Select the required type of history or archive:

Histories

– Select the required history checkbox or select the Basket All checkbox to download
all histories.

Archives

– Use the scroll–down menu to select the required archive. The corresponding list of
archived histories appears in the Archiving date zone.

– Select the required archive checkbox or select the Basket All checkbox to download
all archives.

4. Click Add selected files to basket.

 Note:
Files already selected for downloading can be viewed by clicking Show basket details.

5. Click Download Compressed File to compress and download the histories/archives to
the required local or network directory for offline viewing.
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Viewing History / Archive Files Offline

1. Click the HistoryViewer.htm file to open the View History File page.

2. Complete the History File Name field and click Read, or click Browse to search for and
load the required history or archive file.

3. Select the message you want to view in detail. The resulting display is the same as for
event messages. See Table 91Display Events list, on page 4-26.

 Note:
For further details about histories and archives, see Creating a User History, on page 5-93
and Editing History Parameters, on page 5-94.
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What to Do if an Incident Occurs
Server activity is systematically logged in the System History files, which you can view as
Customer Administrator at any time.

When an incident occurs, PAM software informs users via:

• the Status pane,

• Event Message / History file,

• e–mail / SNMP traps (users with an appropriate Event Message subscription),

• an Autocall to the Bull Service Center (according to your maintenance contract).

In most cases, PAM software handles the incident and ensures operational continuity while
the Bull Service Center analyzes the incident and implements the necessary corrective or
preventive maintenance measures.

Whenever you are informed of an incident:

• functional or presence status indicators / icon NOT green,

• event message or history file marked with the WARNING or ERROR symbol,

you are advised to connect to the PAM Web site (if you are not already connected) and to
investigate the incident.

Investigating Incidents
1. Check the system functional status icon in the Status pane. If the icon is not green, the

server is not operating correctly. See Table 27. System Functional Status / Expected
Domain State, on page 4-36.

2. Open the Domain Manager Control pane and identify the domain using the faulty

hardware element by hovering the mouse over the Domain Memo  icons to display
the Cell infotip.

NovaScale 5085 Server

Cell 0 Module0_IOC0, Module0_QBB0, Module0_DIB0

Cell 1* Module0_QBB1

NovaScale 5165 Server

Cell 0 Module0_IOC0, Module0_QBB0, Module0_DIB0

Cell 1 Module0_IOC1, Module0_QBB1

Cell 2 Module1_IOC0, Module1_QBB0

Cell 3 Module1_IOC1, Module1_QBB1,

NovaScale 6085 Server

Cell 0 Module0_IOC0, Module0_QBB0, Module0_DIB0

Cell 1 Module0_IOC1, Module0_QBB1, Module0_DIB1

NovaScale 6165 Server

Cell 0 Module0_IOC0, Module0_QBB0, Module0_DIB0

Cell 1 Module0_IOC1, Module0_QBB1, Module0_DIB1

Cell 2 Module1_IOC0, Module1_QBB0, Module0_DIB0

Cell 3 Module1_IOC1, Module1_QBB1, Module0_DIB1

Table 26. Domain cells
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– If the domain is operating normally, RUNNING is displayed in the Domain State field.

– If the domain has been automatically powered down, INACTIVE is displayed in the
Domain State field. See Table 27. System Functional Status / Expected Domain
State, on page 4-36 and Chapter 3. Managing Domains, on page 3-1.

 Warning: 
If system functional status is critical (flashing red icon), immediately save data, close
open applications and shut down the domain Operating System.

System Functional Status / Expected Domain State

Icon System Functional Status Expected Domain State

Green
NORMAL RUNNING

Yellow
WARNING RUNNING

Orange

CRITICAL INACTIVE (auto Power OFF) / RUNNING
An automatic Power OFF request may be
sent by PAM software to the domain Operat-
ing System:
– If the domain Operating System is

configured to accept PAM Power OFF
requests, it automatically saves data,
closes open applications and shuts down.

– If the Operating System is not configured
to accept PAM Power OFF requests, youOrange

Flashing

– If the Operating System is not configured
to accept PAM Power OFF requests, you
are advised to manually save data, close
open applications and shut down the
Operating System.

Note:
When system functional status is FATAL, the
icon does not always remain red. Therefore,
an orange functional status icon may indicate
a FATAL hardware  status.

   Red

FATAL INACTIVE
An automatic Force Power OFF command
may be performed by PAM software on the
domain Operating System.
Note:   Red

Flashing

domain Operating System.
Note:
The Operating System does not have time to
save data and close applications before it is
shut down.

Purple
NOT ACCESSIBLE INACTIVE

Table 27. CSS functional status / domain state

3. Toggle the PAM Tree to view hardware functional status (round, colored indicator next to
the Hardware Monitor node). The PAM Tree will automatically expand down to the
faulty hardware element.

4. Check domain state by clicking Domain Manager in the PAM tree.

5. Click the faulty hardware element to open the corresponding Hardware Status page.

6. Check Power and Temperature tabs. If a power and/or temperature indicator is NOT
green, a power– and/or temperature–specific fault has occurred. See Power Status
Indicators and Temperature Status Indicators, on page 4-16.
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7. Click Display Faults List for direct access to server logs. If the Display Faults List
button is not accessible, click History Manager → System → PAM History for the
corresponding log. See Displaying Detailed Hardware Status, on page 4-13.

8. Expand the log for direct access to the corresponding Help File (at the bottom of the
page). The Help File explains the message and how to deal with the incident.

  Important: 
To maintain a trace of transient faults, PAM Tree functional and/or presence status
indicators will not change color until the domain has been powered OFF/ON, even
although the error has been corrected.
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Dealing with Incidents
When you open the incident Help File, you may be requested to perform straightforward
checks and actions or to contact your Customer Service Engineer. This section explains
how to respond to the following requests:

• Check Environmental Conditions

• Check Hardware Availability

• Check Hardware Connections

• Exclude a Hardware Element

• Check Hardware Exclusion Status

• Check Hardware Fault Status

• Check Power Status

• Check Temperature Status

• Check Histories and Events

• Check SNMP Settings

• Check Autocall Settings

• Check PAM Version

• Check MAESTRO Version

• Check Writing Rules

• Power ON/OFF the Domain

• Reboot the PAP Application

• Modify LUN Properties

• Check, Test, and Reset the PMB

Checking Environmental Conditions
If you are requested to check environmental conditions, ensure that the computer room is
compliant with the specifications set out in Appendix A.Specifications.

Checking Hardware Availability
If you are requested to check hardware availability:

1. Check that the CSS module availability status bar is green. If the status bar is not green,
the CSS module has not been detected by PAM software. Check the physical PMB to
PAP unit Ethernet link connection.

2. Toggle the PAM Tree to view hardware presence status (square, colored indicator next
to the Hardware Monitor node).

3. Expand the Hardware Monitor node to view the presence status of all hardware
elements. If a hardware presence status indicator is NOT green, the hardware element is
either missing or not accessible.

  Important: 
If a PAM Tree hardware presence status indicator is not green, this could be normal if
the corresponding hardware element has been removed for maintenance.
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Checking Hardware Connections
If you are requested to check hardware connections, use  Cabling Diagrams to manually
and visually ensure that all cables are correctly inserted in their corresponding hardware
ports.

Excluding a Hardware Element and Checking Exclusion Status
As Customer Administrator, you can logically Exclude a redundant hardware element from
the domain until it has been repaired or replaced. Exclusion is taken into account at the next
domain power ON. See Excluding / Including Hardware Elements, on page 4-21.

If you are requested to check hardware exclusion status, use the Hardware Search engine
to search for and view Excluded hardware elements. See Using the Hardware Search
Engine, on page 4-9.

You can also view domain hardware exclusion status from the Domain Hardware Details
page. See Viewing Domain Hardware Resources, on page 3-26.

Checking Hardware Fault Status
If you are requested to check hardware fault status:

1. Click the corresponding hardware element in the PAM Tree to open the Hardware
Status page.

2. Check the General tab. If the fault status indicator is NOT green, a fault has occurred.
See Fault Status Indicators, on page 4-14.

Checking Hardware Power Status
If you are requested to check hardware power status:

1. Click the corresponding hardware element in the PAM Tree to open the Hardware
Status page.

2. Check the Power tab. If a power indicator is NOT green, a power–specific fault has
occurred. See Power Status Indicators, on page 4-16.

Checking Hardware Temperature Status
If you are requested to check temperature status:

1. Click the corresponding hardware element in the PAM Tree to open the Hardware
Status page.

2. Check the Temperature tab. If a temperature indicator is NOT green, a
temperature–specific fault has occurred. See Temperature Status Indicators, on page
4-18.

Checking Histories and Events
If you are requested to check histories / events, refer to Viewing and Managing Event
Messages and History Files, on page 4-24.
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Checking SNMP Settings
If you are requested to check SNMP settings, IP address, or server name for an event
subscription:

1. From the PAM Tree, click Configuration Tasks → Events → Channels and check that
the SNMP Channel is enabled.

2. Click Subscriptions to view configured subscriptions. Channel type is indicated in the
Channel column.

3. Select the required SNMP Channel subscription from the list and click Edit to view /
modify SNMP settings.

Checking Autocall Settings
If you are requested to check Autocall settings:

1. From the PAM Tree, click Configuration Tasks → Autocalls and check that the Enable
Autocalls checkbox is selected.

2. Check dispatch modes and corresponding settings.

Checking PAM Version
If you are requested to check PAM version:

From the PAM Tree, click PAP to display the PAP Unit Information page. PAM version is
displayed at the top of the page.

Checking MAESTRO Version
If you are requested to check MAESTRO version:

From the PAM Tree, click Hardware Monitor → PMB to open the PMB Status page. Click
the FIRMWARE tab to view MAESTRO version.

Checking Writing Rules
If you are requested to check writing rules, see PAM Writing Rules, on page xxiii.

Powering OFF/ON a Domain
If you are requested to Power OFF/ON or Force Power OFF a domain, ensure that you
have saved data and closed open applications. See Managing Domains, on page 3-1.

Rebooting the PAP Application
If you are requested to reboot the PAP application:

1. From the Microsoft Windows home page, click Start → Programs → Administrative
Tools → Component Services.

2. From Component Services, click Console Root → Component Services →
Computers → My Computer → COM+ Applications → PAP.

3. Right click PAP to open the shortcut menu. Click Shutdown.

4. Activate the required PAM version to reboot the PAP application. See Deploying a PAM
Release, on page 5-27 and Activating a PAM Version, on page 5-28.
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Modifying LUN Properties
If you are requested to modify LUN properties:
• Refer to Configuring SCSI Data Disks, on page 5-5 and to the appropriate Disk

Subsystem documentation.
• Refer to Configuring FDA Data Disks, on page 5-8 and to the appropriate Disk

Subsystem documentation.

Checking, Testing and Resetting the PMB
The PMB is located in the module at the base of the cabinet and links the server to the PAP
unit via an Ethernet link. You may be required to carry out the following checks / actions:

• Check that PMB LED #0 is blinking green (PMB booted correctly):
When the system is powered on, the 7 activity and status LEDs (LED #1–LED #7) are
switched off and LED #0 is blinking. See PMB Leds and Code Wheels, on page 4-42.

• Check PMB code wheel settings. See PMB Leds and Code Wheels, on page 4-42.

• Check that the Ethernet cable linking the server to the PAP unit is correctly inserted and
that the Ethernet link LED is green.

• Check the PAP – PMB link by pinging the PAP and the PMB:

PAP Address PMB 0 Address PMB 1 Address

10.10.240.240 10.10.0.1 10.10.0.2

• Reset the PMB by pressing the RESET button. PMB firmware will be rebooted. See PMB
Leds and Code Wheels, on page 4-42.
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PMB LEDs and Code Wheels
Up to 16 Central Subsystems can be linked, via Platform Management Boards (PMBs) to a
single PAP unit, to provide a single point of administration and maintenance.

Each PMB is equipped with two code wheels used to identify each Central Subsystem and
each CSS module in your configuration. These code wheels are set prior to shipping
(factory default setting), according to configuration.

LED7

LED4
LED3

LED0

LED4 to LED7: orange

LED0 to LED3: green

System activity and status LEDs

PMB status LED

Orange LED
OFF = OK

ON = PMB hot–plugged

Green LED: Ethernet link status (ON = OK)
Yellow LED: Link activity (ON = transmit)

Cabinet

Module
Code wheels

Load push–button

Reset PMB

Reserved

Serial port (DB9)
(reserved)

Ethernet connector
PAP link

For guidance, PMB code wheel settings are indicated in the following table:

CSS
CSS

PMB Code Wheel
PAM

CSS HW Identifier

CSS Module
PMB Code WheelCSS

PMB Code Wheel CSS HW Identifier
CSS Module 0 CSS Module 1

1st 0 00 0 1

2nd 1 01 0 1

3rd 2 02 0 1

4th 3 03 0 1

5th 4 04 0 1

6th 5 05 0 1

7th 6 06 0 1

8th 7 07 0 1

9th 8 08 0 1

10th 9 09 0 1

11th A 10 0 1

12th B 11 0 1

13th C 12 0 1

14th D 13 0 1

15th E 14 0 1

16th F 15 0 1

Figure 97. PMB LED location
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Chapter 5. Tips and Features for Administrators

This chapter explains how, as Customer Administrator, you can configure the server to suit

your working environment. It includes the following sections:

• Section I – Setting up Server Users and Configuring Data Disks, on page 5-3

• Section II – Using EFI Utilities, on page 5-11

• Section III – Customizing PAM Software, on page 5-20

• Section IV – Configuring Domains, see page 5-32

• Section V – Creating Event Subscriptions and User Histories, on page 5-84

 Notes:
Customer Administrators and Customer Operators are respectively advised to consult the
Administrator’s Memorandum, on page xxi or the  Operator’s Memorandum, on page xxvi
for a detailed summary of the everyday tasks they will perform.
Before proceeding to configure the server, please refer to PAM Writing Rules, on page xxiii.

For further information about user accounts and passwords, see Setting up PAP Unit Users,
on page 5-21.

  Important: 
Certain domain configuration and management tools are reserved for use with
partitioned servers and extended systems.  Please contact your Bull Sales
Representative for sales information.



5-2 User’s Guide



5-3Tips and Features for Administrators

Section I – Setting up Server Users and Configuring Data
Disks

This section explains how to:

• Set up Server Users, on page 5-4

• Configure SR–0812 SCSI RAID and SR–1422 SCSI RAID Data Disks, on page 5-5

• Configure FDA 1x00 FC and FDA 2x00 FC Data Disks, on page 5-8
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Setting up Server Users
As Customer Administrator, you must set up user accounts and passwords to control access
to the server.

The operating system pre–installed on the server provides standard security features for
controlling access to applications and  resources.

For further details, refer to the Microsoft Windows / Linux documentation, as applicable.

 Note:
You are advised to maintain a detailed record of authorized users.

Microsoft Windows

Default user access control is not pre–configured on systems running under Microsoft
Windows.
You are advised to set up the Administrator account before proceeding to set up users and
groups via the standard Microsoft Windows administration tools.

Linux

Two default users are pre–configured on systems running under Linux:

User Name Password

Administrator root root

User linux root

You are advised to change the default Administrator name and password before proceeding
to set up users and groups via the standard Linux administration tools.
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Configuring SCSI Data Disks
Optionally, for optimum storage, security and performance, the server may be delivered with
pre–configured disk racks.

The addition of data disks involves the creation of a new array and new array partitions
(LUNs) via the embedded Disk Array Administrator software.

 Note:
Delivered storage sub–systems vary according to Customer requirements.

SJ–0812 SCSI JBOD Disk Rack
Optionally, the server may be is delivered with one or two SJ–0812 SCSI JBOD disk rack(s)
each containing two RAID #1 system disks per domain and one pool spare disk, and
offering two free slots for data disks.

OS Disks (RAID #1) Spare Disks (Pool)

SJ–0812 SCSI JBOD disk rack 1
Cell 0 (CSS Module_0, IOC_0)

Ch 2 Id 01
Ch 2 Id 02

Ch 2 Id 04

SJ–0812 SCSI JBOD disk rack 1
Cell 1 (CSS Module_0, IOC_1)

Ch 1 Id 01
Ch 1 Id 02

Ch 1 Id 04

SJ–0812 SCSI JBOD disk rack 2
Cell 2 (CSS Module_1, IOC_0)

Ch 2 Id 01
Ch 2 Id 02

Ch 2 Id 04

SJ–0812 SCSI JBOD disk rack 2
Cell 3 (CSS Module_1, IOC_1)

Ch 1 Id 01
Ch 1 Id 02

Ch 1 Id 04

Figure 98. SJ–0812 SCSI JBOD disk configuration
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SR–0812 SCSI RAID Disk Rack
Optionally, the server may be delivered with two SR–0812 SCSI RAID disk racks (one per
domain). Each disk rack contains two RAID #1 system disks and one pool spare disk, and
offering five free slots for data disks.

OS Disks (RAID #1) Spare Disk

SR–0812 SCSI RAID disk rack 1
Cell 0 (CSS Module_0, IOC_0)

Ch 2 Id 01
Ch 2 Id 02

Ch 1 Id 04

SR–0812 SCSI RAID disk rack 2
Cell 1 (CSS Module_0, IOC_1)

Ch 2 Id 01
Ch 2 Id 02

Ch 1 Id 04

SR–0812 SCSI RAID disk rack 1
Cell 2 (CSS Module_1, IOC_0)

Ch 2 Id 01
Ch 2 Id 02

Ch 1 Id 04

SR–0812 SCSI RAID disk rack 2
Cell 3 (CSS Module _1, IOC_1)

Ch 2 Id 01
Ch 2 Id 02

Ch 1 Id 04

Figure 99. SR–0812 SCSI RAID disk configuration

Creating a New Disk Array
1. From the Microsoft Windows desktop on the PAP unit, launch a HyperTerminal session

with the following parameters:

Parameter Value

Name Disk Rack

Connect using COM1 or COM2

Bits per second 115200

Data bits 8

Parity None

Stop bits 1

Flow control None

Emulation ANSI

Table 28. HyperTerminal parameters

2. Press CTRL–R to refresh the screen and display the initial Disk Array Administrator
screen.

3. Press Enter to display the System Menu.

4. Select Add an Array.

5. Enter the name of the Array: e.g. Data.

6. Enter the RAID level, number of disks and disk ID.

7. When prompted to Create one partition now for entire Array?, select NO to create a
Multiple–Partition Array.



5-7Tips and Features for Administrators

8. Select Array parameters.

9. Select the required number of free drives:

Free Slots
(population order)

SJ–0812 SCSI JBOD disk rack N/A

SR–0812 SCSI RAID disk rack Ch 2 Id 03
Ch 2 Id 04
Ch 1 Id 01
Ch 1 Id 02
Ch 1 Id 03

Table 29. SCSI data disk population order

10.Select Array Init options: Offline Initialization.

11.When prompted to confirm, enter YES.

Creating a New Array Partition
1. Select Array Menu.

2. Select Data Array and press Enter.

3. Select Add a Partition.

4. Enter the size of the disk partition, e.g. 10,000 MB.

5. Enter the name of the disk partition: e.g. USER1.

6. Enter a LUN number or select the suggested LUN number (from 0 to 63).

7. Repeat this procedure for each new disk partition.

The new Array and associated disk partitions are now configured for use.

 Note:
For further details, refer to the appropriate Disk Subsystem documentation.
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Configuring FC Data Disks

FDA 1x00 FC Disk Rack

Optionally, the server may be delivered with one or two FDA 1x00 FC disk rack(s) each
containing two RAID #1 system disks per domain and one pool spare disk, and offering ten
free slots for data disks. Slots are numbered from 0 to14.

FDA 2x00 FC Disk Rack

Optionally, the server may be delivered with one FDA 2x00 FC disk rack containing two
RAID #1 system disks per domain and one pool spare disk, and offering ten free slots for
data disks. Slots are numbered from 0 to14.

OS Disks (RAID #1) Spare Disk

NovaScale 5xx5 Server

FDA 1x00 FC  disk rack
PD0

PD1
PD14

FDA 2x00 FC  disk rack
PD0

PD1
PD14

NovaScale 6085 Server

FDA 1x00 FC  disk rack 1 controller #0
Cell_0, IOB_0

FDA 1x00 FC  disk rack 1 controller #1
Cell_1, IOB_1

PD0
PD1

PD2
PD3

PD14

NovaScale 6165 Server

FDA 1x00 FC  disk rack 1 controller #0
Cell_0, CSS Module_0, IOB_0

FDA 1x00 FC disk rack 1 controller #1
Cell_1, CSS Module_0, IOB_1

FDA 1x00 FC  disk rack 2 controller #0
Cell_2, CSS Module_1, IOB_0

FDA 1x00 FC disk rack 2 controller #1
Cell_3, CSS Module_1, IOB_1

PD0
PD1

PD2
PD3

PD0
PD1

PD2
PD3

PD14

PD14

FDA 2x00 FC  disk rack  1 controller #0
Cell_0, CSS Module_0, IOB_0
Cell_1, CSS Module_0, IOB_1

FDA 2x00 FC disk rack 1 controller #1
Cell_2, CSS Module_1, IOB_0
Cell_3, CSS Module_1, IOB_1

PD0
PD1

PD2
PD3

PD14

Table 30. FDA 1x00 FC / FDA 2x00 FC disk configuration
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Creating a New Logical Data Disk

 Note:
For optimum storage, performance, and reliability, you are advised to use RAID level 5 for
data disk configuration.

1. From the Microsoft Windows desktop on the PAP unit, launch iSM Client.

Figure 100. iSM Client interface

2. Select the disk subsystem and click the Configuration icon. The Select Operation
Mode page opens.

3. Click Setting. The Configuration [Setting Mode] page opens.

4. Click LD Bind/Unbind. The LD Individual Bind/Unbind page opens.

5. Select the disks to be bound in the RANK.

 Note:
At least three disks must be selected to create a RAID#5 RANK.

6. Click RANK Bind. The RANK Bind page opens.

7. Specify RAID Type and Rebuild Time and click OK. A confirmation dialog box opens.

8. Click OK to return to the LD Individual Bind/Unbind page.

9. Wait for the rank bind operation to finish.

10.Select the LD tab. Click Unused → LD Bind. The LD Individual Bind page opens.

11.Check the Specify both the number of LDs and LD Capacity radio button and enter
the required values.

NovaScale 5xx5 Server

– Controller 1

NovaScale 6xx5 Server

– FDA 1x00 FC Disk Racks

. Disk Rack 1, Controller 0 for Cell 0 (CSS Module_0, IOB_0)

. Disk Rack 1, Controller 1 for Cell 1 (CSS Module_0, IOB_1)

. Disk Rack 2, Controller 0 for Cell 2 (CSS Module_1, IOB_0)

. Disk Rack 3, Controller 1 for Cell 3 (CSS Module_1, IOB_1)

– FDA 2x00 FC Disk Racks

. Disk Rack 1, Controller 0 for Cell 0 and Cell 1 (CSS Module_0, IOB_0, IOB_1)
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. Disk Rack 1, Controller 1 for Cell 2 and Cell 3 (CSS Module_1, IOB_0, IOB_1)

12.Click OK. A confirmation dialog box opens.

13.Click Yes → OK to return to the LD Individual Bind/Unbind page and click Close. The
new logical disk appears in the iSM Server tree.

 Note:
For further details, refer to the appropriate Disk Subystem documentation.
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Section II – Using EFI Utilities

This section explains how to:

• Use the EFI Boot Manager, on page 5-12

• Use the EFI Shell, on page 5-14

• Use the EFI to Set up and Configure a Network, on page 5-18

• Use the EFI to Load FTP Server / Client, on page 5-19
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Using the EFI Boot Manager
The EFI (Extensible Firmware Interface) Boot Manager allows you to control the server’s
booting environment. From the Boot Manager, you can choose to invoke the Extensible
Firmware Interface (EFI) Shell or to go to the Boot Option Maintenance Menu.

To enter the EFI Boot Manager:

1. From the PAM Tree, click Domain Manager → Power ON to power up the required
domain.

2. From the keyboard, press the Control key twice to display the KVM Switch Command
Menu.

3. Select the required system channel port with the ↑↓ keys, according to configuration.
See KVM port configuration, in the User’s Guide.

4. Press Enter to activate the required system channel and exit the Command Mode.

 Note:
The system automatically boots on the first option in the list without user intervention after a
timeout. To modify the timeout, use Set Auto Boot Timeout in the Boot Option Maintenance
Menu.

5. From the Boot Manager Menu, select the EFI Shell option with the ↑↓ keys and press
Enter.

EFI Boot Manager Options

EFI Shell

A simple, interactive environment that allows EFI device drivers to be loaded, EFI
applications to be launched, and operating systems to be booted. The EFI shell also
provides a set of basic commands used to manage files and the system environment
variables. For more information on the EFI Shell, refer to The Extensible Firmware Interface
(EFI) Shell on page 5-14.

Boot Options

Files that you include as boot options. You add and delete boot options by using the Boot
Maintenance Menu. Each boot option specifies an EFI executable with possible options. For
information on the Boot Maintenance Menu options, refer to  Table 31.

Boot Option Maintenance Menu

The EFI Boot Maintenance Manager allows the user to add boot options, delete boot
options, launch an EFI application, and set the auto boot time out value.

If there are no boot options in the system (and no integrated shell), the Boot Maintenance
Menu is presented.  If boot options are available, then the set of available boot options is
displayed, and the user can select one or choose to go to the Boot Maintenance Menu.

If the time out period is not zero, then the system will auto boot the first boot selection after
the time out has expired. If the time out period is zero, then the EFI Boot Manager will wait
for the user to select an option.  Table 31 describes each menu item in the Boot
Maintenance Menu.

 Note:
You can use the → ← ↑↓ keys to scroll through the Boot Maintenance Menu.
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Boot Option Description

Boot from a File This option searches all the EFI System Partitions in the system.

For each partition it looks for an EFI directory. If the EFI directory is
found, it looks in each of the subdirectories below EFI.

In each of those subdirectories, it looks for the first file that is an execut-
able EFI Application.

Each of the EFI Applications that meet this criteria are automatically
added as a possible boot option. In addition, legacy boot options for A:
and C: are also added if those devices are present.

This option allows the user to launch an application without adding it as
a boot option.

The EFI Boot Manager will search the root directories and the
\EFI\TOOLS directories of all of the EFI System Partitions present in the
system for the specified EFI Application.

Add a Boot Option Allows the user to specify the name of the EFI Application to add as a
boot option.

The EFI Boot Manager searches the same partitions and directories as
described in Boot from a File, until it finds an EFI Application with the
specified name.

This menu also allows the user to provide either ASCII or UNICODE ar-
guments to the option that will be launched.

Delete Boot 
Options

Allows you to delete a specific boot option or all boot options. Highlight
the option you want to delete and enter <d>. Enter <y> to  confirm.

Change Boot Order Allows you to control the relative order in which the EFI Boot Manager
attempts boot options. To change the boot order, highlight the boot op-
tion and enter <u> to move the item up one order, <d> to move the item
down one order. For help on the control key sequences you need for
this option, refer to the help menu.

Manage Boot Next
Setting

Allows you to select a boot option to use one time (the next boot opera-
tion).

Set Auto Boot 
Timeout

Allows you to define the value in seconds that pass before the system
automatically boots without user intervention. Setting this value to zero
disables the timeout feature.

Cold Reset Performs a platform–specific cold reset of the system. A cold reset
traditionally means a full platform reset.

Exit Returns control to the EFI Boot Manager main menu. Selecting this op-
tion will display the active boot devices, including a possible integrated
shell (if the implementation is so constructed).

Table 31. Boot Option Maintenance Menu
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Using the EFI Shell
The EFI (Extensible Firmware Interface) Shell is a simple, interactive user interface that
allows EFI device drivers to be loaded, EFI applications to be launched, and operating
systems to be booted. In addition, the Shell provides a set of basic commands used to
manage files and the system environment variables.

The EFI Shell supports command line interface and batch scripting.

Entering the EFI Shell
To enter the EFI Shell:

1. From the PAM Tree, click Domain Manager → Power ON to power up the required
domain.

2. From the keyboard, press the Control key twice to display the KVM Switch Command
Menu.

3. Select the required system channel port with the ↑↓ keys, according to configuration.
See KVM port configuration, in the User’s Guide.

4. Press Enter to activate the required system channel and exit the Command Mode. After
a few seconds, the Boot Manager menu is displayed.

5. From the Boot Manager Menu, select the EFI Shell option with the ↑↓ keys and press
Enter.

When the EFI Shell is invoked, it first looks for commands in the file startup.nsh on the
execution path defined by the environment. There is no requirement for a startup file to
exist. Once the startup file commands are completed, the Shell looks for commands from
console input device.

 Note:
The system automatically boots on the first option in the list without user intervention after a
timeout. To modify timeout, use Set Auto Boot Timeout in the Boot Option Maintenance
Menu.

EFI Shell Command Syntax
The EFI Shell implements a programming language that provides control over the execution
of individual commands. When the Shell scans its input, it always treats certain characters
specially: (#, >, %, *, ?, [, ^, space, and newline).

When a command contains a defined alias, the Shell replaces the alias with its definition
(see alias command in this chapter). If the argument is prefixed with the ^ character,
however, the argument is treated as a literal argument and alias processing is not
performed.

 Note:
In interactive execution, the Shell performs variable substitution, then expands wildcards
before the command is executed.
In batch script execution, the Shell performs argument substitution, then variable
substitution, then expands wildcards before the command is executed.

Variable Substitution
Environment variables can be set and viewed through the use of the set command (see
set command in this chapter). To access the value of an environment variable as an
argument to a Shell command, delimit the name of the variable with the % character before
and after the variable name; for example, %myvariable%.
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The Shell maintains a special variable, named lasterror. The variable contains the return
code of the most recently executed Shell command.

Wildcard Expansion
The *, ? and [ characters can be used as wildcard characters in filename arguments to
Shell commands.

If an argument contains one or more of these characters, the Shell processes the argument
for file meta–arguments and expands the argument list to include all filenames matching
the pattern.

These characters are part of patterns which represent file and directory names.

Character Sequence Meaning

”*” Matches zero or more characters in a file name

”?” Matches exactly one character of a file name

”[chars]” Defines a set of characters; the pattern matches any single character in

the set. Characters in the set are not separated.  Ranges of characters

can be specified by specifying the first character in a range, then the –

character, then the last character in the range.  Example: [a–zA–Z]

Table 32. Wildcard character expansion

Output Redirection
Output of EFI Shell commands can be redirected to files, according to the following syntax:

Command Output Redirection

> unicode_output_file_pathname standard output to a unicode file

>a ascii_output_file_pathname standard output to an ascii file

1> unicode_output_file_pathname standard output to a unicode file

1>a ascii_output_file_pathname standard output to an ascii file

2> unicode_output_file_pathname standard error to a unicode file

2>a ascii_output_file_pathname standard error to an ascii file

>> unicode_output_file_pathname standard output appended to a unicode file

>>a ascii_output_file_pathname standard output appended to an ascii file

1>> unicode_output_file_pathname standard output appended to a unicode file

1>>a ascii_output_file_pathname standard output appended to an ascii file

Table 33. Output redirection syntax

The Shell will redirect standard output to a single file and standard error to a single file.
Redirecting both standard output and standard error to the same file is allowed. Redirecting
Standard output to more than one file on the same command is not supported. Similarly,
redirecting to multiple files is not supported for standard error.

Quoting
Quotation marks in the EFI Shell are used for argument grouping. A quoted string is treated
as a single argument to a command, and any whitespace characters included in the quoted
string are just part of that single argument.

Quoting an environment variable does not have any effect on the de–referencing of that
variable. Double quotation marks “” are used to denote strings. Single quotation marks are
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not treated specially by the Shell in any way. Empty strings are treated as valid command
line arguments.

Executing Batch Scripts
The EFI Shell has the capability of executing commands from a file (batch script). EFI Shell
batch script files are named using the .nsh extension. Batch script files can be either
UNICODE or ASCII format files. EFI Shell script files are invoked by entering the filename at
the command prompt, with or without the filename extension.

Up to nine (9) positional arguments are supported for batch scripts. Positional argument
substitution is performed before the execution of each line in the script file. Positional
arguments are denoted by %n, where n is a digit between 0 and 9. By convention, %0 is the
name of the script file currently being executed.  In batch scripts, argument substitution is
performed first, then variable substitution. Thus, for a variable containing %2, the variable
will be replaced with the literal string %2, not the second argument on the command line. If
no real argument is found to substitute for a positional argument, then the positional
argument is ignored. Script file execution can be nested; that is, script files may be executed
from within other script files. Recursion is allowed.

Output redirection is fully supported. Output redirection on a command in a script file causes
the output for that command to be redirected. Output redirection on the invocation of a batch
script causes the output for all commands executed from that batch script to be redirected to
the file, with the output of each command appended to the end of the file.

By default, both the input and output for all commands executed from a batch script are
echoed to the console. Display of commands read from a batch file can be suppressed via
the echo –off command (see echo). If output for a command is redirected to a file, then
that output is not displayed on the console. Note that commands executed from a batch
script are not saved by the Shell for DOSkey history (up–arrow command recall).

Error Handling in Batch Scripts
By default, if an error is encountered during the execution of a command in a batch script,
the script will continue to execute.

The lasterror Shell variable allows batch scripts to test the results of the most recently
executed command using the if command. This variable is not an environment variable,
but is a special variable maintained by the Shell for the lifetime of that instance of the Shell.

Comments in Script Files
Comments can be embedded in batch scripts. The # character on a line is used to denote
that all characters on the same line and to the right of the # are to be ignored by the Shell.
Comments are not echoed to the console.

EFI Shell Commands
Most Shell commands can be invoked from the EFI Shell prompt. However there are
several commands that are only available for use from within batch script files.

 Note:
The “Batch–only” column indicates if the command is only available from within script files.
The following sections provide more details on each of the individual commands.
Command help command_name displays the details of the command_name .
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Command Batch

only

Description

alias No Displays, creates, or deletes aliases in the EFI Shell

attrib No Displays or changes the attributes of files or directories

bcfg No Displays/modifies the driver/boot configuration

break No Executes a break point

cd No Displays or changes the current directory

cls No Clears the standard output with an optional background color

comp No Compares the contents of two files

connect No Binds an EFI driver to a device and starts the driver

cp No Copies one or more files/directories to another location

date No Displays the current date or sets the date in the system

dblk No Displays the contents of blocks from a block device

devices No Displays the list of devices being managed by EFI drivers

devtree No Displays the tree of devices that follow the EFI Driver Model

dh No Displays the handles in the EFI environment

disconnect No Disconnects one or more drivers from a device

dmem No Displays the contents of memory

dmpstore No Displays all NVRAM variables

drivers No Displays the list of drivers that follow the EFI Driver Model

drvcfg No Invokes the Driver Configuration Protocol

drvdiag No Invokes the Driver Diagnostics Protocol

echo No Displays messages or turns command echoing on or off

edit No Edits an ASCII or UNICODE file in full screen.

err No Displays or changes the error level

exit No Exits the EFI Shell

for/endfor Yes Executes commands for each item in a set of items

goto Yes Makes batch file execution jump to another location

guid No Displays all the GUIDs in the EFI environment

help No Displays commands list or verbose help of a command

hexedit No Edits with hex mode in full screen

if/endif Yes Executes commands in specified conditions

load No Loads EFI drivers

loadbmp No Displays a Bitmap file onto the screen

ls No Displays a list of files and subdirectories in a directory

map No Displays or defines mappings

memmap No Displays the memory map

mkdir No Creates one or more directories

mm No Displays or modifies MEM/IO/PCI

mode No Displays or changes the mode of the console output device

mount No Mounts a file system on a block device

mv No Moves one or more files/directories to destination

openInfo No Displays the protocols on a handle and the agents

pause No Prints a message and suspends for keyboard input

pci No Displays PCI devices or PCI function configuration space

reconnect No Reconnects one or more drivers from a device

reset No Resets the system

rm No Deletes one or more files or directories

set No Displays, creates, changes or deletes EFI environment variables

stall No Stalls the processor for some microseconds

time No Displays the current time or sets the time of the system

type No Displays the contents of a file

unload No Unloads a protocol image

ver No Displays the version information

vol No Displays volume information of the file system

Table 34. List of EFI Shell Commands
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EFI Network Setup and Configuration
The EFI (Extensible Firmware Interface) Utilities delivered with the system provide a
complete set of TCP/IPv4 network stack and configuration tools. Ethernet adapters utilizing
6 bit UNDI option ROMs are supported.

  Important: 
To access this feature, please connect the Enterprise network to the embedded
Ethernet board on the IOR of the domain master IO board. Intel PRO 1000T and 1000F
adapters are not supported.

 Note:
These utilities are installed in the EFI partition of the system disk in the EFI\Tools directory.
The list and respective manual pages for each utility can be found on the Bull NovaScale
Server Resource CD–Rom.

Network stack configuration commands must be executed after booting to EFI Shell. To
simplify network setup, these commands should be grouped, via an EFI batch script, to form
a single one–line command.

Manual EFI Network Configuration
1. Load the TCP/IP protocol via the EFI load command.

 Note:
As the load command does not use the search path to locate protocols, specify the path
and the .efi extension.

fso:\efi\tools\tcpipv4.efi

2. Configure the network interfaces with the ifconfig command:

The simple form of the command is:

ifconfig <interface> inet <ip address> up

where <ip address> is the address assigned to the system. If the system is connected to
a network that uses subnetting, a subnet mask would also need to be specified as
follows:

ifconfig sni0 inet <ip address> netmask <netmask> up

where <netmask> is the network mask assigned to the network.

 Note:
The TCP/IP stack contains a “lo0” loopback interface which can be optionally be configured
with the “sni0” Ethernet interface if a compatible UNDI Ethernet adapter is installed.
Configuration is performed with the ifconfig command.

3. If multiple network or subnetwork networking is required, set a gateway address for the
appropriate gateway(s) attached to the network, via the route command as follows:

route add <destination> <gateway ip address>

where <destination> specifies the target network or host and <gateway ip address>
specifies the network gateway address responsible for routing data to the destination.

If default is used for <destination>, a default route will be set.
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Example Network Configuration Batch File

An example network configuration batch file named NetConf.nsh is installed in the EFI
directory of the EFI Service Partition.

This file loads the TCP/IP, configures the Ethernet interface to the IP address given as first
argument to this file, configures the optional second argument as the gateway, and loads
the FTP Server (daemon).

echo –off

if %1empty == empty then

 echo usage netconf {local ip–addr} [router ip addr]

 goto End 

endif

load fs0:\efi\tools\tcpipv4.efi

ifconfig sni0 %1 netmask 255.255.255.0

if not %2empty == empty then

  route add default %2

endif

load fs0:\EFI\Tools\ftpd.efi

:End

 Note:
The IP addresses and netmask indicated in this file and in the following example are only
examples and must be modified to reflect site network configuration:

fs0:\> Netconf 129.182.189.3 129.182.189.1

129.182.189.3 is the <ip address>

129.182.189.1 is the <gateway ip address>

File Transfer Protocol (FTP)
An FTP Client and an FTP Server are provided with the EFI Utilities.

1. Configure the network. See Manual Network Configuration.

2. Load the FTP Server via the EFI load command.

3. Load the FTP Client via the EFI ftp command. This Client supports most ftp directives
(open, get, put, ...). Use the help directive if you need help.

 Note:
As the load command does not use the search path to locate protocols, specify the path if it
is not in the current working directory and the .efi extension.

load fs0:\efi\tools\ftpd.efi

The FTP Server is now available for use and accepts anonymous connections (one at a
time).

  Important: 
Once the EFI drivers for the TCP/IP, the FTP Server or FTP Client are loaded, you
cannot load an Operating System.
To load an Operating System, reset the domain and return to Boot Manager.
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Section III – Customizing PAM Software

This section explains how to:

• Set up PAP Unit Users, on page 5-21

• Modify Customer Information, on page 5-23

• Configure Autocalls, on page 5-24

• Customize PAM Settings, on page 5-26

• Deploy a New PAM Release, on page 5-27

• Activate a PAM Version, on page 5-28

• Back up and Restore PAM Configuration Files, on page 5-30
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Setting up PAP Unit Users
As Customer Administrator, you must set up user accounts and passwords to control access
to the PAP unit.

The Microsoft Windows operating system pre–installed on the PAP unit provides standard
security features for controlling access to applications and resources. PAM software security
is based on Windows)  user management and you are advised to give Windows)

administrator rights to at least one member of the PAP Customer Administrator user group.
For further details about user management, refer to the Microsoft Windows documentation
on the Bull NovaScale Server System Resource CD.

 Note:
You are advised to change the temporary Administrator password (administrator) used for
setup purposes and to maintain a detailed record of authorized users.

Predefined PAP User Groups
For optimum security and flexibility, the Microsoft Windows software environment is
delivered with two predefined Customer user groups:

Pap_Customer_Administrators Group (CA)

This group is designed for customer representatives responsible for the overall
management, configuration, and operation of the system. Members of the Customer
Administrator group are allowed to configure and administrate the server and have full
access to the PAM Domain Manager, Hardware Monitor, History Manager and
Configuration Tasks menus, as shown in Table 35.

Pap_Customer_Operators (CO)

This group is designed for customer representatives responsible for the daily operation of
the system. Members of the Customer Operator group are allowed to operate the server
and have full access to the Domain Manager menu and partial access to the History
Manager menu, as shown in Table 35.

 Notes:

• Group membership also conditions which Event Messages a user will receive via the
PAM Web interface. See Setting up Event Subscriptions, on page 5-86.

• The predefined Customer user groups have been designed to suit the needs of most
Administrator and Operators. Contact your Customer Service Engineer if you require a
customized user group.

 Warning: 
The two predefined Support user groups:

– Pap_Support_Administrators

– Pap_Support_Operators

are reserved EXCLUSIVELY for authorized Customer Service Engineers in charge
of monitoring, servicing, and upgrading the system.
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PAM Tools Associated Actions CA CO

Domain Manager

Load/delete domains

Power on/off/reset domains

View/modify domain settings

View domain status

View domain resources

View BIOS info

View BIOS version

View loaded BIOS image

View power logs

View request logs

Request a system dump

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

Hardware Monitor

View hardware functional/presence status

View detailed hardware status information

Use the hardware Search engine

Exclude/include hardware components

View current PAM Web site user information

View PAM version information

X

X

X

X

X

X

History Manager

View system history files and messages

Manually archive system history files

View/delete system history archives

View user history files

Manually archive user history files

View/delete user history archives

X

X

X

X

X

X

X

X

X

Configuration Tasks

View/modify customer information

Modify the system history automatic archiving policy

Create/modify/delete domain schemes and identities

Modify domain schemes and identities

Create/delete user histories

Modify user history automatic archiving policy

Customize the event messaging system

View/ modify PAM parameters

Display/modify autocall parameters

X

X

X

X

X

X

X

X

X

Status Pane

View/acknowledge WEB event messages

Check system functional status

Check CSS availability

X

X

X

X

X

X

Table 35. User access to PAM features

CA = Customer Administrator
CO = Customer Operator
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Modifying Customer Information
Customer information is configured during the initial installation procedure, via the PAM
configuration setup Wizard. This information is used by PAM software for the PAM Tree
display and to complete Intervention Reports. 
As Customer Administrator, you  may modify this information.

To modify Customer information:

1. From the PAM Tree, click Configuration Tasks → Customer Information. 
The Customer Information configuration page opens.

2. Enter the new information and click Save to confirm changes.

Figure 101. Customer Information configuration page

 Note:
The value entered in the Site name field will be used for the PAM tree root node.
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Configuring Autocalls
The Autocall feature is part of the BULL Remote Maintenance contract. It is used to
automatically route system events to the Remote Maintenance Center. Full details are given
in the BULL Remote Maintenance Guide.

If your maintenance contract includes the Autocall feature, configure Autocall parameters as
follows:

3. Click Configuration Tasks → Autocalls. The Autocalls configuration page opens.

Figure 102. Autocalls Channel Settings control pane

4. Select the Enable Autocalls checkbox.

5. Select the Send Heartbeat checkbox and enter a value “in days” for the autocall channel
control in the Period box. Recommended value = 1.

6. Select the autocall dispatch mode :

– Local dispatch mode (default mode) sends autocalls to the local target directory
indicated under Local Settings,

– FTP dispatch mode sends autocalls to the server indicated under FTP Settings.

7. If Local dispatch mode (default mode) is selected, complete the Local Settings field
with the following information:

Field Explanation Value

Local target directory Default GTS directory used to store autocalls. c:\gts\session
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8. If FTP dispatch mode is selected, complete the FTP Settings fields with the following
information:

Field Explanation Value

Server name Remote Maintenance Center server IP address 127.0.0.1

Server port Default server port 21

Target directory Default server directory /autocall

Login Declared authorized user name X

Password Declared authorized user password X

9. If a modem connection is to be used:

a. From the PAP Unit Microsoft Windows desktop, configure the dial–up connection
(Control Panel → Phone and Modem Options).

b. From the PAM Autocalls Control Pane, select the Use modem connection
checkbox.

c. Use the Connection name drop–down menu to select the required modem
connection.

d. Complete the User name and Password fields with the declared authorized user
name and user password.
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Setting Thermal Units
By default, PAM software displays thermal measurements in degrees Celsius. As Customer
Administrator, you may change the default setting to degrees Fahrenheit.

To change PAM thermal units:

1. Click Configuration Tasks → PAM. The PAM Configuration control pane opens.

2. Click the Celsius or Fahrenheit radio button, as required.

3. Click Save. A green icon appears in the top left corner of the control pane to confirm the
change.

Figure 103. PAM configuration control pane
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Deploying a New PAM Release
As Customer Administrator, you can deploy a new PAM release by running the new PAM
Installation package x.y.z. msi (x.y.z being the PAM version e.g.  2.1.9 ) file.

To install a new PAM Release:

1. From the local PAP unit console, power down all server domains and close the current
PAM session.

2. From the default PAM Installation directory, double click the .msi file to launch the PAM
Installation InstallShield Wizard.

3. Select Complete to install all program features and to accept the default path for the
installation folder:

<WinDrive>:\Program Files\BULL\PAM\installation\<Release Version>
(e.g. d:\Program Files\BULL\PAM\installation\ 2.1.9 ).

or, select Custom to select program features and to define a path for the installation
folder.

Figure 104. PAM Installation InstallShield Wizard

 Note:
This path is the repository for activation files. NEVER delete this folder after activation as it
is required to repair and re–activate the release.

4. Click Install to begin setup.

5. Select the Launch PAM Activation utility checkbox and click Finish. The PAM
Activation utility is automatically launched.

The PAM Activation icon is installed on the PAP unit desktop and the Platform
Administration and Maintenance program group, giving access to the PAM Activation
and PAP Configuration executable files, is installed in the Program Files directory.
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Activating a PAM Version
The PAM InstallShield Wizard automatically creates a shortcut to the PAM Activation utility
on the PAP unit desktop that can be used at any time to activate an installed PAM Version.

 Note:
A previous PAM Version can be re–activated at any time, in the event of a problem with the
current release.

To activate / re–activate a PAM Version:

1. From the local PAP unit console, power down all server domains and close the current
PAM session.

2. From the PAM Activation utility on the Microsoft Windows desktop, select the required
PAM Version and click Activate to launch the PAM Activation InstallShield Wizard.

3. Select Complete to accept the default paths for the PAM Release and PAM Site Data
folders:

The default PAM Release directory for all the files delivered as part of PAM software is:

<WinDrive>:\Program Files\BULL\PAM\<Release Version>
(e.g. d:\Program Files\BULLl\PAM\ 2.1.9 ).

The default PAM Site Data directory for all the files produced by PAM software (history
files, configuration files) concerning Customer site definition and activity is:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\<DataCompatibilityRelease>
(e.g. d:\Program Files\BULL\PAM\PAMSiteData\1).

Figure 105. PAM Activation InstallShield Wizard

  Important: 
PAM releases use the same data directory to ensure configuration consistency.
Before activating / re–activating a PAM Version, ensure that the <Data Compatibility
Release> level of deployed releases is compatible.
If it  is NOT compatible,  PAM configuration options (e.g. Event subscription options, 
... ) may be lost.
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4. Click Install to begin activation.

5. Select the Launch PAP Configuration utility checkbox if you want to configure or
reconfigure PAP unit settings. Otherwise, click OK to complete activation.

6. From the local PAP unit console, right click the Microsoft Internet Explorer icon on the
desktop and click Properties → General → Delete Files to delete all the files in the
Temporary Internet Folder.

7. Launch a new PAM session.

  Important: 
Notify all authorized users, connecting to PAM from a remote console, that a new
PAM Version has been activated and request them to:

a. Close their current PAM session.

b. Delete all the files in their Temporary Internet Folder.

c. Launch a new PAM session.
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Backing Up and Restoring PAM Configuration Files
As Customer Administrator, you are advised to regularly save PAM configuration data to a
removable media or to a network directory so that it can be rapidly restored in the event of
PAP unit failure.

PAM software can be deployed on any standard PC running the appropriate version of
Microsoft Windows and you can restore your configuration data to rebuild your working
environment.

PAM configuration data is automatically saved to the default PAM Site Data directory on the
PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\<DataCompatibilityRelease>

To ensure carefree, reliable and regular configuration data backup, the Bull NovaScale
Server Resource CD contains two scripts, PamBackupData.js and PamRestoreData.js,
that can be scheduled to run via the Microsoft Windows Task Scheduler.

 Note:
The PamBackupData.js and PamRestoreData.js scripts are also stored in the PAM Site
Data directory on the PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\ReleaseData\Utilities

 Warning: 
The same PAM software release must be deployed on the PAP unit and on the backup
PC to allow data restoration.
PAM releases use the same data directory to ensure configuration consistency.
Before activating / re–activating a PAM Version, ensure that the
<DataCompatibilityRelease> level of deployed releases is compatible.

Backing Up PAM Configuration Files
To create a Microsoft Windows automatic backup task:

1. Select or create the local or network directory to be used for saving configuration data,
e.g. <MyPamBackupDirectory>.

2. Create a local directory for the PamBackupData.js and PamRestoreData.js script files,
e.g. <MyPamBackupTools>.

3. Copy the PamBackupData.js and PamRestoreData.js script files into the
<MyPamBackupTools> directory.

4. Create a Text File and enter the following command line:

Cscript PamBackupData.js <MyPamBackupDirectory>

5. Save the Text File as a batch file with a .BAT extension,
e.g. <MyPamBackupCommand>.bat.

6. Click Control Panel → Scheduled Tasks →  Add Scheduled Task to open the Task
Scheduler wizard and follow the instructions. PAM configuration data will be
automatically saved at the interval indicated in the wizard.

 Note:
When requested to select  a program, select the <MyPamBackupCommand>.bat  batch
file.
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Restoring PAM Configuration Data
To restore PAM configuration data:

1. If required, install the same PAM software release on the backup PC as on the PAP unit.
See Deploying a New PAM Release, on page 5-27 and Activating a PAM Version, on
page 5-28.

2. From the Microsoft Windows desktop, open a command window. Browse to the
<MyPamBackupTools> directory containing the script files and enter the following
command line:

Cscript PamRestoreBackupData.js <MyPamBackupDirectory>

Saved PAM configuration data is restored.
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Section IV – Configuring Domains

  Important: 
This section describes domain configuration and management tools that are
reserved for use with partitioned servers and extended systems.  Please contact your
Bull Sales Representative for sales information.

This section explains how to:

• Partition your Server, on page 5-33

• Assess Configuration Requirements, on page 5-35

• Create, Edit, Copy, Delete, Rename a Domain Configuration Scheme, on page 5-36

• Update Test Schemes, on page 5-41

• Create, Edit, Delete a Domain Identity, on page 5-42

• Create a Mono–Domain Scheme using all Server Resources, on page 5-45

• Create a Mono–Domain Scheme using a Part of Server Resources, on page 5-53

• Create a Multi–Domain Scheme using all Server Resources, on page 5-61

• Create a Multi–Domain Scheme using a Part of Server Resources, on page 5-69

• Configure Extended Systems, on page 5-76

• Clear, Load, Save NVRAM Variables, on page 5-77

• Update the LUN List, on page 5-78

• Limit Access to Hardware Resources, on page 5-79

• Prepare a Scheme, Domain Identity, and Hardware Resources Checklist, on page 5-80
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Partitioning your Server

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.

Bull NovaScale Servers are designed around a flexible, cell–based, midplane architecture
allowing dynamic partitioning into physically independent domains. A domain is a coherent
set of hardware and software resources managed by a single Operating System instance.

The NovaScale 6085 Server is designed to operate as one or two hardware–independent
SMP systems, or domains.

The NovaScale 6165 Server is designed to operate as one, two, three or four
hardware–independent SMP systems, or domains.

 Note:
Server components and configuration may differ according to site requirements.
At least one IOC and one QBB are required for each server domain.

Partitioning allows you to optimize your server to:

• meet variations in workload – peak / off–peak periods,

• allow different time and date settings,

• use the same environment for tests and production,

• carry out software tests prior to deployment / upgrades,

• reduce downtime for servicing or re–configuration.

PAM software provides you with all the tools and features required to partition and manage
your server as independent SMP systems. For easy configuration and optimum use of the
physical and logical resources required for simultaneous operation, domains are defined via
the Domain Configuration Scheme wizard. From the PAM tree, expand the Configuration
Tasks and Domains nodes to display domain configuration options.

Figure 106. Schemes and Identites panes
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A Domain Configuration Scheme is used to define and manage a set of domains that can
be active simultaneously. The Schemes control pane allows you to create, edit, copy,
delete, and rename domain configuration schemes and update default test schemes.

A Domain Identity is used to define and manage domain context information. The
Identities control pane allows you to create, edit, copy, and delete domain identities.

The server is delivered with a pre–configured domain configuration scheme called
MyOperationsScheme, allowing you to simultaneously manage and administer all server
resources. However, as Customer Administrator, you may want to create other schemes
and identities to suit your working environment.

Before proceeding to create a new Scheme and/or new Domain Identities, you are advised
to assess your configuration requirements. See Assessing Configuration Requirements, on
page 5-35.
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Assessing Configuration Requirements

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.
At least one IOC and one QBB are required for each server domain.

You can use the following checklist to help you make an accurate plan of how you want to
partition and manage your system. For easy planning, you can print a copy of the Scheme,
Domain Identity, and Resources checklist templates provided on page 5-80.

Scheme Checklist

Name What name do I want to use for my Scheme?
Examples:
• MyFullConfigScheme
• MyPartConfigScheme
• MyNightScheme
• MyDayScheme
• MyTest_ProductionScheme

Description How can I describe my Scheme to reflect its scope?
Examples:
• Central Subsystems included
• Resources used
• Domain Identities used

Central Subsystem(s) Which Central Subsystem(s) do I want to use?

Number of domains How many domains do I need?

Domain size How many cells do I want to assign to each domain?

EFI boot LUNs Which EFI boot LUN do I want to use for each domain?

I/O resource location Which cells host the I/O resources I want to use?

Domain Identity Checklist

Name What name do I want to use for my Domain Identity to reflect
the tasks/jobs it will run?
Examples:
• MyDataMiningIdentity
• MyDataBaseIdentity
• MyProductionIdentity
• MyTestIdentity

Description How can I describe my Domain Identity to reflect its use?
Examples:
• OS and applications
• Time zone
• Boot path
• IP address
• Network name
• URL
• Production / test conditions

Operating System Which OS do I want to run on this domain? Does this OS sup-
port assigned hardware (CPUs, DIMMs)?

Domain network name Which network name will be used to identify this domain?

Domain IP address Which IP address will be used to reach this domain?

Domain URL Which URL can be used to reach my domain Web site (if any)?

Table 36. Domain configuration assessment criteria
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Creating, Editing, Copying, Deleting, Renaming a Domain
Configuration Scheme

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.

 Note:
Domain Identities can either be created via the Domain Scheme wizard or, independently,
via the  Identities configuration page. See Creating a Domain Identity, on page 5-42.

This section also provides you with a tutorial on how to create a:

• mono–domain scheme using all server resources, on page 5-45

• mono–domain scheme using a part of server resources, on page 5-53

• multi–domain scheme using all server resources, on page 5-61

• multi–domain scheme using a part of server resources, on page 5-69.

Creating a Domain Configuration Scheme

 Note:
At least one IOC and one QBB are required for each server domain.

To create a domain configuration scheme:

1. Assess your configuration requirements. See Assessing Configuration Requirements, on
page 5-35.

2. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes control pane.

Figure 107. Schemes control pane

3. Click New in the toolbar to open the Scheme Management dialog.

4. Complete the Scheme and Description fields, as required. See Assessing Configuration
Requirements, on page 5-35.

5. Click Central Subsystem → Add to select the Central Subsystem to be used by the
domain configuration scheme. The Central Subystem Configuration dialog opens.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 108. Scheme Creation and Central Subsystem Configuration dialogs
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6. Select a Central Subsystem and use the Number of  Parts dropdown list to select the
required number of hardware partitions (2 in the example).

7. Select the required partition configuration and click OK to return to the Scheme
Management dialog.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 109. Scheme Management dialog

The Status icon is red because a Domain Identity is required to complete domain
configuration.

8. Click Domains → Identity to open the Identities List dialog.
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9. If the required identity is in the list, go to Step 10.
If you want to create a new identity for this domain, click New to open the Create New
Identity dialog. See Creating a Domain Identity, on page 5-42.

10.Select the required identity from the list of available identities and click OK to return to
the Scheme Management dialog. The corresponding Status icon turns green.

11.Check that the EFI Boot Lun is correct. If the EFI Boot Lun is correct, go to Step 13.
If the EFI Boot Lun is not correct, click Domains → EFI LUN to open the LUN List
dialog.

12.Select the required EFI Boot Lun from the list of available Luns and click OK to return to
the Scheme Management dialog.

13.Click Save. The domain configuration scheme is now available for domain management.

Editing a Domain Configuration Scheme
To edit a domain configuration scheme:

1. Assess your configuration requirements. See Assessing Configuration Requirements, on
page 5-35.

2. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes pane. See Figure 107 above.

3. Select the required scheme from the list.

4. Click Edit in the toolbar to open the Edit Scheme dialog.
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NovaScale 6085 Server

NovaScale 6165 Server

Central Subsystem

Add Click here to add another Central Subsystem to your scheme.
See Creating a Domain Configuration Scheme, on page 5-36.

Remove Click here to remove a Central Subsystem from your scheme.

Modify Click here to change the number of hardware partitions in your scheme.

Domains

Remove Click here to remove the selected domain from the scheme.

Identity Click here to select a domain identity.

EFI Lun Click here to select an EFI Boot Lun.

Figure 110. Edit Scheme dialog
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5. Make the required changes and click Save. The modified domain configuration scheme
is now available for domain management.

Copying a Domain Configuration Scheme
To copy a domain configuration scheme:

1. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes pane. See Figure 107 above.

2. Select the required scheme from the list.

3. Click Copy in the toolbar. The Copy Scheme dialog opens.

4. Enter a name for the new scheme and click OK. The new domain configuration scheme
is now available for domain management.

Deleting a Domain Configuration Scheme
To delete a domain configuration scheme:

1. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes pane. See Figure 107 above.

2. Select the required scheme from the list.

3. Click Delete in the toolbar. You are requested to confirm scheme deletion.

4. Click OK to confirm. The domain configuration scheme is removed from the Schemes
List and is no longer available for domain management.

Renaming a Domain Configuration Scheme
To rename a domain configuration scheme:

1. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes pane. See Figure 107 above.

2. Select the required scheme from the list.

3. Click Rename in the toolbar.

4. Enter a new name for the scheme and click OK. The renamed domain configuration
scheme is now available for domain management.

Updating Test Schemes
The Domain Wizard allows you to automatically generate and update a set of Test
Schemes. These test schemes take into account all the hardware in your configuration. You
may need to update your test schemes after a service intervention entailing the
addition/removal of hardware elements.

To update test schemes:

1. Click Configuration Tasks → Domains → Schemes in the PAM tree to open the
Schemes pane. See Figure 107 above.

2. Click Test Schemes Update in the toolbar. Default test schemes are automatically
updated.
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Creating, Editing, Copying, Deleting a Domain Identity

  Important: 
Reserved for partitioned servers and extended systems.  Please contact your Bull
Sales Representative for sales information.

 Note:
Domain Identities can either be created via the Domain Configuration Scheme wizard or,
independently, via the Identities configuration page. See Creating a Domain Configuration
Scheme, on page 5-36.

Creating a Domain Identity
To create a domain identity:

1. Assess your configuration requirements. See Assessing Configuration Requirements, on
page 5-35.

2. Click Configuration Tasks → Domains → Identities in the PAM tree to open the
Identities Management page.

Figure 111. Identities List page
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3. Click New in the toolbar to open the Create New Identity dialog.

Figure 112. Create New Identity dialog

4. Complete the Name, Description, Domain Settings, and Management Parameters
fields, as required. See Assessing Configuration Requirements, on page 5-35.

5. Click OK. The new identity appears in the Identities List page and can be applied to a
hardware partition via the Domain Configuration Scheme wizard.

Editing a Domain Identity
To modify domain identity settings, management parameters and/or description:

1. Assess your configuration requirements. See Assessing Configuration Requirements, on
page 5-35.

2. Click Configuration Tasks → Domains → Identities in the PAM tree to open the
Identities Management page. See Figure 111 above.

3. Select the required identity from the list.

4. Click Edit in the toolbar. The Edit an Identity dialog opens, allowing you to modify
domain identity settings, management parameters and/or description. See Figure 112
above.

5. Enter a new description in the Description field, and/or a new Operating System /
Version in the Domain Settings field, and/or a new network name, IP address, URL in
the Management Parameters field.

6. Click OK to confirm the modification.
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Copying a Domain Identity
To copy a domain identity:

1. Click Configuration Tasks → Domains → Identities in the PAM tree to open the
Identities Management page. See Figure 111 above.

2. Select the required identity from the list.

3. Click Copy in the toolbar. The Copy Identity dialog opens.

4. Enter the name for the new identity and click OK to confirm.

5. The new identity appears in the Identities List page and can be applied to a hardware
partition via the Domain Configuration Scheme wizard.

Deleting a Domain Identity

  Important: 
If a Domain Identity is used in a Scheme, it cannot be deleted.

To delete a domain identity:

1. Click Configuration Tasks → Domains → Identities in the PAM tree to open the
Identities List page. See Figure 111 above.

2. Select the required identity from the list.

3. Click Delete in the toolbar and click OK to confirm. The selected identity is removed from
the Identities List.
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Creating a Mono–Domain Scheme using all Server Resources
The configuration criteria set out in the following tables is used to illustrate this example.

NovaScale 6085 Server

Scheme

Name MyBusinessScheme

Description Mono–domain, Cells 0 & 1, Boot 0Lun0, MyBusiness–1

Central Subsystem(s) MyServer

Number of domains 1

Domain size 2 cells: Cell0 & Cell 1

EFI boot LUNs MyServer_0Lun0

IO resource location 0IOC0 mandatory, 0IOC1 optional

Domain Identity

Name MyBusiness–1

Description Time zone: Central America, Boot path: EFI 0Lun0

Operating System Windows

Domain network name MyBusiness–1Net

Domain IP address 123.123.12.1

Domain URL http://www.MyBusiness–1Web.com

Table 37. Scheme configuration criteria – example 1 – mono–module server

NovaScale 6165 Server

Scheme

Name MyBusinessScheme

Description Mono–domain, Cells 0, 1, 2 & 3, Boot 0Lun0, MyBusiness–1

Central Subsystem(s) MyServer

Number of domains 1

Domain size 4 cells: Cell0, Cell1, Cell2 & Cell 3

EFI boot LUNs MyServer_0Lun0

IO resource location 0IOC0 mandatory, 0IOC1, 1IOC0, & 1IOC1 optional

Domain Identity

Name MyBusiness–1

Description Time zone: Central America, Boot path: EFI 0Lun0

Operating System Windows

Domain network name MyBusiness–1Net

Domain IP address 123.123.12.1

Domain URL http://www.MyBusiness–1Web.com

Table 38. Scheme configuration criteria – example 1 – bi–module server

 Note:
A domain configuration scheme can include more than one Central Subsystems. If you have
more than one Bull NovaScale Server, see Configuring Extended Systems, on page 5-76.
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To create a mono–domain scheme using all server resources:

1. Check that the required hardware resources are available (at least one IOC and one
QBB are required for each server domain) and that the domain Operating System
supports the required hardware resources (CPUs, DIMMs, ...).

2. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

3. Click New to open the Scheme Creation dialog.

4. Complete the Scheme and Description fields.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 113. Scheme creation dialog – example 1
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5. Click Central Subsystem → Add to select the Central Subsystem to be used by the
domain configuration scheme. The Central Subsystem Configuration dialog opens.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 114. Central Subsystem configuration dialog – example 1
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6. Check that the required Central Subsystem is highlighted and select 1 in the Number of
Parts dropdown list.

7. Select the required partition configuration and click OK to return to the Scheme
Management dialog.

The Status icons are red because a Domain Identities are required to complete domain
configuration.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 115. Scheme Management dialog – example 1

8. Double–click the empty D1 Identities field. The Identities List dialog opens.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 116. Identities list dialog – example 1

9. If the required identity is in the list, go to Step 12.
If you want to create a new identity for this domain, click New to open the Create New
Identity dialog.
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10.Complete the Name, Description, Domain Settings, and Management Parameters
fields.

Figure 117. Create new identity dialog – example 1

11.Click OK. The new identity appears in the Identities List  dialog.

12.Select the required identity from the list of available identities and click OK to return to
the Scheme Management dialog. The corresponding Status icon turns green.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 118. Scheme Management dialog – example 1

13.Check that the EFI Boot Lun for the domain is correct. If the EFI Boot Lun is correct, go
to Step 14.
If the EFI Boot Lun is not correct, double–click the EFI LUNs field. The LUN List  dialog
opens, allowing you to choose the required EFI Boot Lun from the list of available Luns
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 119. Lun list dialog – example 1

14.Select the required EFI Boot Lun from the list of available Luns and click OK to return to
the Scheme Management dialog.

15.Click Save. The domain configuration scheme is now available for domain management.
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Creating a Mono–Domain Scheme using a Part of Server
Resources

The configuration criteria set out in the following tables is used to illustrate this example.

NovaScale 6085 Server

Scheme

Name MyOffpeakProdScheme

Description Mono–domain, Cell 1, Boot 0Lun1, MyOffpeakProd

Central Subsystem(s) MyServer

Number of domains 1

Domain size 1 cell: Cell 1

EFI boot LUNs 0Lun1

IO resource location 0IOC1

Domain Identity

Name MyOffpeakProd

Description Time zone: Paris, Boot path: EFI 0Lun1

Operating System Linux

Domain network name MyOffpeakProdNet

Domain IP address 124.124.1.0

Domain URL http://www.MyOffpeakProdWeb.com

Table 39. Scheme configuration criteria – example 2 – mono–module server

NovaScale 6165 Server

Scheme

Name MyOffpeakProdScheme

Description Mono–domain, Cell 1, Boot 0Lun1, MyOffpeakProd

Central Subsystem(s) MyServer

Number of domains 1

Domain size 1 cell: Cell 1

EFI boot LUNs 0Lun1

IO resource location 0IOC1

Domain Identity

Name MyOffpeakProd

Description Time zone: Paris, Boot path: EFI 0Lun1

Operating System Linux

Domain network name MyOffpeakProdNet

Domain IP address 124.124.1.0

Domain URL http://www.MyOffpeakProdWeb.com

Table 40. Scheme configuration criteria – example 2 – bi–module server
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 Note:
A domain configuration scheme can include more than one Central Subsystems. If you have
more than one Bull NovaScale Server, see Configuring Extended Systems, on page 5-76.

To create a mono–domain scheme using a part of server resources:

1. Check that the required hardware resources are available (at least one IOC and one
QBB are required for each server domain) and that the domain Operating System
supports the required hardware resources (CPUs, DIMMs, ...).

2. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

3. Click New to open the Scheme Creation dialog.

4. Complete the Scheme and Description fields.

Figure 120. Scheme creation dialog – example 2

5. Click Central Subsystem → Add to select the Central Subsystem to be used by the
domain configuration scheme. The Central Subsystem Configuration dialog opens.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 121. Central Subsystem configuration dialog – example 2

6. Check that the required Central Subsystem is highlighted and select 2 (mono–module
server) or 4 (bi–module server) in the Number of Parts dropdown list.
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7. Select the required partition configuration and click OK to return to the Scheme
Management dialog.

8. As you want this scheme to only use Cell 1, you must remove the domains using the
other cells. Hover the mouse over the cells represented in the CellBlocks diagram to
identify the domain using Cell 1. D2 is using Cell 1.

9. Click D1 → Domains → Remove and click OK to remove the unwanted domain from the
scheme.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 122. Remove domain confirmation dialog – example 2
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10.Repeat Step 11 for D3 and D4, where applicable.

12.Now, only one domain appears in the Scheme Management dialog. The Status icon is
red because a Domain Identity is required to complete domain configuration.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 123. Scheme Management dialog – example 2

13.Double–click the empty D1 Identities field. The Identities List dialog opens.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 124. Identities list dialog – example 2

14.If the required identity is in the list, go to Step 17.
If you want to create a new identity for this domain, click New to open the Create New
Identity dialog.
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15.Complete the Name, Description, Domain Settings, and Management Parameters
fields.

Figure 125. Create new identity dialog – example 2

16.Click OK. The new identity appears in the Identities List  dialog.

17.Select the required identity from the list of available identities and click OK to return to
the Scheme Management dialog. The corresponding Status icon turns green.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 126. Scheme Management dialog – example 2

18.Check that the EFI Boot Lun for the domain is correct and click Save. The domain
configuration scheme is now available for domain management.
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Creating a Multi–Domain Scheme using all Server Resources
The configuration criteria set out in the following tables is used to illustrate this example.

NovaScale 6085 Server

Scheme

Name MyProd_PayrollScheme

Description Multi–domain, Cells 0 & 1, Boot 0Lun0 & 0Lun1
MyProduction & MyPayroll

Central Subsystem(s) MyServer

Number of domains 2

Domain size 1 cell per domain:
Cell 0 for Domain 1
Cell 1 for Domain 2

EFI boot LUNs 0Lun0 for MyProduction
0Lun1 for MyPayroll

IO resource location 0IOC0 mandatory for MyProduction
0IOC1 mandatory for MyPayroll

Domain Identity 1

Name MyProduction

Description Time zone: Vladivostok, Boot path: EFI 0Lun0

Operating System Windows

Domain network name MyProductionNet

Domain IP address 121.121.12.1

Domain URL http://www.MyProductionWeb.com

Domain Identity 2

Name MyPayroll

Description Time zone: Paris, Boot path: EFI 0Lun1

Operating System Linux

Domain network name MyPayrollNet

Domain IP address 122.122.1.0

Domain URL http://www.MyPayrollWeb.com

Table 41. Scheme configuration criteria – example 3 – mono–module server
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NovaScale 6165 Server

Scheme

Name MyProd_PayrollScheme

Description Multi–domain, Cells 0, 1, 2  & 3, Boot 0Lun0 & 0Lun3,
MyProduction & MyPayroll

Central Subsystem(s) MyServer

Number of domains 2

IO resource location 0IOC0 mandatory, 0IOC1 & 1IOC0 optional, for MyProduction
1IOC1 mandatory for MyPayroll

Domain Identity 1

Name MyProduction

Description Time zone: Vladivostok, Boot path: EFI 0Lun0

Operating System Windows

Domain network name MyProductionNet

Domain IP address 121.121.12.1

Domain URL http://www.MyProductionWeb.com

Domain Identity 2

Name MyPayroll

Description Time zone: Paris, Boot path: EFI 0Lun3

Operating System Linux

Domain network name MyPayrollNet

Domain IP address 122.122.1.0

Domain URL http://www.MyPayrollWeb.com

Table 42. Scheme configuration criteria – example 3 – bi–module server

 Note:
A domain configuration scheme can include more than one Central Subsystems. If you have
more than one Bull NovaScale Server, see Configuring Extended Systems, on page 5-76.
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To create a multi–domain scheme using all server resources:

1. Check that the required hardware resources are available (at least one IOC and one
QBB are required for each server domain) and that the domain Operating System
supports the required hardware resources (CPUs, DIMMs, ...).

2. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

3. Click New to open the Scheme Creation dialog.

4. Complete the Scheme and Description fields.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 127. Scheme creation dialog – example 3



5-64 User’s Guide

5. Click Central Subsystem → Add to select the Central Subsystem to be used by the
domain configuration scheme. The Central Subsystem Configuration dialog opens.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 128. Central Subsystem configuration dialog – example 3
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6. Check that the required Central Subsystem is highlighted and select 2 in the Number of
Parts dropdown list.

7. Select the required partition configuration and click OK to return to the Scheme
Management dialog.

The Status icons are red because Domain Identities are required to complete domain
configuration.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 129. Scheme Management dialog – example 3
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8. Double–click the empty D1 Identities field. The Identities List dialog opens.

NovaScale 6085 Server

NovaScale 6165 Server

Figure 130. Identities list dialog – example 3

9. If the required identity is in the list, go to Step 12.
To create a new identity for this domain, click New to open the Create New Identity
dialog.
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10.Complete the Name, Description, Domain Settings, and Management Parameters
fields for Domain Identity D1.

Figure 131. Create new identity dialog – example 3

11.Click OK. The new identity appears in the Identities List  dialog.

12.Select the required identity from the list of available identities and click OK to return to
the Scheme Management dialog. The corresponding Status icon turns green.

13.Repeat Steps 8 to 12 for Domain Identity D2. The scheme is now completely
configured.
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NovaScale 6085 Server

NovaScale 6165 Server

Figure 132. Scheme management dialog – example 3

14.Click Save. The domain configuration scheme is now available for domain management.
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Creating a Multi–Domain Scheme using a Part of Server
Resources

The configuration criteria set out in the following table is used to illustrate this example.

NovaScale 6165 Server

Scheme

Name MyTest_DevptScheme

Description Multi–domain, Cells 1, 2  & 3, Boot 0Lun1 & 0Lun2,
MyTest & MyDevpt

Central Subsystem(s) MyServer

Number of domains 2

Domain size Cell 1 for Domain 1
Cells 2 & 3 for Domain 2

EFI boot LUNs 0Lun1 for MyTest
0Lun2 for MyDevpt

IO resource location 0IOC1 mandatory for MyTest
1IOC0 mandatory, 1IOC1 optional, for MyDevpt

Domain Identity 1

Name MyTest

Description Time zone: Paris, Boot path: EFI 0Lun1

Operating System Linux

Domain network name MyTestNet

Domain IP address 126.126.1.2

Domain URL http://www.MyProductionWeb.com

Domain Identity 2

Name MyDevpt

Description Time zone: Paris, Boot path: EFI 0Lun2

Operating System Windows

Domain network name MyDevptNet

Domain IP address 126.126.1.0

Domain URL http://www.MyPayrollWeb.com

Table 43. Scheme configuration criteria – example 4 – bi–module server

 Note:
A domain configuration scheme can include more than one Central Subsystems. If you have
more than one Bull NovaScale Server, see Configuring Extended Systems, on page 5-76.
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To create a multi–domain scheme using a part of server resources:

1. Check that the required hardware resources are available (at least one IOC and one
QBB are required for each server domain) and that the domain Operating System
supports the required hardware resources (CPUs, DIMMs, ...).

2. From the Customer Administrator PAM tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

3. Click New to open the Scheme Creation dialog.

4. Complete the Scheme and Description fields.

Figure 133. Scheme creation dialog – example 4
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5. Click Central Subsystem → Add to select the Central Subsystem to be used by the
domain configuration scheme. The Central Subsystem Configuration dialog opens.

Figure 134. Central Subsystem configuration dialog – example 4

6. Check that the required Central Subsystem is highlighted and select 3 in the Number of
Parts dropdown list.

7. Select the required partition configuration and click OK to return to the Scheme
Management dialog.
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The Status icons are red because Domain Identities are required to complete domain
configuration.

Figure 135. Scheme Management dialog – example 4

8. As you want this scheme to only use Cells 1, 2 and 3, you must remove the domain
using Cell 0. Hover the mouse over the cells represented in the CellBlocks diagram to
identify the domain using Cell 0. D1 is using Cell 0.

9. Click D1 → Domains → Remove and click OK to remove the domain from the scheme.

Figure 136. Remove domain confirmation dialog – example 4
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10.Now, only two domains appear in the Scheme Management dialog. The Status icons
are red because Domain Identities are required to complete domain configuration.

Figure 137. Scheme Management dialog – example 4
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11.Double–click the empty D1 Identities field. The Identities List dialog opens.

Figure 138. Identities list dialog – example 4

12.f the required identity is in the list, go to Step 15.
To create a new identity for this domain, click New to open the Create New Identity
dialog.

13.Complete the Name, Description, Domain Settings, and Management Parameters
fields for Domain Identity D1.

Figure 139. Create new identity dialog – example 4

14.Click OK. The new identity appears in the Identities List  dialog.
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15.Select the required identity from the list of available identities and click OK to return to
the Scheme Management dialog. The corresponding Status icon turns green.

16.Repeat Steps 11 to 15 for Domain Identity D2. The scheme is now completely
configured.

Figure 140. Scheme management dialog – example 4

17.Click Save. The domain configuration scheme is now available for domain management.

 Note:
Cell 0 is free and available for use by another scheme, if required.
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Configuring and Managing Extended Systems
A single PAP unit can administer, monitor, and manage several Central Subsystems.

The PAM Domain Configuration Scheme Wizard allows easy configuration of extended
systems.

Please contact your BULL Customer Sales Representative for details.
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Clearing, Loading, Saving NVRAM Variables
NVRAM variables are available for each LUN. According to requirements, these variables
can be cleared, saved and/or loaded.

 Note:
NVRAM variables can only be saved when the corresponding domain is active.

To clear, save and/or load NVRAM variables:

1. Click Configuration Tasks → Domains → LUNs in the PAM tree to open the Logical
Units page.

Name Default LUN name

EFI EFI
This LUN is a boot LUN.
DATA
This LUN is a data LUN.

In Use in Domain Yes
This LUN is used by a domain currently loaded in the Domain Manager
Control pane.
No
This LUN is not used by a domain currently loaded in the Domain Man-
ager Control pane.

In Use in Scheme Yes
This LUN has been allocated to a domain within a Domain Configuration
Scheme.
No
This LUN has not been allocated to a domain within a Domain Configu-
ration Scheme.

NVRAM Yes
NVRAM variables have been saved for this LUN.
No
NVRAM variables have not been saved for this LUN.

Description Default description, indicating LUN location (Central Subsystem name
and Cell).

Figure 141. Logical Units page
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2. Select the required LUN from the list of available LUNs and click NVRAM. The NVRAM
Variables dialog opens:

a. Click Clear to clear displayed NVRAM variables. When requested, click OK to
confirm.

b. Click Save to save NVRAM variables for the selected LUN (currently used by an
active domain). When requested, enter the name of the file to which NVRAM
variables are to be saved. The NVRAM variables file is stored in the PAM SiteData
directory.

c. Click Load to load previously saved NVRAM variables from the PAM SiteData
directory.

Updating the LUN List
The list of available LUNs is automatically created when a Central Subsystem is declared
and/or added. You can update the list of available LUNs at any time to reflect configuration
changes.

To update the LUN list:

1. Click Configuration Tasks → Domains → LUNs in the PAM tree to open the Logical
Units page.

2. Click Update. When requested, click OK to confirm. The new LUN list is displayed in the
Logical Units page.
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Limiting Access to Hardware Resources
As Customer Administrator, you can use the PAM software Exclusion / Inclusion function
to logically limit access to certain hardware resources, such as:

IOCs When a domain comprises more than one cell (therefore more than one
IOC), the Master IOC is the one hosting the boot disk. The other IOCs in
the domain are Slave IOCs.

Slave IOCs can be safely excluded from a domain, but connected
peripherals will no longer be accessible.

Note:
If the Master IOC is excluded, system disks will no longer be
accessible and the domain will not power up.

IOC HubLinks All IOC HubLinks can be safely excluded from a domain, but connected
peripherals will no longer be accessible.

IOC HubLinks are organized as follows:
HubLink_1 controls PCI Slots 1 & 2
HubLink_2 controls PCI slots 3 & 4
HubLink_3 controls PCI slots 5 & 6

PCI Slots All PCI slots not connected to a boot disk can be safely excluded from a
domain, but connected peripherals will no longer be accessible.

Note:
If Master IOC PCI Slots 1, 2 are excluded, external system disks will
no longer be accessible and the domain will not power up.

IOLs Slave IOLs can be safely excluded from a domain, but connected
peripherals will no longer be accessible.

Figure 142. Hardware exclusion options

 Notes:
Hardware exclusion / inclusion is a hardware management function, not a domain
management function.
To be taken into account, exclusion / inclusion requires domain power OFF/ON.

See Excluding / Including Hardware Elements, on page 4-21.
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Scheme, Domain Identity, and Resources Checklists

  Important: 
At least one QBB and one IO box is required for each server domain.

Scheme Checklist

Name What name do I want to use for my Scheme?

Description How can I describe my Scheme to reflect its scope?

Central Subsystem(s) Which Central Subsystem(s) do I want to use?

Number of domains How many domains do I need?

Domain size How many cells do I want to assign to each domain?

EFI boot LUNs Which EFI boot LUN do I want to use for each domain?

I/O resource location Which cells host the I/O resources I want to use?

Table 44. Scheme configuration checklist
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Domain Identity Checklist

Name What name do I want to use for my Domain Identity to reflect
the tasks/jobs it will run?

Description How can I describe my Domain Identity to reflect its use?

Operating System Which OS do I want to run on this domain? Will this OS sup-
port assigned hardware (CPUs, DIMMs)?

Domain network name Which network name will be used to identify this domain?

Domain IP address Which IP address will be used to reach this domain?

Domain URL Which URL can be used to reach my domain Web site (if any)?

Table 45. Domain Identity configuration checklist
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Resources Checklist

Central Subsystem:

Cell 0 Cell 1

QBBs QBB0 QBBs QBB1QBBs QBB0 QBBs QBB1

IO Box IOC0 IO Box IOC1

EFI Boot Lun 0Lu0 EFI Boot Lun 0Lu1

OS instance OS instance

I/O Resources I/O Resources

IOC0_Slot 1 IOC1_Slot 1

IOC0_Slot 2 IOC1_Slot 2

IOC0_Slot 3 IOC1_Slot 3

IOC0_Slot 4 IOC1_Slot 4

IOC0_Slot 5 IOC1_Slot 5

IOC0_Slot 6 IOC1_Slot 6

Table 46. Resources checklist – part 1



5-83Tips and Features for Administrators

Resources Checklist

Cell 2 Cell 3

QBBs QBB0 QBBs QBB1QBBs QBB0 QBBs QBB1

IO Box IOC0 IO Box IOC1

EFI Boot Lun 1Lu0 EFI Boot Lun 1Lu1

OS instance OS instance

I/O Resources I/O Resources

IOC0_Slot 1 IOC1_Slot 1

IOC0_Slot 2 IOC1_Slot 2

IOC0_Slot 3 IOC1_Slot 3

IOC0_Slot 4 IOC1_Slot 4

IOC0_Slot 5 IOC1_Slot 5

IOC0_Slot 6 IOC1_Slot 6

Table 47. Resources checklist – part 2
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Section V – Creating Event Subscriptions and User Histories

This section explains how to:

• Customize the PAM Event Messaging System, on page 5-85

• Set up Event Subscriptions, on page 5-86

• Create, Edit, Delete an E–mail Server, on page 5-88

• Create, Edit, Delete an E–mail Account, on page 5-90

• Create, Edit, Delete a User History, on page 5-92

• Enable / Disable Event Channels, on page 5-96

• Create, Edit, Delete an Event Subscription, on page 5-98

• Understand Event Message Filtering Criteria, on page 5-100

• Preselect, Create, Edit, Delete an Event Filter, on page 5-110
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Customizing the PAM Event Messaging System
During operation, all Central Subsystem activity messages are automatically logged in
predefined System Histories that can be viewed and archived by members of the Customer
Administrator group. In addition, PAM software reports and logs environmental, command,
and hardware errors.

A comprehensive set of Event Message subscriptions allows connected and non–connected
users to be notified of system status and activity.

The PAM event messaging system is based on a subscription mechanism allowing the
Customer Administrator to send precisely filtered event messages to targeted individuals
and/or groups via four channels (WEB Interface, E–mail, User History, SNMP) as shown in
Figure 143.

Figure 143. PAM event messaging system features

 Note:
PAM software is delivered with a set of predefined subscriptions that have been designed to
suit the needs of most Administrators and Operators. If required, you can use PAM
Configuration tools to set up customized subscriptions.

From the PAM tree, expand the Configuration Tasks and Events nodes to display event
configuration options.
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Setting up Event Subscriptions
Before creating an event subscription, you should establish:

• the set of messages you want a user or a group of users to receive (Filter),

• how you want the user or group of users to receive messages (Channel).

Selecting a Filter

The comprehensive event message filtering system allows you to use a predefined filter or
to create a specific filter, according to your needs.
See Preselecting an Event Filter, on page 5-110 and Creating an Event Filter, on page
5-111.

Selecting a Channel

Four channels can be used to forward event messages, according to targeted recipients:

Channel Advantage

E–mail Allows a specific user to receive system notifications/ alerts.

User history Records specific system operations/alerts into a dedicated log file.

Web Allows a specific group of users to be warned of system operations/alerts
when connected to the PAM Web interface.

SNMP Forwards specific messages as SNMP traps to the selected SNMP applica-
tion.

Table 48. Event channels
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Event Subscription Flowcharts
Once you have established who the targeted recipients are and which channel you want to
use, you can use the following flowcharts as a quick guide to event subscription procedures.

E–mail Event Subscription

Allows a specific user to receive system notifications/alerts via e–mail.

 Preselect an Event filter, on page 5-110, or Create an Event Filter, on page 5-111.

Select or Create an E–mail Server, on page 5-88.

Select or  Create an E–mail Account, on page 5-90.

 Create the Event Subscription, on page 5-98.

User History Event Subscription

Records specific system operations/alerts into a dedicated log file.

 Preselect an Event filter, on page 5-110, or Create an Event Filter, on page 5-111.

Select or Create a User History, on page 5-93.

 Create the Event Subscription, on page 5-98.

Web Event Subscription

Allows a specific group of users to be warned of system operations/alerts
 when connected to the PAM Web interface.

 Preselect an Event filter, on page 5-110, or Create an Event Filter, on page 5-111.

 Create the Event Subscription, on page 5-98.

SNMP Event Subscription

Forwards system operations/alerts as SNMP traps to the selected SNMP Manager.

 Preselect an Event filter, on page 5-110, or Create an Event Filter, on page 5-111.

 Create the Event Subscription, on page 5-98.



5-88 User’s Guide

Creating, Editing, Deleting an E–mail Server
To send messages via the e–mail channel, you must first create an e–mail server. Several
e–mail accounts can then be attached to the same e–mail server, see Creating an E–mail
Account, on page 5-90.

Creating an E–mail Server
To create an e–mail server:

1. Click Configuration Tasks → Events → E–mail servers in the PAM tree. The e–mail
servers configuration page opens.

Figure 144. E–mail servers configuration page

2. Click New in the toolbar.

3. Enter the server name in the Name field, the address of the existing e–mail server you
intend to use in the URL field, and a brief description, if required, in the Description
field.

4. Enter a user name and password, if required and click OK to confirm the creation of the
new e–mail server.

 Note:
The OK button is accessible once all mandatory fields have been completed.
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Editing E–mail Server Attributes
To modify an e–mail server URL / description:

1. Click Configuration Tasks → Events → E–mail servers in the PAM tree. The e–mail
server configuration page opens. See Figure 144 above.

2. Select the required server from the e–mail servers list.

3. Click Edit in the toolbar to modify the server URL / description.

4. Enter a new address in the URL field and/or a new description in the Description field,
as applicable.

5. Click OK to confirm the modification.

Deleting an E–mail Server

  Important: 
Before deleting an e–mail server, all the accounts attached to that server must be
attached to another server, or deleted.
At least one e–mail server must be defined to send messages via the e–mail channel.

If e–mail accounts are attached to this e–mail server:

• see Editing E–mail Account  Attributes, on page 5-89 to attach these accounts to
another server, or

• see Deleting an E–mail Account, on page 5-91 to delete these accounts.

To delete an e–mail server:

1. Click Configuration Tasks → Events → E–mail Servers in the PAM tree. The e–mail
server configuration page opens. See Figure 144, on page 5-88.

2. Select the required server from the e–mail servers list.

3. Click Delete in the toolbar.

4. Click OK to confirm the deletion of the selected e–mail server.
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Creating, Editing, Deleting an E–mail Account
To send messages via the e–mail channel, you must first create an e–mail server and then
attach an e–mail address to this e–mail server. Several e–mail accounts can be attached to
the same e–mail server.

Creating an E–mail Account
To create an e–mail account:

1. Click Configuration Tasks → Events → E–mail accounts in the PAM tree. The e–mail
accounts configuration page opens.

Figure 145. E–mail accounts configuration page

2. Click New in the toolbar.

3. Enter the new account name in the Account field and corresponding e–mail address in
the URL Address field.

4. Select the server to be used to deliver messages to this address from the E–mail Server
list. If the required e–mail server is not in the list, see Creating an E–mail Server, on
page 5-88.

5. Enter a brief description, if required, in the Description field.

6. Click OK to confirm the creation of the new e–mail account.

The new e–mail account can now be selected when you set up an event subscription to be
sent via the e–mail channel.

 Note:
The OK button is accessible once all mandatory fields have been completed.
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Editing E–mail Account Attributes
To modify an e–mail account name, address, server and/or description:

1. Click Configuration Tasks → Events → E–mail accounts in the PAM tree. The e–mail
accounts configuration page opens. See Figure 145 above.

2. Select the required account from the e–mail accounts list.

3. Click Edit in the toolbar to modify the account name, address, server and/or description.

4. Enter the new attributes in the corresponding fields, as applicable. If the required e–mail
server is not in the list, see Creating an E–mail Server, on page 5-88.

5. Click OK to confirm the modification.

Deleting an E–mail Account

  Important: 
Before deleting an e–mail account, all the event subscriptions attached to that
account must be attached to another account, or deleted.

If event subscriptions are attached to this e–mail account, see:

• Editing Event Subscription Attributes, on page 5-99 to attach these event subscriptions to
another account,

• or Deleting an Event Subscription, on page 5-99 to delete these event subscriptions.

To delete an e–mail account:

1. Click Configuration Tasks → Events → E–mail accounts in the PAM tree. The e–mail
accounts configuration page opens. See Figure 145 above.

2. Select the required account from the e–mail accounts list.

3. Click Delete in the toolbar.

4. Click OK to confirm the deletion of the selected e–mail account.
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Creating, Editing, Deleting a User History
There are two types of histories: System histories and User histories.

System histories cannot be modified and are are only accessible to members of the
Customer Administrator group.

User histories can be created, edited and deleted and are accessible to members of both
the Customer Administrator and Customer Operator groups.

For guidance, System history contents are explained in the following table:

System History Contents

History Name Contents

HistoryTrace History Manager trace file. Logs archiving actions and
history/archive processing errors.

InterventionReportHistory Reserved for Support personnel.

IPMITrace Reserved.

MaestroHistory Reserved.

MaestroTrace Reserved for Support personnel.

PAMHistory Central PAM software history file. Logs all error or infor-
mation messages concerning PAM software and all oper-
ator visible events.

PAMTrace Logs domain power sequence trace data.

RPCTrace Reserved for Support personnel.

SANTrace Logs SAN–IT trace data.

Table 49. System history contents
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Creating a User History

 Note:
The Site Data Directory will be used, by default, if you do not specify a different directory
when you create a user history.See Viewing PAM Version Information, on page 4-11

To create a user history:

1. Click Configuration Tasks → Histories in the PAM tree. The Histories control pane
opens.

2. Click New in the toolbar. The Create a New User History dialog opens.

Figure 146. Create a New User History dialog

3. Enter a name in the Name field (mandatory) and a brief description, if required, in the
Description field.

4. Enter a directory pathname in the Directory field. If this field is left blank, the default
Histories directory will be used.
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5. Use the drop–down menu to select an automatic archiving policy Type:

Type Automatic Archiving Policy

Number of Days The system will automatically create an archive for this history after
the number of days specified in the Value field.

Size in KBytes The system will automatically create an archive when this history
reaches the size in KBytes specified in the Value field.
Note:
Size in KBytes must be greater than 10.

Number of Records The system will automatically create an archive when this history
reaches the number of records specified in the Value field.
Note:
Number of Records must be greater than 10.

Table 50. History automatic achiving policies

6. Enter the required number of days / KBytes / records in the Value field, as applicable.

7. Enter a directory pathname in the Directory field. If this field is left blank, the default
Archives directory will be used.

8. If you want the archive to be automatically deleted at regular intervals, select the Delete
archive files checkbox and enter the number of days you want to maintain the archive in
the days field.

9. Click OK to confirm the creation of the new history. The new history appears in the list of
available histories.

 Note:
The OK button is accessible once all mandatory fields have been completed.

Editing History Parameters
To modify the archiving parameters of system / user histories:

1. Click Configuration Tasks → Histories in the PAM tree. The Histories control pane
opens.

2. Select the required History from the Histories list.

3. Click Edit in the toolbar to modify the archiving parameters for this History. The Edit
History Parameters page opens.

4. Enter the new parameters in the corresponding fields.

5. Click OK to confirm the modification.
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Deleting a User History

  Important: 
Before deleting a user history, all the event subscriptions attached to that history
must be attached to another history, or deleted. System histories cannot be deleted.

If event subscriptions are attached to this history:

• see Editing Event Subscription Attributes, on page 5-99 to attach these event
subscriptions to another history, or

• see Deleting an Event Subscription, on page 5-99 to delete these event subscriptions.

To delete a user history:

1. Check that no event subscriptions are attached to this history.

2. Click Configuration Tasks → Histories in the PAM tree. The Histories control pane
opens.

3. Select the required History from the Histories list.

4. Click Delete in the toolbar.

5. Click OK to confirm the deletion of the selected user history.
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Enabling / Disabling Event Channels
An event channel must be selected and enabled for all event subscriptions. The following
table provides the Customer Administrator with guidelines for selecting an event channel.

Channel Target Enabled Disabled

EMAIL Specific recipient.

Allows a specific re-
cipient to directly re-
ceive specific mes-
sages.

Advanced feature:

LOG (User History) All user groups.
Allows all users to ac-
cess specific mes-
sages.

Advanced feature:
Only to be used if
the system gener-
ates too many mes-

SNMP SNMP application.

Forwards specific
messages as SNMP
traps to the selected
SNMP application for
processing.

ates too many mes-
sages and mainte-
nance actions are to
be carried out.

WEB (PAM Interface) Selected users.

Allows a specific
group of users to
view specific mes-
sages.

Table 51. Event channel selection guidelines

 Note:
When an event channel is disabled, all messages sent via that channel are lost.
All event channels are enabled by default.

To enable / disable an event channel:

1. Click Configuration Tasks → Events → Channels in the PAM tree. The channels
configuration page opens.
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Figure 147. Event Channels configuration page

2. Select the Yes or No radio button in the Enable column to enable or disable the required
channel.

3. Click the Save icon to confirm the new configuration.
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Creating, Editing, Deleting an Event Subscription
Once event subscription prerequisites have been set up, you can create the event
subscriptions required to send messages to their destinations. See Event Subscription
Flowcharts, on page 5-87.

Creating an Event Subscription
To create an event subscription:

1. Click Configuration Tasks → Events → Subscriptions in the PAM tree. The event
subscription configuration page opens.

2. Click New in the toolbar.

Figure 148. New Event Subscription dialog box

3. Select the Active and Enable checkboxes to activate and enable the new subscription.

4. Enter a short, readily identifiable name in the Name field and a brief description, if
required, in the Description field.

5. Select the required channel radio button:

– E–MAIL: to send event messages to an e–mail address.

– LOG: to send event messages to a user history.

– SNMP: to send event messages to the SNMP Manager.

– WEB: to send event messages to the status pane in the PAM web interface.

6. Select a pre–configured E–mail Account, User History, or User Group from the
drop–down menu or enter an SNMP Manager IP address or server name.

7. Select a pre–configured filter from the Filter drop–down menu.
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8. Click OK to confirm the creation of the new event subscription.

9. The event subscription configuration page is automatically updated with the new
subscription.

10.Click Test Subscription to check that the event subscription has been configured
correctly. Subscription parameters will be used to send a test message.

 Note:
The OK button is accessible once all mandatory fields have been completed.

Editing Event Subscription Attributes
To modify an event subscription description, channel, address and/or filter, or to activate /
deactivate and/or enable / disable an event subscription:

1. Click Configuration Tasks → Events → Subscriptions in the PAM tree. The event
subscription configuration page opens.

2. Select the required event subscription in the event subscription table.

3. Click Edit to modify the attributes of this event subscription. The Edit Event
Subscription dialog box opens.

4. Select the new channel, E–mail Account, User History, or User Group from the
drop–down menu or enter a new SNMP Manager IP address or server name.

5. Modify the description.

6. If required, activate / deactivate and/or enable / disable the event subscription by
selecting / deselecting the Active  and Enable checkboxes.

 Warning: 
If you deactivate / disable an event subscription, no events will be sent to the
recipient(s) until the event subscription is reactivated / re–enabled.

7. Click OK to confirm the modification.

8. Click Test Subscription to check that the event subscription has been re–configured
correctly.

 Note:
The OK button is accessible once all mandatory fields have been completed.

Deleting an Event Subscription
To delete an event subscription:

1. Click Configuration Tasks → Events → Subscriptions in the PAM tree. The event
subscription configuration page opens.

2. Select the required event subscription in the event subscription table.

3. Click Delete in the toolbar. The Delete Subscription dialog box opens.

4. Click OK to confirm the deletion of the selected event subscription.
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Understanding Event Message Filtering Criteria
The set of predefined filters supplied with PAM software covers everyday event messaging
requirements. However, a comprehensive filtering system allows you to finely tune event
messaging criteria, if required.

Before creating a new event filter, you should get to know filtering criteria options.

1. Click Configuration Tasks → Events →  Filters in the PAM tree. The filter configuration
page opens with the list of existing event message filters.

2. Click New to display the Standard Filter page.

Figure 149. Event message standard filtering criteria chart
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3. Click Advanced to display the Advanced Filter page.

Figure 150. Event message advanced filtering criteria chart

4. Carefully analyze Tables 52 and 53 to understand the various options.
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Standard Event Message Filtering Criteria

Criteria Description

S (Select) All the checkboxes in this column are selected by default. When an
event message S checkbox is deselected, the event message is re-
moved from the filter.

Actions

– Select the S checkbox if you want to include the event message
in the new filter.

– Deselect the S checkbox if you do not want to include the event
message in the new filter.

Message/Identifier Gives a message description and provides a clickable link to the as-
sociated help messages.

Actions

– Toggle the Message/Identifier column by clicking Message or
Identifier in the toolbar.

– Double click the required message. The corresponding help
message opens.

Ack (Acknowledge) This column is only applicable to messages sent to the PAM Web
interface and is interactive with the Duration column (see below). All
the checkboxes in this column are selected by default. When the
message Ack checkbox is selected, the event message will be dis-
played in the event list until it is manually acknowledged by a user.

Note:
The PAM Web interface stores up to 150 event messages
maximum per user group (100 messages by default). Once this
limit has been reached, messages may be deleted in order of
arrival, even if they have not been acknowledged.

Actions

– Select the Ack checkbox if you want the event message to be
displayed until it is manually acknowledged by a user.

– Deselect the Ack checkbox if you want the event message to be
deleted automatically after a specified period of time. The
Duration dialog box opens (see below).
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Criteria Description

Duration This column is only applicable to messages sent to the PAM Web
interface and is interactive with the Ack column (see above). When
the specified duration expires, the event message is deleted auto-
matically.

Note:
The PAM Web interface stores up to 150 event messages
maximum per user group (100 by default). Once this limit has
been reached, messages may be deleted in order of arrival, even
if the set duration has not expired.

Actions

– Double click the Duration cell to open the Message Display
Duration dialog box.

– Select the Display message until acknowledged checkbox if
you want to manually acknowledge the message before it is
removed from the display and click OK to apply.

– Enter a value in the Duration field and use the drop–down
menu to select the duration unit: seconds, minutes, hours, or
days.

– The Apply to this message only  radio button is selected by
default. If required, select another radio button to apply the
duration setting to other messages included in the filter.

– Click OK to set the duration. The new duration value is
displayed in the Duration cell and the Ack checkbox is
deselected (see above).
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Criteria Description

Severity Level This column is used to set message severity level(s): Information,
Success, Warning, and Error. At least one severity level must be
selected to define the filter.

Actions

– Double click the Severity cell to open the dialog box.

– All severity levels are selected by default. Deselect the required
checkbox to remove a severity level from the filter.

– Select the Apply to all messages checkbox to apply this
severity level to all the messages included in the filter.

– Click OK to set and apply the severity level. The new severity
level is displayed in the corresponding Severity cell.

Table 52. Standard event message filtering criteria
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Advanced Event Message Filtering Criteria

 Note:
Advanced filtering criteria are reserved for advanced users and are to be used with care.

Criteria Description

Thresholding Thresholding is defined on a Count / Period basis aimed at routing
significant messages only. Identical messages are counted and
when the number of messages indicated in the Threshold Count
field is reached within the period of time indicated in the Threshold
Period field, this message is selected for routing.

Actions

– Double click the Threshold cell to open the dialog box.

– Select the Threshold Inactive radio button to deactivate
thresholding.

– Select the Apply to all messages checkbox to deactivate the
thresholding setting on all the messages included in the filter.

– Select the Threshold Active radio button to activate
thresholding.

– Enter the required number of messages in the Threshold
Count field, the required period of time in the Threshold Period
field, and use the drop–down menu to select the time unit:
seconds, minutes, hours, or days.

– Select the corresponding radio button to apply thresholding
settings to one or more messages included in the filter.
Note:
The Apply to this message only radio button is selected by
default.

– Click OK to set thresholding. The new Threshold Count and
Threshold Period settings are displayed in the Threshold cell.
Note:
Inactive is displayed in the Threshold cell when thresholding is
deactivated.
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Criteria Description

Clipping Clipping is defined on a Count / Period basis aimed at routing a pre–
defined number of messages only. Identical messages are counted
and when the number of messages indicated in the Clipping Count
field is reached within the period of time indicated in the Clipping
Period field, no other messages will be selected for routing.

Actions

– Double click the Clipping cell to open the dialog box.

– Select the Clipping Inactive radio button to deactivate clipping.

– Select the Apply to all messages checkbox to deactivate the
thresholding setting on all the messages included in the filter.

– Select the Clipping Active radio button to activate clipping.

– Enter the required number of messages in the Clipping Count
field, the required period of time in the Clipping Period field,
and use the drop–down menu to select the time unit: seconds,
minutes, hours, or days.

– Select the corresponding radio button to apply clipping settings
to one or more messages included in the filter.
Note:
The Apply to this message only radio button is checked by
default.

– Click OK to set clipping. The new Clipping Count and Clipping
Period settings are displayed in the Clipping cell.
Note:
Inactive is displayed in the Clipping cell when clipping is
deactivated.
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Criteria Description

Source Each event message refers to a source (the component that gener-
ated the message) and a target (the component referred to in the
message) (see below). This feature allows messages to be filtered
according to one or more Source string(s) and is particularly useful
for debugging and troubleshooting.

Actions

– Double click the Source cell to open the dialog box.

– Select a source filter from the Event Sources list.

– If the list is empty, enter a source string in the Source filter field
and click Add. The new source filter is displayed in the Event
Sources list. (Example source strings can be viewed in history
files).

– Click Remove or Remove All to remove one or more source
strings from the Event Sources list.

– Repeat for each source string to be included in the filter.

– Click Apply list to all messages to apply the specified source
list to all the messages included in the filter.

– Click OK to apply the source list. Specified is displayed in the
Source cell.
Note:
All is displayed in the Source cell if the source is not specified.



5-108 User’s Guide

Criteria Description

Target Each event message refers to a target (the component referred to in
the message) and a source (the component that generated the mes-
sage) (see above). This feature allows messages to be filtered ac-
cording to one or more Target string(s) and is particularly useful for
debugging and troubleshooting.

Actions

– Double click the Target cell to open the dialog box.

– Select a target filter from the Event Targets list.

– If the list is empty, enter a target string in the Target filter field
and click Add. The new target filter is displayed in the Event
Targets list. (Example target strings can be viewed in history
files).

– Click Remove or Remove All to remove one or more target
strings from the Event Targets list.

– Repeat for each target string to be included in the filter.

– Click Apply list to all messages to apply the specified target
list to all the messages included in the filter.

– Click OK to apply the target list. Specified is displayed in the
Target cell.
Note:
All is displayed in the Target cell if the target is not specified.
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Criteria Description

Keyword This feature allows messages to be filtered according to a Keyword
contained in the messages. Any relevant word(s) contained in
source / target strings can be used.

Actions

– Double click the Keywords cell to open the dialog box.

– Select a keyword filter from the Event Keywords list.

– If the list is empty, enter a keyword in the Keyword filter field
and click Add. The new keyword filter is displayed in the Event
Keywords list. (Example keywords can be viewed in history
files).

– Click Remove or Remove All to remove one or more keyword
from the Event Keywords list.

– Repeat for each keyword to be included in the filter.

– Click Apply list to all messages to apply the specified keyword
list to all the messages included in the filter.

– Click OK to apply the keyword list. Specified is displayed in the
Keyword cell.
Note:
All is displayed in the Keywords cell if the keyword is not
specified.

Table 53. Advanced event message filtering criteria
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Preselecting, Creating, Editing, Deleting an Event Filter
An event filter must be selected for all event subscriptions. The event messaging system is
delivered with a set of predefined filters.

Preselecting an Event Filter
Before proceeding to set up an event subscription, you are advised to check which
predefined filter is adapted to your needs:

1. Click Configuration Tasks → Events → Filters in the PAM tree. The filter configuration
page opens.

Figure 151. Filters configuration page

2. Check that the required filter is present.

You may also define a specific filter by using the comprehensive event message filtering
utility. See Creating an Event Filter, on page 5-111.
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Creating an Event Filter
Once you have established which filtering criteria you want to apply to your new filter, you
can proceed to create a new event filter:

1. Click Configuration Tasks → Events →  Filters in the PAM tree. The filter configuration
page opens with the list of existing event message filters.

2. Click New to display the Create a New Event Filter page. The standard event message
filtering criteria table is displayed.

Figure 152. New Filter configuration page – standard event message filtering criteria table

3. Enter a relevant name in the Filter Name field and a brief description, if required, in the
Description field.

 Note:
For further details about event filtering criteria and options, see Standard Event Filtering
Criteria, on page 5-102 and Advanced Event Filtering Criteria, on page 5-105.

4. Deselect the S checkbox for the event messages not to be included in the filter.

5. If the filter is to be used to send messages to the PAM Web interface, select the Ack
checkbox if you want the event message to be manually acknowledged by a user; or
deselect the Ack checkbox to enter a display value in the Duration cell.

6. Double click the Severity cell to select the message severity level.
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7. If required, click Advanced to access advanced filtering criteria. The advanced event
message filtering criteria chart is displayed.

Figure 153. New Filter configuration page – advanced event message filtering criteria table

8. When you have finished configuring your event filter, click Create.

9. Repeat steps 3 to 8 for each new event filter you want to create.

10.Click Close to save changes. The new filter appears in the Filters list.

Editing Event Filter Attributes
1. Click Configuration Tasks → Events →  Filters in the PAM tree. The filter configuration

page opens with the list of existing event message filters. See Figure 152 above.

2. Select the required filter from the event message filter list.

3. Click Edit in the toolbar to modify filter attributes.

4. Click OK to save changes.

Deleting an Event Filter

  Important: 
Before deleting an event filter, all the event subscriptions using that filter must either
be modified to use another filter, or deleted.

1. Click Configuration Tasks → Events →  Filters in the PAM tree. The filter configuration
page opens with the list of existing event message filters. See Figure 151 above.

2. Select the required filter from the event message filter list.

3. Click Delete in the toolbar.

4. Click OK to confirm the deletion of the selected event filter.
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Appendix A.  Specifications

• NovaScale 5085 server specifications, on page A-2

• NovaScale 5165 server specifications, on page A-4

• NovaScale 6085 server specifications, on page A-6

• NovaScale 6165 server specifications, on page A-8
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NovaScale 5085 Server Specifications
NovaScale 5085 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

40U Cabinet Dimensions / Weight

Unpacked Packed

Height: 195.5 cm (77.0 in) Height:  200 cm (78.7 in)Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Height:  200 cm (78.7 in)

Width:   80 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.):  943 kg (2079 lb)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.01 in)

Weight (max.):  973 kg (2145 lb)Weight (max.):  943 kg (2079 lb) Weight (max.):  973 kg (2145 lb)

19U Cabinet Dimensions / Weight

Unpacked Packed

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

Depth: 140.0 cm (55.1 in)

Weight (max.):  508 kg (1120 lb)

Service Clearance

Front 150 cmFront

Rear

150 cm

100 cmRear

Side (free side)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)Max. wet bulb temperature

Moisture  content

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h
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Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels

Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 par PDU

3 x AWG10

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power:
PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 54. NovaScale 5085 Server specifications
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NovaScale 5165 Server Specifications
The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

40U Cabinet Dimensions / Weight

Unpacked Packed

Height: 192 cm (75.1 in) Height: 202 cm (79.5 in)Height: 192 cm (75.1 in)

Width:   60 cm (23.6 in)

Depth:  128 cm (50.4 in)

Height: 202 cm (79.5 in)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.1 in)

Width:   60 cm (23.6 in)

Depth:  128 cm (50.4 in)

Weight: 590 kg (1300 lb)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.1 in)

Weight: 630 kg (1390 lb)Weight: 590 kg (1300 lb) Weight: 630 kg (1390 lb)

19U Cabinet Dimensions / Weight

Unpacked Packed

Height: 101 cm (39.8 in)

Width:   60 cm (23.6 in)

Height: 110 cm (43.3 in)

Width:   80 cm (31.5 in)Width:   60 cm (23.6 in)

Depth:  128 cm (50.4 in)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.1 in)Depth:  128 cm (50.4 in)

Weight: 390 kg (440 lb)

Depth:  140 cm (55.1 in)

Weight: 420 kg (507 lb)

Service Clearance

Front 150 cmFront

Rear

150 cm

100 cmRear

Side (free side)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)Max. wet bulb temperature

Moisture  content

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle
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Lw(A) 6.3 Bels Lw(A) 6.1 Bels

Power Cables

AC (20A)

Cable type

Connector type

1 per PDU

3 x 4mm� / AWG # 12 (US)

C22 Appliance Coupler

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power CSS module
Maximum inrush current

Mains power PDU

20A Curve C
210A / per quarter period

20A Curve C

Maximum inrush current

Mains power PDU
Maximum inrush current

210A / per quarter period

20A Curve C
210A / per quarter period

Table 55. NovaScale 5165 Server specifications
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NovaScale 6085 Server Specifications
NovaScale 6085 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

40U Cabinet Dimensions / Weight

Unpacked Packed

Height: 195.5 cm (77.0 in) Height:  200 cm (78.7 in)Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Height:  200 cm (78.7 in)

Width:   80 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.):  943 kg (2079 lb)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.01 in)

Weight (max.):  973 kg (2145 lb)Weight (max.):  943 kg (2079 lb) Weight (max.):  973 kg (2145 lb)

19U Cabinet Dimensions / Weight

Unpacked Packed

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

Depth: 140.0 cm (55.1 in)

Weight (max.):  508 kg (1120 lb)

Service Clearance

Front 150 cmFront

Rear

150 cm

100 cmRear

Side (free side)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)Max. wet bulb temperature

Moisture  content

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h
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Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels

Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 par PDU

3 x AWG10

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power:
PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 56. NovaScale 6085 Server specifications
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NovaScale 6165 Server Specifications
NovaScale 6165 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

40U Cabinet Dimensions / Weight

Unpacked Packed

Height: 195.5 cm (77.0 in) Height:  200 cm (78.7 in)Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Height:  200 cm (78.7 in)

Width:   80 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.):  943 kg (2079 lb)

Width:   80 cm (31.5 in)

Depth:  140 cm (55.01 in)

Weight (max.):  973 kg (2145 lb)Weight (max.):  943 kg (2079 lb) Weight (max.):  973 kg (2145 lb)

19U Cabinet Dimensions / Weight

Unpacked Packed

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

Depth: 140.0 cm (55.1 in)

Weight (max.):  508 kg (1120 lb)

Service Clearance

Front 150 cmFront

Rear

150 cm

100 cmRear

Side (free side)

100 cm

100 cm

Operating Limits

Dry bulb temperature range +15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)
Relative humidity (non–condensing)

° ° ° °
Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)Relative humidity (non–condensing)

Max. wet bulb temperature
35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)
Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+24°C   (+75.2°F)

0.019 kg water/kg dry air
Pressure / Elevation

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range +5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)Relative humidity (non–condensing)

Max. wet bulb temperature

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)Max. wet bulb temperature

Moisture  content

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range –35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

Relative humidity (non–condensing)

Gradient 25°C/h  (77°F/h)

5 to 95% 
Gradient 30%/h
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Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels

Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 par PDU

3 x AWG10

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
The PDU requires an extra cable length of 1.5 meters for connection inside the cabi-
net.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection

Mains power CSS module
Maximum inrush current

Mains power PDU
Maximum inrush current

20A Curve C
210A / per quarter period

20A Curve C
210A / per quarter period

Mains power:
PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 57. NovaScale 6165 Server specifications
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Appendix B. Cabling Diagrams

NovaScale 5085 Server

 Internal disk configuration, on page B-3.

 External Disk configuration, on page B-4:

SJ–0812 SCSI JBOD disk configuration, on page B-4.

SR–0812 SCSI RAID disk configuration, on page B-4.

Extension disk rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID), on page B-5.

FDA 1x00 FC disk configuration, on page B-5.

Extension disk rack (FDA 1x00 FC – FDA 1x00 FC), on page B-6.

 Power Cables, on page B-11.

NovaScale 6085 Server

 Internal disk configuration, on page B-7.

 External Disk configuration, on page B-8:

SJ–0812 SCSI JBOD disk configuration, on page B-8.

SR–0812 SCSI RAID disk configuration, on page B-8.

Extension disk rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID), on page B-9.

FC disk configuration, on page B-9.

Extension disk rack (FDA 1x00 FC – FDA 1x00 FC), on page B-10.

 Power Cables, on page B-11.

NovaScale 5165 Server

 Internal disk configuration, on page B-12.

 External Disk configuration, on page B-13:

SJ–0812 SCSI JBOD disk configuration, on page B-13.

SR–0812 SCSI RAID disk configuration, on page B-14.

Extension disk rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID), on page B-14.

FDA 1x00 FC disk configuration, on page B-15.

Extension disk rack (FDA 1x00 FC – FDA 1x00 FC), on page B-15.

 Power Cables, on page B-25.
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NovaScale 6165 Server

 Internal disk configuration, on page B-16.

 External Disk configuration, on page B-18:

SJ–0812 SCSI JBOD disk configuration, on page B-18.

SR–0812 SCSI RAID disk configuration, on page B-19.

Extension disk rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID), on page B-20.

FDA 1x00 FC disk configuration, on page B-21.

Extension disk rack (FDA 1x00 FC – FDA 1x00 FC), on page B-22.

FDA 2x00 FC disk configuration, on page B-23.

Extension disk rack (FDA 2x00 FC – FDA 1x00 FC), on page B-24.

 Power Cables, on page B-25.
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NovaScale 5085 Server Data Cabling Diagram

Internal Disk Configuration

Mark Cable Type From To

1 Video/PS2/PS2 cable KVM (video) Console (video)

2 PS2/USB converter KVM (USB) Console (PS2/PS2)

3 Combined PS2/VGA cable KVM Port 1 PAP (VGA/PS2)

4 Combined USB/VGA cable KVM Port 2 IOL (Video/USB)

6 RJ45 – RJ45 Ethernet cross
cable

PMB Ethernet PAP LAN Maint

7 USB cable Modem USB PAP USB

8
8

RJ45 – RJ45 Ethernet
RJ45 – RJ45 Ethernet (optional)

PAP Ethernet
IOL Ethernet

Enterprise LAN
Enterprise LAN

9 RJ11 – RJ11 cable Modem (Line) Telephone network socket

Figure 154. NovaScale 5085 Server data cabling diagram
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External Disk Configuration

SJ–0812 SCSI JBOD Disk Rack

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC0)

S/S Disk 1 
Extension port

Figure 155. SJ–0812 SCSI JBOD disk rack data cabling diagram

SR–0812 SCSI RAID Disk Rack

Mark Cable Type From To

8 DB9 to Jack cable (optional) Nport server S/S Disk (1) RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI
(IOC0)

S/S Disk (1) Host port

Figure 156. SR–0812 SCSI RAID disk rack data cabling diagram
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Extension Disk Rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI RAID
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 157. SJ–0812 SCSI JBOD extension disk rack data cabling diagram

Disk Rack (FDA 1x00 FC)

Mark Cable Type From To

6 RJ45 – RJ45 Ethernet cable S/S Disk Ethernet Hub port 6

7 LC–LC cable S/S Disk (CTL 0) FC Adapter (IOC 0)

8 DB9 to DB9 serial cable (optional) PAP COM 1 S/S Disk RS232

Figure 158. FDA 1x00 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 1x00 FC – FDA 1x00 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 159. FDA 1x00 FC – FDA 1x00 FC extension disk rack data cabling diagram
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NovaScale 6085 Server Data Cabling Diagram

Internal Disk Configuration

Mark Cable Type From To

1 Video/PS2/PS2 cable KVM (video) Console (video)

2 PS2/USB converter KVM (USB) Console (PS2/PS2)

3 Combined PS2/VGA cable KVM Port 1 PAP (VGA/PS2)

4 Combined USB/VGA cable KVM Port 2 IOL#0 (Video/USB)

5* Combined USB/VGA cable KVM Port 3 IOL#1 (Video/USB)

6 RJ45 – RJ45 Ethernet cross cable PMB Ethernet PAP LAN Maint

7 USB cable Modem USB PAP USB

8
8
8

RJ45 – RJ45 Ethernet
RJ45 – RJ45 Ethernet (optional)
RJ45 – RJ45 Ethernet (optional)

PAP Ethernet
IOL#0 Ethernet
IOL#1 Ethernet

Enterprise LAN
Enterprise LAN
Enterprise LAN

9 RJ11 – RJ11 cable Modem (Line) Telephone network
socket

Figure 160. NovaScale 6085 Server data cabling diagram
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External Disk Configuration

SJ–0812 SCSI JBOD Disk Rack

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC0)

S/S Disk 1 
Extension port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC1)

S/S Disk 2 
Extension port

Figure 161. SJ–0812 SCSI JBOD disk rack data cabling diagram

SR–0812 SCSI RAID Disk Rack

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable Nport Server Hub

2 RJ45 – RJ45 Ethernet cable Hub Ethernet port 7 PAP LAN Maint

8 DB9 to Jack cable (optional) Nport server S/S Disk (1) RS232

8 DB9 to Jack cable (optional) Nport server S/S Disk (2) RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI
(IOC0)

S/S Disk (1) Host port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI 
(IOC1)

S/S Disk  (2) Host port

Figure 162. SR–0812 SCSI RAID disk rack data cabling diagram
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Extension Disk Rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI RAID
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 163. SJ–0812 SCSI JBOD extension disk rack data cabling diagram

Disk Rack (FDA 1x00 FC)

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub port 1

2 LC–LC cable S/S Disk (CTL 0) FC Adapter (IOC 0)

3 LC–LC cable S/S Disk (CTL 1) FC Adapter (IOC 1)

6 RJ45 – RJ45 Ethernet cable S/S Disk Ethernet Hub port 6

8 DB9 to DB9 serial cable (optional) PAP COM 1 S/S Disk RS232

Figure 164. FDA 1x00 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 1x00 FC – FDA 1x00 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 165. FDA 1x00 FC – FDA 1x00 FC extension disk rack data cabling diagram
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Power Cabling Diagram
All power supply cables are connected to the internal PDU(s), as shown below:

Internal Disk configuration

Console Drawer

PAP Unit

KVM Switch

Mains

16A

16A

10A

10A

10A

10A
1

4

5

J4

J3

J1

J6

J5

J2

6

PDU

CSS Module

2

Mark Cable Type From To

1 Power cable Console PDU J6

2 Power cable KVM switch PDU J5

4 Power cable PAP Pwr PDU J3

5 – 6 Power cable CSS Module PDU J1, J2

SCSI or FC Disk configuration

Console Drawer

PAP Unit

KVM Switch

Mains

16A

16A

10A

10A

10A

10A
1

4

5

J4

J3

J1

J6

J5

J2

6

PDU

CSS Module

2

NPort Server

S/S Disk (SCSI or FC)

Power bar

S/S Disk (SCSI or FC)

3

Mark Cable Type From To

1 Power cable Power bar (console,  
KVM switch, NPort server)

PDU J6

2 – 3 Power cable S/S disk (SCSI or FC) PDU J5, J4

4 Power cable PAP Pwr PDU J3

5 – 6 Power cable CSS Module PDU J1, J2

Figure 166. NovaScale 5085 Server / NovaScale 6085 Server power cabling diagram
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NovaScale 5165 Server Data Cabling Diagrams

Internal Disk Configuration



B-13Server Cabling

Mark Cable Type From To

1 video/PS2/PS2 cable Console KVM switch

2 USB cable PAP USB Modem USB

3 RJ11 – RJ11 cable Modem (Line) Telephone 
network socket

5 RJ45 – RJ45 Ethernet cable PAP (VGA and PS2)
via AVRIQ (4)

KVM Port 1

7 RJ45/RJ45 cable IOL Module 0
VGA and USB
via AVRIQ (6)

KVM Port 3

11 RJ45/RJ45 cable IOL Module 1
VGA and USB
via AVRIQ (10)

KVM Port 5

14
14

RJ45 – RJ45 Ethernet (optional)
RJ45 – RJ45 Ethernet (optional)

IOL Module 0 Ethernet
IOL Module 1 Ethernet

Enterprise LAN
Enterprise LAN

15 RJ45/RJ45 cable KVM (LAN) Enterprise LAN

16 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub Ether Port 1

17 RJ45 – RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

18 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 1 Hub port 3

19 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 0 Hub port 2

Figure 167. NovaScale 5165 Server  data cabling diagram

External Disk Configuration

SJ–0812 SCSI JBOD Disk Rack

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC 0 Module 0)

S/S Disk 1 
Extension port

Figure 168. SJ–0812 SCSI JBOD disk rack data cabling diagram
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SR–0812 SCSI RAID Disk Rack

Mark Cable Type From To

8 DB9 to Jack cable (optional) Nport server S/S Disk (1) RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI
(IOC0 Module 0)

S/S Disk (1) Host port

Figure 169. SR–0812 SCSI RAID disk rack data cabling diagram

Extension Disk Rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI RAID
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 170. SJ–0812 SCSI JBOD extension disk rack data cabling diagram
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Disk Rack (FDA 1x00 FC)

Mark Cable Type From To

6 RJ45 – RJ45 Ethernet cable S/S Disk Ethernet Hub port 6

7 LC–LC cable S/S Disk (CTL 0) FC Adapter 
(IOC 0 Module 0)

8 DB9 to DB9 serial cable (optional) PAP COM 1 S/S Disk RS232

Figure 171. FDA 1x00 FC disk rack data cabling diagram

Extension Disk Rack (FDA 1x00 FC – FDA 1x00 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 172. FDA 1x00 FC – FDA 1x00 FC extension disk rack data cabling diagram
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NovaScale 6165 Server Data Cabling Diagrams

Internal Disk Configuration
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Mark Cable Type From To

1 video/PS2/PS2 cable Console KVM switch

2 USB cable PAP USB Modem USB

3 RJ11 – RJ11 cable Modem (Line) Telephone 
network socket

5 RJ45 – RJ45 Ethernet cable PAP (VGA and PS2)
via AVRIQ (4)

KVM Port 1

7 RJ45/RJ45 cable IOL #0 Module 0
VGA and USB
via AVRIQ (6)

KVM Port 3

9 RJ45/RJ45 cable IOL #1  Module 0
VGA and USB
via AVRIQ (8)

KVM Port 4

11 RJ45/RJ45 cable IOL #0 Module 1
VGA and USB
via AVRIQ (10)

KVM Port 5

13 RJ45/RJ45 cable IOL #1  Module 1
VGA and USB
via AVRIQ (12)

KVM Port 6

14
14
14
14

RJ45 – RJ45 Ethernet (optional)
RJ45 – RJ45 Ethernet (optional)
RJ45 – RJ45 Ethernet (optional)
RJ45 – RJ45 Ethernet (optional)

IOL0 Module 0 Ethernet
IOL1 Module 0 Ethernet
IOL0 Module 1 Ethernet
IOL1 Module 1 Ethernet

Enterprise LAN
Enterprise LAN
Enterprise LAN
Enterprise LAN

15 RJ45/RJ45 cable KVM (LAN) Enterprise LAN

16 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub Ethernet

17 RJ45 – RJ45 Ethernet cable PAP LAN Enter Enterprise LAN

18 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 1 Hub port 3

19 RJ45 – RJ45 Ethernet cable PMB Ethernet Module 0 Hub port 2

Figure 173. NovaScale 6165 Server data cabling diagram
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External Disk Configuration

SJ–0812 SCSI JBOD Disk Rack

Mark Cable Type From To

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC0)

S/S Disk 1 
Extension port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI RAID
(IOC1)

S/S Disk 2 
Extension port

Figure 174. SJ–0812 SCSI JBOD disk rack data cabling diagram
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SR–0812 SCSI RAID Disk Rack

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable Nport Server (Module 0) Hub

1* RJ45 – RJ45 Ethernet cable Nport Server (Module 1) Hub

2 RJ45 – RJ45 Ethernet cable Hub Ethernet port 7 PAP LAN Maint

8 DB9 to Jack cable (optional) Nport server S/S Disk 1 RS232

8 DB9 to Jack cable (optional) Nport server S/S Disk 2 RS232

8 DB9 to Jack cable (optional) Nport server S/S Disk 3 RS232

8 DB9 to Jack cable (optional) Nport server S/S Disk 4 RS232

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI 
(IOC 0 Module 0)

S/S Disk 1 Host port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI 
(IOC 1 Module 0)

S/S Disk 2 Host port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI 
(IOC 0 Module1)

S/S Disk 3 Host port

9 SCSI–3 68–pin 
VHDCI to VHDCI cable

HBA SCSI 
(IOC 1 Module 1)

S/S Disk 4 Host port

Figure 175. SR–0812 SCSI RAID disk rack data cabling diagram
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Extension Disk Rack (SJ–0812 SCSI JBOD – SR–0812 SCSI RAID)

Mark Cable Type From To

a9 SCSI–3 68–pin 
VHDCI to VHDCI cable

SR–0812 SCSI
RAID 
extension port

SJ–0812 SCSI JBOD 
extension port

Figure 176. SJ–0812 SCSI JBOD extension disk rack data cabling diagram
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Disk Rack (FDA 1x00 FC)

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub port 1

2 LC–LC cable S/S Disk (CTL 0) FC Adapter 
IOC 0 Module 0

3 LC–LC cable S/S Disk (CTL 1) FC Adapter 
IOC 1 Module 0

4 LC–LC cable S/S Disk (CTL 0) FC Adapter 
IOC 0 Module 1

5 LC–LC cable S/S Disk (CTL 1) FC Adapter 
IOC 1 Module 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 3

7 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 2

8 DB9 to DB9 serial cable (optional) PAP COM 1 S/S Disk RS232

Figure 177. FDA 1x00 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 1x00 FC – FDA 1x00 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 178. FDA 1x00 FC – FDA 1x00 FC extension disk rack data cabling diagram
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Disk Rack (FDA 2x00 FC)

Mark Cable Type From To

1 RJ45 – RJ45 Ethernet cable PAP Ethernet Hub port 1

2 LC–LC cable S/S Disk (CTL0–HF0) FC Adapter IOB 0 Module 0

3 LC–LC cable S/S Disk (CTL0–HF1) FC Adapter IOB 1 Module 0

4 LC–LC cable S/S Disk (CTL1–HF0) FC Adapter IOB 0 Module 1

5 LC–LC cable S/S Disk (CTL1–HF1) FC Adapter IOB 1 Module 1

6 RJ45 – RJ45 Ethernet cable S/S Disk Hub port 6

8 * DB9 to DB9 serial cable 
(optional)

PAP COM 1 S/S Disk RS232

* optional cable used to configure the S/S disk.

Figure 179. FDA 2x00 FC disk rack data cabling diagram
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Extension Disk Rack (FDA 2x00 FC – FDA 1x00 FC)

Mark Cable Type From To

1 HSSDC–HSSDC cable S/S Disk S/S Disk Extension

2 DE diagnosis cable S/S Disk S/S Disk Extension

Figure 180. FDA 2x00 FC – FDA 1x00 FC extension data cabling diagram
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Power Cabling Diagram

Internal Disk configuration

Console
Drawer

PAP UnitKVM Switch

Mains

16A

16A

10A

10A

10A

10A

1 4

7

J4

J3

J1

J6

J5

J2
6

PDU–1

CSS Module 0

2

16A

16A

10A

10A

10A

10A

J4

J3

J1

J6

J5

J2

Mains

PDU–2

CSS Module 1

5

6

NPort Server

Hub
3

7

Mark Cable Type From To

1 Power cable Console PDU–1 J4

2 Power cable KVM switch PDU–1 J3

3 Power cable Hub PDU–2 J5

4 Power cable NPort server PDU–2 J4

5 Power cable PAP Pwr PDU–2 J3

6 Power cable CSS Module 1 PDU–1 & 2 J2

7 Power cable CSS Module 0 PDU–1 & 2 J1
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SCSI or FC Disk configuration

Console
Drawer

PAP Unit KVM Switch

Mains

16A

16A

10A

10A

10A

10A
1

4

7

J4

J3

J1

J6

J5

J2
6

PDU–1

CSS Module 0

2

16A

16A

10A

10A

10A

10A

J4

J3

J1

J6

J5

J2

Mains

PDU–2

CSS Module 1

5

6

NPort Server

Hub

3

7

Disk SCSI or FC Disk SCSI or FC

Disk SCSI Disk SCSI 

Power bar

3

3 3

Mark Cable Type From To

1 Power cable Power bar 
(Hub, NPort server)

PDU–1 J6

2 Power cable PAP Pwr PDU–1 J5

3 Power cable S/S disk (SCSI or FC) PDU–1 & 2 J3, J4

4 Power cable KVM switch PDU J5

5 Power cable Console drawer PDU–2  J6

6 Power cable CSS Module 1 PDU–1 & 2 J2

7 Power cable CSS Module 0 PDU–1 & 2 J1

Figure 181. NovaScale 5165 Server / NovaScale 6165 Server power cabling diagram
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Appendix C. Error Messages and Recovery Information

 BIOS POST codes, on page C-1

 BIOS error messages, on page C-2

 PAM message list, on page C-36

BIOS POST Codes
During initialization, POST codes are generated by the BIOS for each QBB in the
configuration. These POST codes may be used for troubleshooting purposes.

Bull NovaScale Server POST codes can be viewed by clicking BIOS Info in the PAM
Domain Manager and are organized as follows:

Code Range POST Code Module Page

0x8F80 to 0x8FFF SAL–A C-3

0xDEAD0100 to 0xDEAD3300 SAL–A Hang C-7

0x87D0 to 0x87FF SAL–B C-9

0x07D0 to 0x07FF SAL–B Hang C-11

0x87B0 to 0x87BF SAL–F C-12

0x07B0 to 0x07BF SAL–F Hang C-13

0x00D0 to 0x0000 IA32 C-14

0x??2A to 0x??92 DIM Checkpoints C-24

0x052A0000 to 0x8A2A0 PCI Diagnostic C-25

0x50XX to 0x5FXX EFI C-26

0x4000 to 0x4FFF ACPI C-26

0xAA00 to 0xAAFF Recovery C-27

0xAF00 to 0xAFFF Runtime C-29

0xA000 to 0xA0FF PAM BIOS commands C-30

Table 58. BIOS POST code organization

 Note:
POST codes are listed in chronological order.
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BIOS Error Messages
Error messages are generated by the BIOS when errors are detected during initialization.

Bull NovaScale Server error messages can be viewed from the Windows or Linux operating
system and are organized as follows:

Error Messages Page

Boot Error Messages C-33

Storage Device Error Messages C-33

System Configuration Error Messages C-34

CMOS Error Messages C-35

Miscellaneous Error Messages C-35

Table 59. BIOS error message organization
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SAL–A POST Codes

 Note:
In this document, Post Codes are presented in chronological order.

 POST Codes Meaning

0x8FED Initialize base memory

0x8FEC Levelization OK

0x8FEE Enable SNC ports. Program SNC static registers

0x8FEA System BSP election (case with SPS)

0x8FD7 (1) Looks for PEloader (case without SPS)

0x8FD7 (2) Looks for PEloader (case with SPS)

0x8FCE (1) Start programming SIOH (case without SPS)

0x8FCE (2) Start programming SPS, SIOH (case with SPS)

0x8FAE (1) End programming SIOH (case without SPS)

0x8FAE (2) End programming SPS, SIOH (case with SPS)

0x8FAD Execute Autoscan

0x8FAB Initialize ICH2

0x8FAA Initialize SIO. Program refresh for fixed delay

Table 60. SAL–A POST codes (before release B600)

POST Codes Meaning

0x8FFF Node BSP has been selected

0x8FFD CVDR/CVCR Programming: a work in progress

0x8FFB Reset system after CVDR/CVCR programming

0x8FF9 Reset failed after CVDR/CVCR programming

0x8FF7 SNC minimum programming stepping independant

0x8FF5 SNC minimum programming stepping dependant

0x8FF3 FSS (SPS) only: enable SNC scalability ports SP0, SP1

0x8FF2 SNC Set Default SP in SNC_INCO register

0x8FEF Enter into memory levelization

0x8FE0 Exit  from memory levelization

0x8FDF Initialize temporary backing store and memory stack

0x8FDE Load IVT into memory, Programm IVA

0x8FDD SPS only: serialize access thru code running in RAM

0x8FDC SNC Initialization complete

0x8FDB Search North Firmware Standard Fit for mandatory modules

0x8FDA Search North Firmware Extented Fit for mandatory modules
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POST Codes Meaning

0x8FD9 Check if all mandatory modules are available in North Firmware

0x8FD8 Search for the SAL_A extension written in ”C” (autoscan)

0x8FD7 Load the SAL_A ”C” extension into memory

0x8FCF Enter into SAL–A ”C” extension

0x8FCE Scan for devices behind SNC scalability ports

0x8FCD ISPS Path: Initialize CBC registers, NID_DEF registers, Scan SPS SP

ports

0x8FCC Start of processing for SPS  based platforms

0x8FCB SPS Path: Search for SNC and SIOH devices

0x8FCA SPS Path, SBSP: Initialize REM_CDEFs, SYS_CFGx, SP_OVERx regis-
ters (SPS); SPC registers (SNC)

0x8FC9 SPS Path, SBSP: Setup for IOs (SIOH regs, Iohmap regs, CbPort regs,
PSeg regs)

0x8FC8 SPS Path, SBSP: Initialize IO structure; Run Autoscan algorithm

0x8FC7 Start of processing for BSPS Based platforms

0x8FC6 BSPS Path: Search for BSPS, SNC and SIOH devices

0x8FC5 BSPS Path, SBSP: Disable unused scalability ports on BSPS device;
Initialize SNC SPC regs

0x8FC4 BSPS Path, SBSP: Setup for IOs (SIOH regs, CBPort regs, VGAPort regs,
PSeg regs)

0x8FC3 BSPS Path: Initialize IO structure; Run Autoscan algorithm

0x8FC2 Start of processing for SIOH based platforms

0x8FC1 SIOH Path: Initialize IO structure, Run Autoscan algorithm

0x8FC0 Exit  from SAL–A ”C” extension

0x8FBF Any BSP, SPS: Set Synchronization Point SYNCSPS_C_Ext_Done

0x8FBE Node   BSP,  SPS: Wait until Synchronization Point
SYNCSPS_C_Ext_Done is cleared

0x8FBD System BSP, SPS: Wait until all nodes reach Synchronization Point
SYNCSPS_C_Ext_Done

0x8FBC System BSP, SPS: Program all SNC MIR/MIT registers

0x8FBB System BSP, SPS: Program all SPS MIR registers

0x8FBA System BSP, SPS: Build memory map

0x8FB9 System BSP, SPS: Flush caches

0x8FB8 System BSP, SPS: Release all nodes from Synchronization Point
SYNCSPS_C_Ext_Done

0x8FB7 Node BSP, BSPS: Program all SNC MIR/MIT registers

0x8FB6 Node BSP, BSPS: build memory map

0x8FB5 Node BSP, BSPS: Flush caches
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POST Codes Meaning

0x8FB4 Node   BSP, BSPS: Set Synchronization Point SYNCMap_870 (in SNC
SPAD register)

0x8FB3 System BSP, BSPS: Wait for NBSPs to reach Synchronization Point
SYNCMap_870

0x8FB2 System BSP, BSPS: Initialize snoop filters on BSPS

0x8FB1 System BSP, BSPS: Wait for ”other” SBSP to fulfil its duties

0x8FAF System BSP, BSPS: Select Super–System–BSP (SSBSP)

0x8FAE Super SBSP, BSPS: Search devices (SNCs, SIOHs, BSPSs)

0x8FAD SBSP, BSPS: Init CBport and VGAport on all BSPS devices

0x8FAC Super SBSP, BSPS: Initialize FLOOR/CEILING registers on all BSPS
devices

0x8FAB Super SBSP, BSPS: Update Memory map with data belonging to other
nodes

0x8FAA Super SBSP, BSPS: Flush caches

0x8FA9 Super SBSP, BSPS: Release all nodes from Synchronization Point
SYNCMap_870

0x8FA8 Node   BSP, BSPS: Wait until Synchronization Point SYNCMap_870
clears to zero

0x8FA7 Super SBSP, both: Build Dimm slot table (behind memory map)

0x8FA6 Reload IVT into memory

0x8FA5 Re–initialize r_bus_dev_snc, r_bus_dev_sncx, r_bus_dev_sps,
r_bus_dev_sioh CPU regs

0x8FA4 Common code path for NAPS (procs that did not became NBSP), SAPS
(NBSPs that did not became SBSP)

0x8FA3 SAPS check north fw version to south fw version

0x8F9F Minimum initialization for ICH2/ICH4 chips

0x8F9E Minimum initialization for LPC 47B27X chip (Super IO)
Minimum initialization for 21555 Non–Transparent PCI–to–PCI Bridge

0x8F9D Update health into memory, Set global memory available flag in SNC
SPAD register

0x8F9C SBSP checks north fw version to south fw version

0x8F9B Check if recovery needed because of north/south fw mismatch

0x8F9A Check if recovery forced by OEM recovery switch

0x8F99 Check if recovery jumper set on FW hub

0x8F98 Check if recovery requested thru <ctrl><home> key combination on PS2
keyboard (not used on FAME)

0x8F97 Prepare for recovery (Set flags and clean–up)

0x8F96 Go to firmware recovery

0x8F95 Return to PAL
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POST Codes Meaning

0x8F94 Reset Path: Wait for all processors (hopefully)

0x8F93 Path: Set Recovery and Rest bit in all SNC SPAD registers

0x8F92  Check if all SNCs are Bx steppings or higher

0x8F91 Program MMCFG register of all SNCs

0x8F90 BSP will reset By use of MMCFG interface

0x8F8F APs wait loop

0x8F8E Jump to same code in memory (BSP + APs)

0x8F8D Get data for APs, stored by BSP (BSP + APs)

0x8F8C Get Recovery module info (thru PELoader, BSP only)

0x8F8B Load Recovery module into memory (thru PELoader, BSP only)

0x8F8A Load FW North, South images into memory (thru recovery module exe-
cution, BSP only)

0x8F89 Validate FW North image (thru recovery module execution, BSP only)

0x8F88 Validate FW South image (thru recovery module execution, BSP only)

0x8F87 Enable writing into FW hubs (thru recovery module execution, BSP only)

0x8F86 Flash South firmware (thru recovery module execution, BSP only)

0x8F85 Flash North firmware (thru recovery module execution, BSP + APs)

0x8F84 Synchronize all processors, APs wait for reset

0x8F83 Disable writing into FW hubs (thru recovery module execution, BSP only)

0x8F82 Eject Media (thru recovery module execution, BSP only)

0x8F81 Generate system reset (BSP only)

0x8F80 Wait for system reset

Table 61. SAL–A POST codes (for releases B600 and later)
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SAL–A Hang POST Codes

POST Codes Meaning

0xDEAD0100 Unable to levelize local RAM

0xDEAD0200 Wrong chip under SNC (neither SPS, nor SIOH)

0xDEAD0300 PEL module not found, local firmware might be corrupted

0xDEAD0400 South Bridge Vendor ID is incorrect, expected ICH2 or ICH4

0xDEAD0500 Scalability Port 0 presence bit is not set

0xDEAD0600 Scalability Port 1 presence bit is not set

0xDEAD0700 Scalability Port 0 framing failed ( Idle Flits Ack. bit is not set )

0xDEAD0800 Scalability Port 1 framing failed ( Idle Flits Ack. bit is not set )

0xDEAD0900 Depending on the configuration:
– if configuration WITHOUT SPS: SIOH not accessible
– if configuration WITH SPS: SPS 1 Vendor ID is incorrect

0xDEAD0A00 SPS 1 Vendor ID is incorrect

0xDEAD0B00 No SIOH could be found

0xDEAD0C00 Master IOB / IOC not found, at least one IOB / IOC should have logical 
number 0

0xDEAD0D00 Mismatched SPS stepping, expected same stepping for both SPS chips

0xDEAD0E00 Non–transparent Bridge Vendor ID is incorrect, expected 21554 or 21555

0xDEADFF00 CVCR core–to–bus ratio is incorrect, expected 2:8, 2:9, or 2:10

0XDEAD3000 AUTOSCAN module not found, local firmware might be corrupted

0XDEAD3100 Unable to shadow AUTOSCAN module

0XDEAD3200 AUTOSCAN failed

0XDEAD3300 AUTOSCAN Memory Map has too many entries

Table 62. SAL–A hang POST codes (before release B600)

POST Codes Meaning

0xD000 Failure on SNC SP Checking

0xD001 No Framing on SNC SP0 (idle Flit Ack missing ...)

0xD002 No Framing on SNC SP1 (idle Flit Ack missing ...)

0xD003 No Framing on SNC SP0 and SP1 (idle Flit Ack missing ...)

0xD004 Master abort on SPINCO Read and chip is not a B–SPS

0xD005 Both Scalability ports disabled on SNC

0xD006 Unknown chip found behind SNC!

0xD100 Both Scalability Ports disabled on SNC

0xD101 Neither SIOH nor I–SPS or B–SPS found behind SNC

0xD102 No Firmware Hubs found on compatibility SIOH

0xD103 Autoscan returned an error on SPS based conf
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0xD104 Autoscan returned an error on B–SPS based conf.

0xD105 Autoscan returned an error on SIOH based conf.

0xD106 QBB number too large

0xD107 QBB number Multi–defined

0xD108 QBB Number not contiguous

0xD109 No SNC found in system

0xD10A No Master QBB defined

0xD10B IOB / IOC number too large

0xD10C IOB / IOC number Multi–defined

0xD10D No SIOH found in system

0xD10E No compatibility IOB / IOC defined

0xD10F IOBB Number not contiguous

0xD110 Mismatch at SBSP election

0xD111 Too many SNC  devices found (FAME A, B, C)

0xD112 Too many BSPS devices found (FAME B, C)

0xD113 Too many SIOH devices found (FAME A, B, C)

0xD114 Unknown device found on Bus 0xfe or 0xff (FAME B, C)

0xD115 Too many BSPS devices found (FAME B, C) 

0xD116 Too many SNC  devices found (FAME B, C) 

0xD117 QBB number too large

0xD118 QBB number Multi–defined

0xD119 Unknown device found on Bus 0xfe or 0xff (FAME A, B, C)

0xD11A Too many SIOH devices found (FAME B, C)

0xD11B IOB / IOC number too large

0xD11C IOB / IOC number Multi–defined

0xD11D QBB number not contiguous

0xD11E IOB / IOC number not contiguous

0xD11F Hub Interface Presence (Bit 8) not set in HLCTL0 of Master SIOH

0xD120 Disable Hub Interface (Bit 2) set in HLCTL0 of Master SIOH

0xD121 No ICH2/4 LPC Device found on Compatibility Bus

0xD122 Levelization did not find any usable memory on QBB

0xD200 Unexpected failure on SPS  Scalability Port (Bit i !=0 => Failure on Port i)

0xD300 Unexpected failure on SIOH Scalability Port (Bit i !=0 => Failure on Port i)

0xD400 Unexpected failure on BSPS Scalability Port (Bit i !=0 => Failure on Port i)

Table 63. SAL–A hang POST codes (for releases B600 and later)
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SAL–B POST Codes

POST Codes Meaning

0x87FF First check point. Initialize cr.iva/ar.eflag/ar.cflg/cr.lrr0/cr.lrr1/cr.ifa/cr.itir

0x87FE Initialize io_base address, CPU#, health, etc. for CPU’s. 
Initialize min_state_area for all CPUs
 (cpu_data_base+cpu_bspstore_base+cpu_health)
cpu_data_base points to min state save area. TOM below and above 4G.
Allocate sal_mp_info_table data and sal_efi stack area and legacy_stack
(temp).
Initialize legacy stack top and bottom for temporary use during POST only. 
INT_15, (FN# F788 in EM code) uses INT–8 timer tick for frequency cal-
culation.  (BSP+APs) Save ID, EID, Initialize BSPSTORE, SP.

0x87FD Search FIT for legacy BIOS.

0x87FC Search for legacy_nvm module (sal_legacy_nvm_module_1d).

0x87FB Search for efi_nvm module (sal_efi_nvm_module_1e).

0x87FA Search for acpi_dsdt module (sal_acpi_data_module_16).
Ask for Address, size, type.

0x87F9 Search for addition information acpi_dsdt module.
Ask for size, align, and scratch buff size.

0x87F8 Search for addition information acpi_dsdt module.
Initialize scratch buffer.

0x87F7 Reserve ACPI_64 and ACPI_32 data area.
Reserve MP table data area.
Save SAL data base & size.
SAL shadow top (PELoader + SAL_F).

0x87F6 Cache flush after PELoader shadow.

0x87F5 Search for information on SAL_F module (sal_f_module_12).
By size, align, and scratch buff size.

0x87F4 Search for addition information SAL_F module.
Initialize scratch buffer.

0x87F3 Cache flush after SAL shadowed.

0x87F2 Initialize SAL data top address
Physical equals to virtual for runtime use and above 4G
Load Call backs for byte/word checkpoint display entry and Address.
SAL PMI address 
EFI to SAL call back address 
SAL procedure address 
SAL SST base  and address
SAL procedure entry base inside SST
Build time address where SAL_PROC entry is stored
Build time GP 
Runtime GP 
SAL SST size.

0x87F1 Load PAL module.

0x87F0 BSP Shadow PAL module, initialize PAL shadow base, size, proc ptr initial-
ize PAL procedure address entry & checksum AP’s PAL PMI base will be
set.

0x87EF Cache flush after PAL shadow.
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POST Codes Meaning

0x87EE Find PAL shadow size + align through SAL call.

0x87ED Find # of CPU’s present in the system, # of CPU, # of IOAPIC.

0x87EC Search for addition information EFI module (sal_efi_module_15) size,
align, and scratch buff size. 
Initialize scratch buffer.

0x87EB Save maximum (PAL, EFI) shadow size and alignment.  
Save PAL (ia32)/EFI shadow top address, size, alignment.  
EFI module shadow base address (virtual/Physical), size, bottom address
(DATA+SAL+PAL+EFI).  
Update virtual address entries in translation register descriptor, addresses
in MDT/

0x87EA Cache flush shadow.

0x87E9 PAL call for memory Test for SELF–TEST (pal_mem_for_test_25).

0x87E8 PAL call for PAL test (pal_test_proc_102) and save results.

0x87E7 PAL Call for pal_bus_get_features function # (pal_bus_get_features_09).

0x87E6 Set buslock mask=1 (non–atomic)
By PAL Call PAL Bus Set Feature (pal_bus_set_features_0a).

0x87E5 Set PMI entry point
PAL Call (pal_pmi_entrypoint_20).

0x87E4 PAL Cache Summary by PAL Call (pal_cache_summary_04).

0x87E3 PAL Cache Information set. PAL Call cache_info_02.

0x87E2 pal_mc_register_mem_1b/find CPU min state pointer.
Should be able now to initialize health, bsp/ap, cache size line size, sapic
ver, and cpuid.  
Set minimal state save area, BSPSTORE and SP.

0x87E1 Cache flush shadow.

0x87E0 Program IVA, ITR(0) for PAL, SAL runtime code & data area cr.iva/cr.ifa/cr.i-
tir/itr[r0].

0x87DF Clear semaphore and wait for all CPUs to synchronize.

0x87DE Sort CPU health.  Already sorted for 2nd level BSP selection.  
Store BSP/AP flag for respective CPU.

0x87DD Setup for interrupt wakeup reinitialization of BSPSTORE and SP if needed.
Wait for interrupt wakeup.
The low order quartets indicate the CPUs of the board which have com-
pleted the initialization
– Quartet =1 if the CPU has completed its initialization
– Quartet =0 if  the CPU has not completed its initialization (for instance fail-
ure) or if it is CPU absent.

0x87DC Switch to virtual address Control register programming SET in PSR bn(44),
it(36), rt(27), dt(17), ic(13) .
Clear task priority register=cr.tpr.
Clear interruption function state register–cr.ifs.
Set legacy BIOS cs.base and ss.base.
Set es, ds, fs, gs=0 with 4G limit Legacy BIOS module (eip).
Give control at xxxx:e05b to IA–32 code.

Table 64. SAL–B POST codes
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SAL–B Hang POST Codes

POST Codes Meaning

0x07FD Then hang, if not found. See 0x87FD.
If found copy top 64K legacy boot block ROM at xxxx:0000.

0x07FC Then hang, if not found. See 0x87FC.
Else continue by saving in RAM.

0x07FB Then hang, if not found. See 0x87FB.
Else continue by saving in RAM.
Reserve 128k memory for NVM emulation.

0x07FA Then hang, if not found. See 0x87FA.
Else continue by saving in RAM.

0x07F9 Then hang, if not found. See 0x87F9.
Else continue by saving in RAM.

0x07F8 Then hang, if not found. See 0x87F8.
Else continue by saving in RAM.

0x07F6 Hang, on ERROR. See 0x87F6.

0x07F5 Then hang, if not found or Information ERROR. See 0x87F5.
SAL shadow bottom (PELoader + SAL_F).
Find SAL_F page size.
Align to next 32K boundary and save address and size.

0x07F4 Then hang, if not found. See 0x87F4.
Else continue by saving in RAM.

0x07F3 Hang on ERROR. See 0x87F3.

0x07F0 Hang on ERROR. See 0x87F0.

0x07EF Hang on ERROR. See 0x87EF.

0x07EE Hang on ERROR. See 0x87EE.

0x07ED Hang on ERROR. See 0x87ED.

0x07EC Hang if ERROR. See 0x87EC.

0x07EA Hang on ERROR. See 0x87EA.

0x07E9 Hang, if Memory ERROR. See 0x87E9.

0x07E8 Hang, if late self test ERROR. See 0x87E8.
NOTE: a build switch can skip this.

0x07E7 Hang if ERROR. See 0x87E7.

0x07E6 Hang if ERROR. See 0x87E6.

0x07E5 Hang if ERROR. See 0x87E5.

0x07E4 Hang if ERROR. See 0x87E4.

0x07E3 Hang, if ERROR. See 0x87E3.

0x07E1 Hang if ERROR. See 0x87E1

Table 65. SAL–B hang POST codes
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SAL–F POST Codes

POST Codes Meaning

0x87BF First check point. Checkpoint in v6b00_83_ip2x.  
Update EBDA entry inside SST 
Create EFI memory descriptor Update SST checksum.

0x87BE Check point near v6b00_83_5 
Search FIT for ACPI module (SAL_C_module_17) and get size, align,
scratch buff size.

0x87BD Load image by module type (sal_c_module_17).  Use PELoader.

0x87BC Load image by module type (sal_c_module_17).  Flush cache.

0x87BB Initialize memory manager (0x0) by call to SAL_C.

0x87BA Feed system information (0x1) with call to SAL_C.

0x87B9 Initialize MP table v1.4 (0x2) with call to SAL_C

0x87B8 Initialize IA–32 ACPI v1.1 (0x3) with call to SAL_C

0x87B7 Initialize IA64 ACPI v1.1 (0x4) with call to SAL_C

0x87B6 Initialize IA–32&IA64 ACPI v2.0 (0x5) with call to SAL_C

0x87B5 Clear scratch memory (0xFFF) with call to SAL_C

0x87B4 Search FIT for EFI module with call to PELoader.  
Get Size, align, and scratch buff size.

0x87B3 Load image by module type (sal_c_module_17).

0x87B2 Flush cache with PAL call.

0x87B1 Build EFI input parameter table.  
Get EFI stack, bspstore etc. with EFI call.

0x87B0 Build EFI input parameter table.  
Get EFI stack, bspstore etc. with EFI call.  
Store EFI stack, bspstore etc. with EFI call.  
Call EFI and that should be end.

Table 66. SAL–F POST codes
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SAL–F Hang POST Codes

POST Codes Meaning

0x07BE Hang if ERROR. See 0x87BE.

0x07BD Hang if not found.  Get entry point, and GP value. See 0x87BD.

0x07BC Hang on ERROR. Build MP & ACPI table. See 0x87BC.

0x07BB Hang on ERROR. See 0x87BB.

0x07BA Hang on ERROR. See 0x87BA.

0x07B9 Hang on ERROR. See 0x87B9.

0x07B8 Hang on ERROR. See 0x87B8.

0x07B7 Hang on ERROR. See 0x87B7.

0x07B6 Hang on ERROR. See 0x87B6.

0x07B5 Hang on ERROR. See 0x87B5.

0x07B4 Hang on ERROR. Get entry point, and GP value. See 0x87B4.

0x07B3 Hang on ERROR.  Get entry point, and GP value. See 0x87B3.

0x07B2 Hang on ERROR. See 0x87B2.

0x07B1 Hang on ERROR. See 0x87B1.

0x07B0 Hang on ERROR if OK come back from EFI. See 0x87B0.

Table 67. SAL–F Hang POST Codes
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IA–32 POST Codes

IA–32
 POST Codes

Meaning

0x00D0 Starting POINT control from SAL Set direction.
Create Stack.
Next checkpoint 0x00D5.

0x00D5 Get address and size of legacy BIOS.
Clear the BootBlock flag.
Next checkpoint 0x00D6.

0x00D6 Form the ROM image in memory.
Next checkpoint 0x00D7.

0x00D7 Search for compressed RUNTIME interface module.
If not found HANG checkpoint 0x00DE, else next checkpoint 0x00D8.

0x00D8 Decompress RUNTIME module to RAM segment.
If not found HANG checkpoint 0x00DE, else next checkpoint 0x00D9.

0x00D9 Copy uncompressed RUNTIME to F000 shadow RAM.
Copy E000 ROM segment to scratch RAM segment.
Copy scratch segment to E000 shadow RAM.
Next, Give control to shadow with far jump to F000:FFF0 for wake–up
(checkpoint 0x0003).

0x00DE Hang for fatal error.

Reset vector Check for hard or soft reset.
If hard reset => disable NMI, go to checkpoint 03h.
If soft reset => disable NMI, reset shutdown type to hard reset.
Initialize interrupt controller (8259) depending on shutdown type in CMOS.
Next, checkpoint 0x0003.

0x0003 Disable video.
Clear base 640K memory.
Enable F000 shadow RAM (ALWAYS Shadowed).
Start initialization of Runtime POST Setup (RPS) module header structure.
Go to checkpoint 0x0005.

0x0005 Disable USB host controller, disable all cache (CACHE is ALWAYS ON).
Next, checkpoint 0x0006.

0x0006 Copy code to lower RAM segment.
Copy old F000 ROM (ROM always at 4GB) to shadow RAM.
Initialize PMM structures for later data memory allocation.
Initialize SDSM (Setup Data Storage Manager) structure for allocating
CMOS to Setup.
Decompress POST module.  Finish initialization.
Fill in POST, runtime, and INT13 interface information into POST module
header.
Pass control to POST.
Initialize GPNV area.
Decompress Debug module if present.
Decompress DIM module.
Store Runtime, POST, and INT13 interfaces into RPS module header.
Uncompress INT10 module.
Copy DIM to shadow.
Next, checkpoint 0x0008.
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IA–32
 POST Codes

Meaning

0x0008 Check CMOS diagnostic byte to determine if battery power is OK and set
error flags if necessary.
Verify CMOS checksum manually by reading storage area, if not O.K. load
with power–on default values and clear password.
Clear CMOS pending interrupt. Initialize Status Registers A in CMOS.
Next, checkpoint 0x0007.

0x0007 Initialize the BIOS update data area (BUP), and update the communication
vector between BIOS and INT13.
Initialize RT_CMOS_BYTE. INITIALIZES INT13 interrupt service routine to
just return.  Next, checkpoint 0x000B.

0x000B Perform any necessary initialization before the keyboard controller BAT
command test. Next, checkpoint 0x000C.

0x000C The keyboard controller input buffer is free.
Next, issue BAT command and read result.
If bad 8042 then HALT! Next, checkpoint 0x000Eh.

0x000E The keyboard controller BAT command result has been verified.
Next, perform any necessary initialization after the keyboard controller BAT
command test. Next, checkpoint 0x000F.

0x000F Enable keyboard controller command byte, enable mouse if supported.
Next, checkpoint 0x0011

0x0011 Check if <Ins>, <Del>, or <End> key has been pressed, get POST informa-
tion.
Destroy CMOS checksum and set CMOS checksum error bit if indicated by
POST information.
Next, checkpoint 0x0012.

0x0012 Initialize CMOS and checksum with default values if END is pressed,
“Initialize CMOS in every boot” flag is set, or OEM method flag is set.
Disable #1 & #2 DMA controllers, disable #1 & #2 interrupt controllers, reset
video display EGA and monochrome devices.
Next, checkpoint 0x0013.

0x0013 Program chipset registers using POST tables, save good/bad cache status
to CMOS. Check for <Del> or OEM alternate key to enter setup. The DEL
key is also checked in the majority of the checkpoints from checkpoint 13h
to checkpoint 85h.
Initialize the chipset.
Next, checkpoint 0x0014.

0x0014 8254 PIT timer test on channel 2. The checking for the <Del> key press be-
tween here and checkpoint 27h.  Will determine if Setup is invoked at
checkpoint 0x0087 for legacy keyboards only.
USB keyboards are initialized than.
Next, checkpoint 0x0019.

0x0019 Initialize system timer and check refresh toggle. HALT! If refresh toggle er-
ror.
Next, checkpoint 0x001A.

0x001A Read and compare high/low timing for refresh toggle.  If not within accept-
able limits, HALT!  Clear parity status, if any.
Next, checkpoint 0x0023.
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IA–32
 POST Codes

Meaning

0x0023 Read the 8042 input port and save switch setting, check for green KBC, and
disable the keyboard controller password.
Performing any necessary configuration before initializing the interrupt vec-
tors.
Next, checkpoint 0x0024.

0x0024 Perform any OEM specific initialization before interrupt vector initialization.
Interrupt vector initialization is about to begin.
Next, checkpoint 0x0025.

0x0025 Initializes interrupt vector table.
Test for POST diagnostics, Clear passwords if POST flag is set.
Indicate 25 video rows and monochrome display in BIOS data area.
Next, checkpoint 0X0027.

0x0027 Enable USB function/clock in chipset if necessary and if configurable, ini-
tialize USB, and perform any necessary chipset or OEM initialization.
Next, checkpoint 0x0028.

0x0028 Set monochrome and color mode video settings. Set 40 x 25 text / CGA col-
or display mode.
Next, checkpoint 0x0029.

0x0029 Jump to debugger hook, clear parity status (parity will be by IA64 part). Dia-
mond VGA option ROM bug fix.
Next, checkpoint 0x002A.

0x002A Initialize different buses through DIM module. See DIM Code
Checkpoints section of document for more information.
Initialize INT 40 vector to proper location (PCI SCSI adapter fix).
Initialize video.
Make F000 shadow RAM write enabled (ALWAYS READ/WRITE). If VGA
device was found and initialized by BIOS, go to checkpoint 0x002D, else
next checkpoint 0x002B.

Note that there
will be 15–bit
post codes in
this area.
These indicate
Device Initiali-
zation Manager
sub–codes.

The convention for the DIM POST codes is as follows:
Port 80 = 0x2A
Port 81 = DIM Function number | DI number

0x002B Passing control to the video ROM to perform any required configuration be-
fore the video ROM test.
Check to see if Option ROM scan should be performed. If no, go to check-
point 0x002D.
If yes, next checkpoint 0x002Ch.

0x002C Scan video ROM segment (C000) for option ROM. If found, pass control for
video initialization.
Next, checkpoint 0x002D.



C-17Error Messages and Recovery Information

IA–32
 POST Codes

Meaning

0x002D The video ROM has returned control to BIOS POST Performing any re-
quired processing after the video ROM had control. Uncompress and initial-
ize ADM (Advanced Display Manager) module.
If ADM not available HALT! Uncompress and initialize small BIOS and/or
silent logos, detect and reset mouse, perform any required chipset or OEM
initialization processing after video ROM initialization.
Establish link for console Redirection.
Next, checkpoint 0x002E.

0x002E NMI off, clear parity status (IA64 now responsible), check video interrupt
segment to see if video ROM found.  If ROM found, check diagnostics sta-
tus byte in CMOS, set new video mode. Next, checkpoint 37h. If no ROM
found, check good/bad status of CMOS.   If good, read display adapter type
from CMOS and set in BIOS data area.  If bad, assume monochrome dis-
play and set in BIOS data area.
Next, checkpoint 0x002F.

0x002F EGA/VGA controller not found, so do display memory read/write test, if er-
ror go to checkpoint 0x0031.
Next, checkpoint 0x0030h.

0x0030 Horizontal and vertical refresh–retrace test. If color or monochrome card
found go to checkpoint 0x0034.
Else, next checkpoint 0x0031.

0x0031 The display memory read/write test or refresh–retrace test failed, so do al-
ternate display memory read/write test, if error go to checkpoint 0x0034h.
Next, checkpoint 0x0032.

0x0032 Horizontal and vertical refresh–retrace test. If card not found give memory
error beep.
Next, checkpoint 0x0034.

0x0034 Display check complete. Set the detected display mode and size.
Next, checkpoint 0x0037.

0x0037 Displaying the power on message next.  Uncompress OEM logo code/data
if silent boot enabled, enable timer interrupt, display OEM logo or BIOS
POST screen depending on setup.
Next, checkpoint 0x0038.

0x0038 Initialize the boot input, IPL, and all other general devices.  Enable writes to
F000 RAM (ALWAYS READ/WRITE).  Detect the presence of a USB
mouse. Check NVRAM and flash part, display “O.K./fail” message. Initialize
ATA channel and reset hard disk controller.  Uncompress HHF module and
initialize with setup selected values.
Next, checkpoint 0x0039.

0x0039 Display any errors reported by DIM. See DIM Code Checkpoints section of
document for more information. Display USB devices found. Display any
chipset or OEM message strings before memory size display.
Next, checkpoint 0x003A.

Note that there
will be 15–bit
post codes in
this area.
These indicate
Device Initiali-
zation Manager
sub–codes.

The convention for the DIM POST codes is as follows:
Port 80 =  0x38 and 0x39
Port 81 = DIM Function number | DI number
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IA–32
 POST Codes

Meaning

0x003A Display message to press a key Hit <DEL> or OEM defined key to enter set-
up. Display entering setup message “Entering Setup” if DEL key has been
pressed.
Next, checkpoint 0x0040.

0x0040 Check for <ESC> or <DEL> keys to limit wait for  <DEL> key press. The
DEL and ESC keys are also checked in the majority of the checkpoints from
checkpoint 0x0040 to checkpoint 0x0059. Initialize the global data area with
variables used during quick boot and tick sound.
Next, checkpoint 0x0042.

0x0042 Check for <ESC> or <DEL> key press.
Next, checkpoint 0x0043.

0x0043 Check for <ESC> or <DEL> key press. Enable timer interrupt if POST diag-
nostics disabled.
Next, checkpoint 0x0045.

0x0045 Get #of 64ks below and above 1M.
Next, checkpoint 0x004B.

0x004B Check for <ESC> or <DEL> key press. If found, set bit to run setup later.
Check for <Ctrl Alt Del>.
If found, set flag go to checkpoint 0x004C.

0x004C Check for <ESC> or <DEL> key press.
Display total memory size.
Delay for MAX of 5 seconds checking for <ESC> or <DEL> key press every
10milliseconds.  This is so one can see the Display message to press a key
Hit <DEL> or OEM defined key to enter setup.
Display entering setup message “Entering Setup” if DEL key has been
pressed Next, checkpoint 0x0052

0x0052 Store extended memory to CMOS [31], [30] in KB units.  Store extended
memory to CMOS [36], [35] in 1M units.
Next, checkpoint 0x0053.

0x0053 Check for <DEL> key press.  Clear parity error bit.
Next, checkpoint 0x0054.

0x0054 Disable parity and NMI.  Update base memory, extended memory, and
checksum in CMOS if <END> key press has been detected or initialize
CMOS in every boot flag is set.
Next, checkpoint 0x0057.

0x0057 Check for <DEL> key press.
Adjust base and/or extended memory for memory hole programming.
Save extended memory size in bytes to POST Memory Manager
[gs:pmm_last_extended_address].
Next, checkpoint 0x0058.

0x0058 Check for <DEL> key press.
Next, checkpoint 0x0059.

0x0059 Enable timer interrupt if POST diagnostics disabled.  Reset DMA#1 and
DMA#2; Determine if DMA controller should be tested or if DMA registers
should be preserved. If testable disable DMA controllers, and test DMA
controllers (Perform port pattern test on DMA registers).
If DMA error found, HALT!
Next, checkpoint 0x0060.
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IA–32
 POST Codes

Meaning

0x0060 The DMA page register test passed. Test DMA#1 Registers.
If error found, display DMA error string.  HALT!
Next, checkpoint 0x0062.

0x0062 The DMA controller 1 base register test passed.
Test DMA#2 Registers.
If error found, display DMA error string. HALT!
Next, checkpoint 0x0065.

0x0065 The DMA controller 2 base register test passed.
Enable DMA#1, enable DMA#2, and initialize DMA #1 and DMA #2.
Next, checkpoint 0x0066.

0x0066 Completed programming DMA controllers 1 and 2.
Clear DMA#2 write request register.  Read PIC #1 and #2 mask registers
and save.
Initialize 8259–interrupt controller.
Restore PIC#2 mask.
Restore PIC#1 mask with timer and video interrupts enabled.
Next, checkpoint 0x007F.

0x007F Check for <DEL> key press.
Next, checkpoint 0x0080.

0x0080 Check for <DEL> key press.
Mouse initialization of PS/2 mouse to program the IRQ level to edge trig-
gered or level triggered.
Next, checkpoint 0x0081.

0x0081 Check for <DEL> key press.
The keyboard test has started.
Clearing the output buffer and checking for stuck keys.
Next, checkpoint 0x0083h.

0x0083 Disable parity and NMI.
Check battery/checksum status in CMOS. If battery checksum OK, go to
set/reset memory expansion bit at checkpoint 0x0084. If battery/checksum
error, then check for CMOS memory size mismatch error.  If yes, go to
checkpoint 0x0084.  If no, then update base/extended memory in CMOS
and checksum.
Go to set/reset memory expansion bit at checkpoint 0x0084.

0x0084 Test and initialize the keyboard.
Initialize keyboard circular buffer.
Compare base and extended memory size with value in CMOS.
Set memory error bit if memory mismatch.
Set/reset memory expansion bit. Allocate EBDA.
Uncompress INT13 module into memory.
Give control to INT13 initialization code.
Initialize ATA/ATAPI data area.
Detect presence of a floppy.
Call DIM module to scan and initialize BBS option ROM’s. See DIM.
Next, checkpoint 0x0085.
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IA–32
 POST Codes

Meaning

Note that there
will be 15–bit
post codes in
this area.
These indicate
Device Initiali-
zation Manager
sub–codes.

The convention for the DIM POST codes is as follows:
Port 80 = 0x84
Port 81 = DIM Function number | DI number

0x0085 Display error messages.
Display F1/F2 message if bad CMOS Wait for F1/F2 or <DEL> key press.
Determine whether setup can be executed according to POST flag.
Load CMOS and GPNV default values if F2 was pressed and go to check-
point 0x0089.
If F1 or <DEL> pressed, go to Setup (checkpoint 0x0086).
Determine if user wants and is permitted to enter setup (Check password 3
times in valid CMOS) and force display back to BIOS.
Set up printer values to allow Print Screen to work in setup.
Reset the mouse if a USB mouse is present.
Next, checkpoint 0x0089 if not going to setup.

0x0086 Perform OEM necessary programming before CMOS SETUP.
Next, checkpoint 0x0087.

0x0087 Uncompress and run CMOS SETUP program if POST diagnostics dis-
abled.
Skip Setup if POST diagnostics enabled.
If Setup saved, then reboot, else readjust display mode and display wait
message.
Next, checkpoint 0x0088.

0x0088 Perform OEM necessary programming after CMOS SETUP.
Next, checkpoint 0x0089.

0x0089 Check if KB locked, if so reboot, else enable BIOS POST display or OEM
logo, whichever selected.
Display “WAIT” message.
Next, checkpoint 0x008B.

0x008B De–allocate HHF (Hardware Health) memory if enabled. Initialize boot de-
vice priority order.
Next, checkpoint 0x008C.

0x008C Perform any chipset or OEM initialization after CMOS setup even if not exe-
cuted. Several items initialized are the INT15 E820 table, chipset and I/O
setup parameters.
Next, checkpoint 0x008D.

0x008D Call optional OEM patch.
Set printer and RS232 time–out values in BIOS data area.
Next, checkpoint 0x0095.

0x0095 Check and load unattended password.
Restore display from silent mode to BIOS. Initialize the boot device order
and associated variables.
Next, checkpoint 8Eh.
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IA–32
 POST Codes

Meaning

0x008E Uncompress INT 13 module.  If module not found, go to checkpoint 0x0093.

Update BIOS to INT 13 communication segment.
Build INT 13 module header.
Update communication between POST, Runtime, and INT 13.
Check whether to initialize floppy or not.
Next, checkpoint 0x0093.

0x0093 Test for SCSI boot.  If yes SCSI boot, scan for option ROMs, activate ADM if
not already activated, initialize SCSI drive numbers in BIOS data area, and
continue on.
If no SCSI boot, pass control to INT 13 module initialization code.
Next, checkpoint 0x008F.

0x008F Initialize the floppy disk drive including initializing the global data area, set-
ting interrupt vectors, and sensing drive type and setting disk state accord-
ingly.
Initialize AFD variables. Check for valid CMOS.
Next, checkpoint 0x0091.

0x0091 Initialize ATA/ATAPI devices and associated variables.
Next, checkpoint 0x0092.

0x0092 Initialize I2O devices and associated variables, if enabled in Setup
(CMOS). Adjust AFD variables. Call DIM module to scan and initialize op-
tion ROM’s. See DIM Code Checkpoints section of document for more in-
formation.
Return control from INT 13 module.  Initialize IDE drives in BIOS data area.
Activate ADM if not already active.
Make F000 RAM write enabled (ALWAYS READ/WRITE).
Next, checkpoint 0x0096.

Note that there
will be 15–bit
post codes in
this area.
These indicate
Device Initiali-
zation Manager
sub–codes.

The convention for the DIM POST codes is as follows:
Port 80 = 0x92
Port 81 = DIM Function number | DI number

0x0096 Call hook that is available to initialize option ROM’s if DIM code has not al-
ready initialized any.
Next, checkpoint 0x0097.

0x0097 Search for and give control to the option ROM’s if not already done by DIM
code.
Next, checkpoint 0x0098.

0x0098 Activate ADM if add–on ROM found (yes, again).
Disable USB host controller. Restoring INT10 vector.
Performing any required processing after the option ROM returned control.
If any ROM cleanup or OEM ROM work needed do it.
Next, checkpoint 99h.

0x0099 Check CMOS to verify correct time (no power failure).
Set to default if CMOS bad.
Set up printer base address.
Next, checkpoint 0x009A.
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IA–32
 POST Codes

Meaning

0x009A Set the RS–232 base address.
Next, checkpoint 9Bh.

0x009B Perform any chipset or OEM initialization.
If needed check Coprocessor at checkpoint 0x009C else next, checkpoint
A2h.

0x009C Coprocessor test done. Next, checkpoint 9Dh.

0x009D Initialization after the Coprocessor test is complete.
Update equipment byte in CMOS and CMOS checksum.
Next, checkpoint A2h.

0x00A2 Display any SMART error messages.
Test for floppy drive.
Initialize POST error information for event logging.
Display any soft error messages.  If errors occurred, then “Run Setup” dis-
played if hard disk error, CMOS time error, or cache error. Else display
“Press F1 to resume” and wait for F1 key to be pressed.
If CMOS bad or memory error occurred then HALT!  If POST diagnostic
switch enabled, then reboot.
Next, checkpoint 0x00A4.

0x00A4 Call hook to perform any chipset or OEM time dependent programming.
Things like programming wait states (DONE by IA64), shadow RAM cache-
ability (ALWAYS CACHEABLE).
Next, checkpoint 0x00A5.

0x00A5 Beep and set interrupt on.
Next, checkpoint 0x00A7.

0x00A7 Final OEM Patch called.
Prepare the final RUNTIME image in a segment for copying to F000 shad-
ow.
Test for the presence of INT 10 module in E000 segment.
Initialize the start and end offset variables to aid in the copying of the final
runtime segment.
Next, checkpoint 0x00AE.

0x00AE Uncompress DMI code and data modules.
Initialize SMBIOS header structure.
Pass control to DMI module for initialization.
Copy DMI code and data into final runtime image (F000).
Next, checkpoint 0x00AC.

0x00AC Building the multiprocessor table.
Next, checkpoint 0x00AB.

0x00AB Copy device present information to POST code segment.
Copy INT 13 to final runtime (F000).
If not enough room in F000, copy to E000.
Update pointers between Runtime and INT 13 interfaces.
Next, checkpoint 0x00AD.

0x00AD Prepare INT10 image.
Update the necessary data in different modules.
Update available space in SMBIOS data structure. BIOS POST complete.
Enable F000 writes to RAM (ALWAYS READ/WRITE), and go to checkpoint
0x00A8.
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IA–32
 POST Codes

Meaning

0x00A8 Initialization before passing control to the adapter ROM at E000h com-
pleted.
Pass control to the adapter ROM at E000h.
Next, checkpoint 0x00A9.

0x00A9 Return control from ROM.
If ROM found, enable E000 shadow and copy ROM to shadow.  Next,
checkpoint 0x00AA.

0x00AA Clear screen and display system configuration if no OEM logo.
Enable/disable USB according to CMOS setting.
Enable/disable Num Lock according to CMOS setting.
Initialize extended keyboard.
Check for unattended start in CMOS.  If yes, load hot key password into
KBC and lock keyboard and mouse.  If no, continue.  If BIOS display, then
display “Wait” message.
Go to Big Real Mode.
Initialize MSIRQ routing table header.
Copy runtime language module to E000 segment.
Copy runtime ADM module to E000 segment.
Next, checkpoint 0x00B1.

0x00B1 Copy Runtime BIOS, program BIOS cacheability (ALWAYS CACHEABLE).
Next, checkpoint 0x0000h.

0x0000 Clear stack in 0 segment.
Set reset type to hard reset in BIOS data area.
Copy BBS data in DIM segment to code segment.
Clear from 0:500 to top of available real memory.
Invalidate PMM.
Release of memory used by IA32 and return to IA64.

Table 68. IA–32 POST Codes
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Device Initialization Manager (DIM) Code Checkpoints
The Device Initialization Manager module gets control at various times during BIOS POST
to initialize different BUSes. 
The following table describes the main checkpoints where the DIM module is accessed:

DIM Codes Meaning

0x??2A Initialize different BUSes and perform the following functions:
Reset, Detect, and Disable (function 0);
Static Device Initialization (function 1);
Boot Output Device Initialization (function 2).
Function 0 disables all device nodes, PCI devices, and PnP ISA cards.  It
also assigns PCI bus numbers.
Function 1 initializes all static devices that include manual configured on-
board peripherals, memory, and I/O decode windows in PCI–PCI bridges,
and noncompliant PCI devices.  Static resources are also reserved.
Function 2 searches for and initializes any PnP, PCI, or AGP video devices.

0x??38 Initialize different BUSes and perform the following functions:
Boot Input Device Initialization (function 3);
IPL Device Initialization (function 4);
General Device Initialization (function 5).
Function 3 searches for and configures PCI input devices and detects if sys-
tem has standard keyboard controller.
Function 4 searches for and configures all PnP and PCI boot devices. Func-
tion 5 configures all onboard peripherals that are set to an automatic config-
uration and configures all remaining PnP and PCI devices.

0x??39 Display error messages encountered during different BUSes initialization.
Perform function 6, which return error flags that are used to display neces-
sary error information.

0x??84 Scan and initialize BBS option ROM’s.
Perform function 8, which builds various IPL tables according to the boot
devices present in the system.

0x??92 Scan and initialize option ROM’s.
Perform function 7 which gives control and shadows all present ISA, PnP
ISA, and PCI option ROM’s.

Table 69. DIM Code checkpoints

Functions

0 = func#0, disable all devices on the BUS concerned.
1 = func#1, static devices initialization on the BUS concerned.
2 = func#2, output device initialization on the BUS concerned.
3 = func#3, input device initialization on the BUS concerned.
4 = func#4, IPL device initialization on the BUS concerned.
5 = func#5, general device initialization on the BUS concerned.
6 = func#6, error reporting for the BUS concerned.
7 = func#7, add–on ROM initialization for all BUSes.
8 = func#8, BBS ROM initialization for all BUSes.

BUSes

0 = Generic DIM (Device Initialization Manager).
1 = On–board System devices.
2 = ISA devices.
3 = EISA devices.
4 = ISA PnP devices.
5 = PCI devices.
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PCI Diagnostic POST Codes

POST Codes Name Meaning

31–16 Post code main part See below

15–12 Ext3 Module number (0 or 1)

11–08 Ext2 IOB / IOC number (0  or 1)

07–04 Ext1 Hub link number for the PCI (1 to 4)

03–00 Ext0 P64H2 secondary bus (0x“A” or 0x“B”)

Table 70. PCI diagnostic POST code format

POST Codes Meaning Extensions

0x802A Temporary PCI bus number assignment Yes

0x812A Initial PCI bus power–up sequence Yes

0x822A Disable all PCI slots Yes

0x812A Initial PCI bus power–up sequence Yes

0x832A Apply power to PCI slots Yes

0x842A Set PCI bus mode and frequency Yes

0x852A Final PCI bus power–up sequence Yes

0x862A One second temporization Yes

0x872A One second temporization Yes

0x882A One second temporization Yes

0x892A One second temporization Yes

0x8A2A Read Vendor ID of all PCI devices Yes

0x052A0000 Disable all PCI devices before PCI Bus Walk No

0x252A0000 Configure VGA card, then execute VGA option ROM No

0x552A0000 Configure all remaining PCI devices, then look for USB
devices

No

Table 71. PCI diagnostic POST codes
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EFI POST Code MAP
The following rules apply to POST code encoding:

Bit 15: 1 – IA64 code being executed, 0 – IA–32 code being executed

Bit 14: 1 – system stopped due to known failure, 0 – progress indication

Bit 13: 1 – fault or trap (no change in module numbers), 0 – normal execution

In the event of a fault or trap, only bit 13 is set to allow fault detection.

Bit 12: Reserved
Bit 11–4: Module type
Bit 3–0: Sub–module type

The module number identifies major modules such as memory, PCI, ACPI, etc. The sub–
module identifies sub–functions such as SPD read in progress, ECC error, and DIMM
mismatch for memory module.

POST Code Module

0x50XX to 0x5FXX EFI

Table 72. EFI POST Codes

ACPI POST Codes

POST Code Module

0x4000 – 0x4FFF Reserved for ACPI

Table 73. ACPI POST Codes
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Recovery Port 80 POST Codes

POST Codes Meaning

0xAA00 BIOS image loaded OK.

0xAA10 BIOS Image File loading from the media is in progress.

0xAA11 Removable Magnetic ATAPI device has been detected.

0xAA2X Flash update operation status. X – can have a value from 0 to 0xF.

This is number of the block being updated.

0xAA80 ATAPI device has been reset to recover from a reading error.

BIOS Image File loading from the media is in progress.

0xAA81 Waiting for ATAPI device ready. BIOS Image File loading from the media
is in progress.

0xAAF0 Failure while loading BIOS Image file from the media.

0xAAF1 Validation of the BIOS image has failed.

0xAAF3 Flash update failure.

0xAAAA Recovery completed without errors

0xAAE0 File system error.

0xAAE1 BIOS image file is not found on the media.

0xAAE3 Unsupported ATAPI device has been detected.

0xAAE4 Read Error.

Table 74. Recovery Port 80 POST codes (before release B600)

POST Codes Meaning

0xAA00 BIOS image loaded OK

0xAA10 BIOS Image File loading from the media is in progress.

0xAA11 Removable Magnetic ATAPI device has been detected.

0xAA12 CD_FOUND_INFO

0xAA2X Flash update operation status. X – can have a value from 0 to 0xF. This
is number of the block being updated.

0xAA80 ATAPI device has been reset to recover from a reading error. BIOS
Image File loading from the media is in progress.

0xAA81 Waiting for ATAPI device ready. BIOS Image File loading from the media
is in progress.

0xAAF0 Failure while loading BIOS image file from the media

0xAAF1 Validation of the BIOS image has failed.

0xAAF3 Flash update failure.

0xAAAA Recovery completed without errors

0xAAD0 CD_HEAD_READ_ERROR

0xAAD1 CD_BODY_READ_ERROR
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POST Codes Meaning

0xAAD2 CD_TAIL_READ_ERROR

0xAAD3 LS120_READ_ERROR

0xAAE0 FILE_SYSTEM_ERROR

0xAAE1 FILE_NOT_FOUND_ERROR

0xAAE2 UNKNOWN_DEVICE_ERROR

0xAAE3 READ_ERROR

0xAAE4 CD_BOOT_REC_READ_ERROR

0xAAE5 CD_BOOT_REC_BYTE_0_BAD

0xAAE6 CD_BOOT_REC_CD001_ERROR

0xAAE7 CD_CATALOG_READ_ERR

0xAAE8 CD_INVALID_DEFAULT_HDR_ID

0xAAE9 CD_SEARCH_BOOTABLE_IMAGE

0xAAEA CD_SECTION_NOT_BOOTABLE

0xAAEB CD_MEDIA_TYPE_NOT_HD

0xAAEC CD_NO_BOOT_IMAGE_FOUND

0xAAED CD_LOAD_MBR_FAILURE

0xAAEE CD_NO_ACTIVE_FAT16_PART

0xAAEF CD_NO_ACTIVE_BOOT_SECTOR

0xAAC0 PMB_BAD_MAGIC_NUMBER1

0xAAC1 PMB_TIME_OUT

0xAAC2 PMB_BAD_HW_STATUS

0xAAC3 PMB_BAD_MAGIC_NUMBER2

0xAAC4 PMB_BAD_BUFFER_NUMBER

0xAAC5 PMB_BAD_DATA_SIZE

0xAAC6 PMB_BAD_FROM_IDENT

0xAAC7 PMB_BAD_TO_IDENT

0xAAC8 PMB_BAD_GETBIOS_FCT

0xAAC9 PMB_BAD_GETBIOS_FCTVER

0xAACA PMB_BAD_GETBIOS_CMD

0xAACB PMB_BAD_GETBIOS_CMDVER

0xAACC PMB_BAD_SW_STATUS1

0xAACD PMB_BAD_SW_STATUS2

0xABnm BIOS image read from the PAM.
nm (from 0x00 to 0x64) is the number of the block being read from the
PAM.

Table 75. Recovery Port 80 POST codes (for releases B600 and later)
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Runtime POST Codes

POST Codes Module

0xAFCD IA–32 Intercept Trap due to an unsupported IA–32 instruction

0xAFE8 Normal SAL Machine Check Handling in Progress

0xAFE9 Could Not Correct MC Error, Halting CPU

0xAFEA MCA successfully completed, passing control back to PAL (Resume)

0xAFEB Calling OS MCA for Machine Check error handling

0xAFEC Machine Check Handler Processing Rendezvous Request

0xAFED OS request for SAL Clear Processor/Platform Error/State Log in progress

0xAFEE SAL Platform OEM MCA Error Handler In Control

0xAFEF OS request for SAL Get Processor/Platform Error/State Log in progress

0xAFF0 SAL INIT Handler is in control

0xAFF1 Passing Control to IA–32 OS Init Handler

0xAFF2 Found valid OS_INIT Ep, Passing Control to EM OS Init Handler

0xAFF3 Is a MP platform MCA condition, calling SAL_RENDZ

0xAFF4 Not a MP Platform MCA Init condition

0xAFF5 EM OS with no Init Handler or IA–32OS–BSP detected, Soft Rebooting...

0xAFF6 No OS Initialize Handle Registered, Checking OS Type...

0xAFF8 SAL PMI Handler is in Control

0xAFFA OEM SAL PMI Handler is in Control

0xAFFB Getting Source of PMI Event

0xAFFC Power Management PMI Handler is in Control

0xAFFD Platform Error PMI Handler is in Control

0xAFFE Platform Flash Management PMI Handler is in Control

0xAFFF Platform Emulation PMI Handler is in Control

0xAF71 Recover Reliable Update – verifies the bootblock checksum and corrects if
possible.

Table 76. ACPI POST codes
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PAM – BIOS Interface Post Codes
These Post codes are issued on execution of the commands sent by the BIOS to the PAM.

POST
Codes

Module Display

0xA000 BIOS Ready command is to be sent

0xA001 BIOS Ready command has been sent

0xA002 BIOS Ready command has returned KO (status 1=–1) PAM

0xA004 BIOS Ready command has returned No Go (status1=0, status2=1) PAM

0xA005 BIOS Ready command has returned normal (status1=0, status2=0)

0xA00F No response to BIOS Ready command after time out 18 sec PAM

0xA010 EFI Started command is to be sent

0xA011 EFI Started command has been sent

0xA012 EFI Started command has returned KO (status 1=–1) PAM

0xA013 EFI Started command has returned No Change (status1= 1)

0xA014 EFI Started command has returned No Go (status1=0, status2=1) PAM

0xA015 EFI Started command has returned normal (status1=0, status2=0)

0xA01F No response to EFI Started command after time out 18 sec PAM

0xA020 EFI Exit command is to be sent

0xA021 EFI Exit command has been sent

0xA022 EFI Exit command has returned KO (status 1=–1) PAM

0xA025 EFI Exit command has returned normal (status1=0, status2=0)

0xA02F No response to EFI Exit command after time out 18 sec PAM

0xA030 Send MC Log command is to be sent

0xA031 Send MC Log command has been sent

0xA032 Send MC Log command has returned KO (status 1=–1)

0xA035 Send MC Log command has returned normal (status1=0, status2=0)

0xA03F No response to Send MC Log command after time out 18 sec

0xA040 MC Reset command is to be sent

0xA041 MC Reset command has been sent

0xA042 MC Reset command has returned KO (status 1=–1) PAM

0xA045 MC Reset command has returned normal (status1=0, status2=0) PAM

0xA04F No response to MC Reset command after time out 18 sec PAM

0xA050 Reset System command is to be sent

0xA051 Reset System command has been sent
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POST
Codes

DisplayModule

0xA052 Reset System command has returned KO (status 1=–1) PAM

0xA055 Reset System command has returned normal (status1=0, status2=0) PAM

0xA05F No response to Reset System command after time out 18 sec PAM

0xA060 Set Time command is to be sent

0xA061 Set Time command has been sent

0xA062 Set Time command has returned KO (status 1=–1)

0xA065 Set Time command has returned normal (status1=0, status2=0)

0xA06F No response to Set Time command after time out 18 sec

0xA070 Get FRU command is to be sent

0xA071 Get FRU command has been sent

0xA072 Get FRU command has returned KO (status 1=–1) PAM

0xA075 Get FRU command has returned normal (status1=0, status2=0)

0xA07F No response to Get FRU command after time out 18 sec PAM

0xA080 Get GUID command is to be sent

0xA081 Get GUID command has been sent

0xA082 Get GUID command has returned KO (status 1=–1) PAM

0xA085 Get GUID command has returned normal (status1=0, status2=0)

0xA08F No response to Get GUID command after time out 18 sec PAM

0xA090 EFI Variable Modified command is to be sent

0xA091 EFI Variable Modified command has been sent

0xA092 EFI Variable Modified command has returned KO (status 1=–1)

0xA095 EFI Variable Modified command has returned normal (status1=0,
status2=0)

0xA09F No response to EFI Variable Modified command after time out 18 sec

0xA0A0 EFI Variable To Restore command is to be sent

0xA0A1 EFI Variable To Restore command has been sent

0xA0A2 EFI Variable To Restore command has returned KO (status 1=–1)

0xA0A5 EFI Variable To Restore command has returned normal (status1=0,
status2=0)

0xA0AF No response to EFI Variable To Restore command after time out 18
sec
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POST
Codes

DisplayModule

0xA0B0 Send Message command is to be sent

0xA0B1 Send Message command has been sent

0xA0B2 Send Message command has returned KO (status 1=–1)

0xA0B5 Send Message command has returned normal (status1=0, sta-
tus2=0)

0xA0BF No response to Send Message command after time out 18 sec

0xA0C0 Notify command is to be sent

0xA0C1 Notify command has been sent

0xA0C2 Notify command has returned KO (status 1=–1)

0xA0C5 Notify command has returned normal (status1=0, status2=0)

0xA0CF No response to Notify command after time out 18 sec

0xA0D0 Get BIOS Image command is to be sent

0xA0D1 Get BIOS Image command has been sent

0xA0D2 Get BIOS Image command has returned KO (status 1=–1) PAM

0xA0D5 Get BIOS Image command has returned normal (status1=0, sta-
tus2=0)

0xA0D6 Get BIOS Image command has returned No BIOS imagel (sta-
tus1=0, status2=2)

PAM

0xA0DF No response to Get BIOS Image command after time out 18 sec PAM

Table 77. PAM – BIOS Interface POST codes (for releases B740 and later)
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Boot Error Messages

Message Displayed Description

Boot Failure ... This is a generic message indicating the BIOS could
not boot from a particular device. 
This message is usually followed by other information
concerning the device.

Reboot and Select proper Boot
device or Insert Boot Media in
selected Boot device

BIOS could not find a bootable device in the system
and/or removable media drive does not contain media.

Table 78. Boot error messages

Storage Device Error Messages

Message Displayed Description

Primary Master
Hard Disk Error

The IDE/ATAPI device configured as Primary Master could
not be properly initialized by the BIOS. 
This message is typically displayed when the BIOS is trying
to detect and configure IDE/ATAPI devices in POST.

Secondary Master 
Hard Disk Error

The IDE/ATAPI device configured as Secondary Master could
not be properly initialized by the BIOS. 
This message is typically displayed when the BIOS is trying
to detect and configure IDE/ATAPI devices in POST.

Primary Master Drive 
– ATAPI Incompatible

The IDE/ATAPI device configured as Primary Master failed an
ATAPI compatibility test. 
This message is typically displayed when the BIOS is trying
to detect and configure IDE/ATAPI devices in POST.

Secondary Master Drive
– ATAPI Incompatible

The IDE/ATAPI device configured as Secondary Master failed
an ATAPI compatibility test. 
This message is typically displayed when the BIOS is trying
to detect and configure IDE/ATAPI devices in POST.

Table 79. Storage error messages
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System Configuration Error Messages

Message Displayed Description

DMA–2 Error Error initializing secondary DMA controller. This is a fatal error,
often indication a problem with system hardware.

DMA Controller Error POST error while trying to initialize the DMA controller. This is a
fatal error, often indication a problem with system hardware.

Checking NVRAM.
Update Failed

BIOS could not write to the NVRAM block.  This message
appears when the FLASH part is write–protected or if there is
no FLASH part (System uses a PROM or EPROM).

NVRAM Checksum
Bad, NVRAM Cleared

There was an error in while validating the NVRAM data.  
This causes POST to clear the NVRAM data.

Resource Conflict More than one system device is trying to use the same
non–shareable resources (Memory or I/O).

NVRAM Ignored The NVRAM data used to store Plug’n’Play (PnP) data was not
used for system configuration in POST.

NVRAM Bad The NVRAM data used to store Plug’n’Play (PnP) data was not
used for system configuration in POST due to a data error.

Static Resource Conflict Two or more Static Devices are trying to use the same resource
space (usually Memory or I/O).

PCI I/O conflict A PCI adapter generated an I/O resource conflict when
configured by BIOS POST.

PCI ROM conflict A PCI adapter generated an I/O resource conflict when
configured by BIOS POST.

PCI IRQ conflict A PCI adapter generated an I/O resource conflict when
configured by BIOS POST.

PCI IRQ routing table
error

BIOS POST (DIM code) found a PCI device in the system but
was unable to figure out how to route an IRQ to the device.
Usually this error is causing by an incomplete description of the
PCI Interrupt Routing of the system.

Timer Error BIOS POST (DIM code) found a PCI device in the system but
was unable to figure out how to route an IRQ to the device.
Usually this error is causing by an incomplete description of the
PCI Interrupt Routing of the system.

Interrupt Controller–1
error

BIOS POST could not initialize the Master Interrupt Controller.
This may indicate a problem with system hardware.

Interrupt Controller–2
error

BIOS POST could not initialize the Slave Interrupt Controller.
This may indicate a problem with system hardware.

Table 80. System configuration error messages
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CMOS Error Messages

Message Displayed Description

CMOS Date/Time Not
Set

The CMOS Date and/or Time are invalid.
This error can be resolved by readjusting the system time in
AMIBIOS Setup.

CMOS Battery Low CMOS Battery is low. This message usually indicates that the
CMOS battery needs to be replaced. It could also appear when
the user intentionally discharges the CMOS battery.

CMOS Settings
 Wrong

CMOS settings are invalid. 
This error can be resolved by using AMIBIOS Setup.

CMOS Checksum
 Bad

CMOS contents failed the Checksum check. Indicates that the
CMOS data has been changed by a program other than the
BIOS or that the CMOS is not retaining its data due to
malfunction. 
This error can typically be resolved by using AMIBIOS Setup.

Table 81. CMOS error messages

Miscellaneous Error Messages

Message Displayed Description

Keyboard Error Keyboard is not present or the hardware is not responding
when the keyboard controller is initialized.

Keyboard/Interface Error Keyboard Controller failure.
This may indicate a problem with system hardware.

System Halted The system has been halted. 
A reset or power cycle is required to reboot the machine. This
message appears after a fatal error has been detected.

Table 82. Miscellaneous error messages
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PAM Help Messages
 Message severity levels, on page C-36

 Message list, on page C-36

Message Severity Levels
PAM event messages or histories are graded into four severity levels as explained in
Understanding Event Message and History Severity Levels, in the User’s Guide.

 Note:
According to the message severity level, the first character 2 of 2B2Bxxxx (Success,
Information or Warning level) may change to A (AB2Bxxxx) (Error level).

Message List
PAM messages can be consulted online and/or printed at the user’s request. 
The following table indicates PAM message IDs with a brief description.

Description

2B2B0000 Undefined error

2B2B1000 Successful function completion

2B2B1001 Function not completed for an internal reason

2B2B1002 File not found

2B2B1003 Directory not found

2B2B1004 File already exists

2B2B1005 Call to function failed

2B2B1006 Invalid argument

2B2B1007 Missing argument

2B2B1008 Collection item not found

2B2B1009 Collection item already exists

2B2B100A Invalid collection item

2B2B100B Unit absent

2B2B100C Unit present

2B2B100D Functional status: Normal

2B2B100E Functional status: Warning

2B2B100F Functional status: Critical

2B2B1010 Functional status: Fatal

2B2B1012 CellBlock added

2B2B1013 CellBlock removed

2B2B1014 Cannot load XML file

2B2B1015 Cannot save XML file

2B2B1016 Name or field too long

2B2B1017 Error loading XML file

2B2B1018 Cannot delete XML file

2B2B1019 Component not accessible
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Description

2B2B101A Component irrelevant

2B2B101B PAM internal error

2B2B101C Factory Bootrom used to load MAESTRO

2B2B101D Updated Bootrom used to load MAESTRO

2B2B101E Running MAESTRO loaded from PMB flash ROM

2B2B101F Running MAESTRO loaded from PAP disk

2B2B1020 MAESTRO image choice: “PMB flash ROM”

2B2B1021 MAESTRO image choice: PAP disk

2B2B1022 Fault status: Normal

2B2B1023 Fault status: Faulty

2B2B1024 Failure status: Normal

2B2B1025 Failure status: Degraded

2B2B1026 Failure status: Failed

2B2B1027 Error validating XML file

2B2B1028 Invalid length

2B2B1029 Unable to create directory

2B2B102A Unit  excluded

2B2B102B Unit  reinserted

2B2B102F Maintenance network adapter missing

2B2B1030 Disk full

2B2B1031 Cannot copy XML file

2B2B1032 New release activated

2B2B1033 Illegal character in object name

2B2B2000 Method not implemented

2B2B2001 Interface not supported

2B2B2002 Invalid interface pointer

2B2B2003 Operation aborted

2B2B2004 Unspecified error

2B2B2005 Operation failed on registry key

2B2B2006 Operation failed on semaphore

2B2B2007 Unexpected value for <switch name> switch

2B2B2008 Access denied

2B2B2009 Directory created

2B2B200A File created

2B2B200B Object created successfully

2B2B200C Object deleted successfully

2B2B200E Object invalid

2B2B200F File not loaded

2B2B2010 File not saved

2B2B2012 Operation forbidden

2B2B2013 Element not found

2B2B2014 Object renamed successfully
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Description

2B2B2015 Renaming object forbidden

2B2B2016 Method  not applicable

2B2B2017 PAM object should not be reentered

2B2B2018 Unexpected variant type

2B2B2019 Error detected by the PAP Operating System

2B2B201A Cannot create object

2B2B201B Command in progress

2B2B201C Asynchronous command not issued

2B2B201D Service status

2B2B201E File operation failed

2B2B2100 Cannot add CellBlock

2B2B2101 Cannot remove CellBlock

2B2B2102 Hardware identifier out of range

2B2B2103 Hardware identifier already assigned

2B2B2104 PAP software started

2B2B2105 Incorrect signature

2B2B2106 Config information successfully applied to cellblock

2B2B2107 Cannot apply config information using file

2B2B2201 Object locked

2B2B2202 Object not locked

2B2B2203 Operation not allowed

2B2B2204 Invalid XML string

2B2B2205 Element missing

2B2B2210 Domain cannot be activated

2B2B2211 Domain  inactive

2B2B2212 Domain initializing

2B2B2213 Domain Power–on failed

2B2B2214 Domain time out during the power–on sequence

2B2B2215 Domain powered on

2B2B2216 Domain BIOS ready

2B2B2217 Domain time out while waiting for BIOS ready state

2B2B2218 Recovering BIOS

2B2B2219 Domain EFI started

2B2B221A Domain EFI started  time out

2B2B221B Domain running

2B2B221C Domain terminating

2B2B221D Domain power–down failed

2B2B221E Domain power–down time out

2B2B221F Domain initialization step: <step description>

2B2B2220 Domain termination step <step description>

2B2B2221 Domain <domain name> Power–on started

2B2B2222 Resource(s) unavailable for domain Power–on
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Description

2B2B2223 Domain <domain name>, <command> failed

2B2B2224 BIOS command received: <command name>

2B2B2225 Reset action requested

2B2B2226 Domain creation error

2B2B2227 Domain not running

2B2B2228 Domain <domain name> is already powered on

2B2B2229 Incorrect BIOS data length

2B2B222A Domain group cannot be removed

2B2B222B Domain cannot be removed because it is not in an INACTIVE
state

2B2B222C Domain command rejected

2B2B222D MAESTRO Domain <domain name> power state unknown

2B2B222E Domain <domain name> synchronization with MAESTRO failed

2B2B222F Fan box <fan box name> is not available

2B2B2230 IOR / IOL not available

2B2B2232 Not enough DPS

2B2B2233 No SPS fan box is available on module

2B2B2234 Domain <domain name> cannot be powered ON

2B2B2235 XML EFI variable invalid

2B2B2236 BIOS EFI variable invalid

2B2B2237 Domain power off after time out

2B2B2238 No CPU available for this QBB included in domain

2B2B2239 Message from BIOS

2B2B223A Domain reset started

2B2B223B Domain identity not found

2B2B223C Domain powering on suspended

2B2B223D Domain power on resumed

2B2B223E Reset action unknown

2B2B223F Domain halted

2B2B2240 QBB origin unexpected

2B2B2241 CPU incompatible

2B2B2242 Domain group cannot be added

2B2B2243 Non compliance with configuration information

2B2B2244 Domain definition invalid

2B2B2245 SPS function not available

2B2B2246 No QBB available

2B2B2247 Master resource mismatch

2B2B2248 Domain clock frequency

2B2B2249 No BIOS image reference set

2B2B224A Domain clock frequency should be nominal

2B2B224B SPS not available

2B2B224C Domain notification invalid
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Description

2B2B224D Domain power off after virtual power on

2B2B224E BIOS Post Code not accessible

2B2B224F Cannot delete BIOS image file

2B2B2250 Cannot update an EFI variable

2B2B2251 Cannot read recovery status

2B2B2252 Scheme incompatible with current domain configuration

2B2B2253 Resource missing in scheme

2B2B2254 BIOS postcodes logged after time–out

2B2B2255 Domain thermal alert

2B2B2256 Domain FRU faulty

2B2B2257 Cannot get the EFI variables

2B2B2258 Invalid clock exclusion

2B2B2259 BIOS stop request

2B2B2300 PMB not declared

2B2B2301 PMB declared before PAM

2B2B2302 PMB declared

2B2B2303 PMB connection check

2B2B2304 PMB connection error

2B2B2305 RPC trace

2B2B2306 RPC connection error

2B2B2307 RPC error

2B2B2400 Cannot add object

2B2B2401 Cannot remove object

2B2B2402 Object added to collection

2B2B2403 Object removed from collection

2B2B2404 Inconsistency in filter

2B2B2405 Subscription test

2B2B2406 Invalid event processor

2B2B2407 Cannot submit event to subscription

2B2B2408 Inconsistency in subscription

2B2B2409 Event object in use

2B2B240A Error sending an autocall file

2B2B240B Error sending mail

2B2B240C Server not configured

2B2B240D User not declared

2B2B240E Too many pending autocall files

2B2B240F Local directory not configured

2B2B2410 Autocall heartbeat

2B2B2411 Autocall handler disabled

2B2B2500 Cannot remove unit

2B2B2501 Maintenance procedure failed

2B2B2502 Maintenance procedure command OK
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Description

2B2B2503 CPU KO (Performance restricted)

2B2B2504 CPU KO (Functionally restricted)

2B2B2505 CPU KO (Unresponsive)

2B2B2508 Unknown BIOS status

2B2B2509 Unknown PIROM format

2B2B2510 Invalid PIROM data

2B2B2511 Invalid memory size

2B2B2512 CPU FRU–EEPROM written

2B2B2513 Module Power configuration: normal

2B2B2514 Module Power configuration: critical

2B2B2515 Module Power configuration: fatal

2B2B2516 Module SPSFanBox configuration: normal

2B2B2517 Module SPSFanBox configuration: critical

2B2B2518 Module SPSFanBox configuration: fatal

2B2B2519 FRU active

2B2B2520 FRU inactive

2B2B2521 FRU ready for maintenance

2B2B2522 FRU not ready for maintenance

2B2B2523 No maintenance procedure for this FRU

2B2B2524 Module main off

2B2B2525 Only x out of y Mbytes have been initialized

2B2B2526 FRU or system EEPROM successfully written / updated

2B2B2527 Unable to write / update FRU EEPROM

2B2B2528 Unable to read the System EEPROM

2B2B2529 Cannot access CPU LIDs

2B2B2530 Unit removed

2B2B2531 SIOH KO

2B2B2532 PCI slot faulty

2B2B2533 PCI slot faulty

2B2B2534 Illegal PCI function number

2B2B2535 Cannot access PCI Class Codes

2B2B2536 PCI class code unknown

2B2B2537 QBB KO

2B2B2538 Maintenance procedure in progress

2B2B2539 FRU power on rejected

2B2B253A No maintenance procedure to close

2B2B253B Illegal memory row index

2B2B253C Memory row KO

2B2B253D Unable to read the FRU EEPROM

2B2B253E Cannot get the FPGA version

2B2B253F Invalid I2CFitPattern definition

2B2B2540 No ERC reference
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Description

2B2B2541 Check EEPROM failed

2B2B2600 HistoryManager internal error

2B2B2601 History internal error

2B2B2602 Archive internal error

2B2B2603 EVT files not available

2B2B2604 HistoryMaster missing

2B2B2605 XML description not found

2B2B2606 Event Logging failed

2B2B2607 Static History illegal operation

2B2B2608 Current history not locked for any PUID

2B2B2609 Current history not locked for PUID

2B2B260A Current history locked

2B2B260B EventLogConverter internal error

2B2B260C EventLog internal error

2B2B260D Current history created with PAM revision

2B2B2700 Security internal error

2B2B2701 MsgUtil internal error

2B2B2703 Current call context not available

2B2B2704 Security disabled for current object

2B2B2705 Application not found in COM Catalog

2B2B2706 Message index not found

2B2B2707 Message identifier not found

2B2B270C FileObject internal error

2B2B270D FTP error

2B2B270E FTP session closed

2B2B270F FTP session opened

2B2B2710 Engineering modes were reset to their default value

2B2B2711 ZIP error

2B2B2712 Zip file already created

2B2B2713 Zip file already closed

2B2B2714 External Alarm

2B2B2715 SNMP Agent error

2B2B2716 Remote Access Server error

2B2B2800 Incorrect FTP server configuration on PAP

2B2B2801 Firmware version identifier not found

2B2B2802 Remove reference firmware denied

2B2B2803 Invalid BootRom version

2B2B2804 Invalid reference firmware

2B2B2805 Firmware version not found

2B2B2806 Firmware version shared

2B2B2807 Remove default firmware denied

2B2B2808 FTP server not found



C-43Error Messages and Recovery Information

Description

2B2B2809 Invalid Hardware Type

2B2B2900 NVRAM area modified

2B2B2901 S@N.IT command failed

2B2B2902 Check internal SAN – only one fabric allowed

2B2B2903 Property or method not available

2B2B2904 Parameter must have hexadecimal characters

2B2B2905 method or property modification forbidden

2B2B2906 S@N.IT discovery failed

2B2B2907 SAN trace open string

2B2B290A LUN status changed

2B2B290B SNMP trap

2B2B290C SNMP error

2B2B2A00 FRUEEPROMInfo internal error

2B2B2A01 Checksum invalid

2B2B2A02 FRU EEPROM Info not IPMI compliant for component <PUID>

2B2B2A03 IPMISELDevice internal error

2B2B2A04 Invalid network function code

2B2B2B00 Cannot save log file

2B2B2B01 Error notification received

2B2B2B02 Unexpected log format

2B2B2B03 Error report file created and saved

2B2B2B04 Unable to create an error report file

2B2B2C00 Information from Global Status

2B2B2D00 Identity card created

2B2B2D01 Identity card failed

2B2B3000 Object not ready. Object non initialized or MAESTRO problem

2B2B3001 Unknown PUID

2B2B3002 Function not supported

2B2B3005 Process in progress

2B2B3006 Debug message

2B2B3007 MAESTRO component fault ON

2B2B3008 MAESTRO component fault OFF

2B2B300A Operation failed

2B2B300B Method in progress

2B2B3100 MAESTRO is starting

2B2B3101 MAESTRO is ready

2B2B3102 MAESTRO task launched

2B2B3103 MAESTRO task deleted

2B2B3104 MAESTRO task suspended

2B2B3200 PMB firmware successfully reloaded

2B2B3201 PMB firmware reload: failed

2B2B3202 PMB firmware MAESTRO boot: failed



C-44 User’s Guide

Description

2B2B3210 PMB firmware reload: started

2B2B3211 MAESTRO reboot after having reloaded PMB firmware

2B2B3212 MAESTRO reboot before reloading PMB firmware

2B2B3213 PMB firmware: missing File or Version information

2B2B321E PMB firmware OK

2B2B321F PMB Firmware information

2B2B3220 PMB confidence test not performed

2B2B3221 PMB confidence test error

2B2B3222 Midplane Type not supported

2B2B3280 RPC connection is not opened

2B2B3281 RPC connection is opened

2B2B3282 RPC connection is closed

2B2B3283 RPC portmapper failed

2B2B3284 RPC server not found

2B2B3285 RPC server: unknown procedure

2B2B3286 RPC server: cannot reply to procedure

2B2B3290 RPC call failure

2B2B32A0 PAP request started

2B2B32A1 PMB request started

2B2B32A2 Remote request terminated

2B2B32A3 Request to PAP started

2B2B32A4 PMB request started

2B2B32A5 Request to remote destination terminated

2B2B32A6 Invoke error

2B2B3300 Stand–by power device OFF

2B2B3301 Power device OFF. The main part of device converters is OFF

2B2B3302 Power device ON. Stand–by and main are ON

2B2B3303 Power device Faulty

2B2B3304 Stand–by power device Faulty

2B2B3305 Power converter Faulty

2B2B3306 Stand–by power device ON

2B2B3307 Power converter OFF

2B2B3308 Power converter ON

2B2B3309 Power converter Failed

2B2B330A Power device voltage margin: +

2B2B330B Power device voltage margin: OFF

2B2B330C Power device voltage margin: –

2B2B331D Fan status: Normal

2B2B331E Fan status: Fault.

2B2B331F LED: OFF

2B2B3320 LED: ON

2B2B3321 FPGA not correctly loaded
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2B2B3322 P64H2_<P64H2 number> hot–plug request

2B2B3323 P64H2_<P64H2 number> hot–plug acknowledge.

2B2B3324 ACPI signal asserted

2B2B3325 ACPI signal deasserted

2B2B3326 FRU connected

2B2B3327 FRU isolated

2B2B3328 Cabinet door opened

2B2B3329 Cabinet door closed

2B2B3330 Cabinet intrusion detector cable is connected

2B2B3331 Cabinet intrusion detector cable is disconnected

2B2B3332 Battery failed

2B2B3333 I2C loop back error

2B2B3334 Clock frequency unknown

2B2B3335 PHPB/HPB fault

2B2B3336 Chip not accessible through SM bus

2B2B3337 Set clock frequency

2B2B3338 Set clock source

2B2B3339 Set clock not allowed

2B2B333A Invalid MSX clocks configuration

2B2B333B Invalid I2C fit pattern value

2B2B3400 Device missing

2B2B3401 Device failed

2B2B3402 SM bus access denied

2B2B3403 SM bus failed

2B2B3405  I2C network failed

2B2B3406 Chipset command aborted

2B2B3407 Chipset status: busy

2B2B3408 Chipset status: error

2B2B3409 I2C loop back error

2B2B340A BSPS write error

2B2B3500 Domain already powered on

2B2B3501 Domain already powered off

2B2B3502 Power on in progress

2B2B3503 Power off in progress

2B2B3504 Remove domain KO

2B2B3505 Master IOB / IOC not defined

2B2B3506 Master QBB not defined

2B2B3507 NVRAM missing

2B2B3508 Domain <domain name> requested by <action>

2B2B3509 Domain <domain name> requested by <action>

2B2B3600 Command sent by Bios to PMB

2B2B3601 Message returned to BIOS by PMB
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2B2B3602 BIOS log queue overflow control

2B2B3700 ERC mode

2B2B3701 ERC interrupt

2B2B3702 Error in Machine Check processing

2B2B3703  ERC signal configuration state

2B2B3704 ERC log queue overflow control

2B2B3705 BIOS log queue state

2B2B3706 Burst of machine check errors

2B2B3707 Burst of machine check errors terminated

2B2B3708 ERC error reporting modified

2B2B3800 Invalid IPMI response length

2B2B3801 IPMI command received

2B2B3802 IPMI response

2B2B3803 IPMI watchdog timer expiration

2B2B3804 IPMI invalid command length

2B2B3805 IPMI invalid command format

2B2B3806 IPMI cannot execute command

2B2B3807 IPMI debug message

2B2B3808 IPMI watchdog timer action

2B2B3900 Trace of request received by DomainPool object

2B2B3901 Module hardware resources left unchanged

2B2B3902 Request rejected

2B2B3A00 JTAG illegal command

2B2B3A01 JTAG not supported command

2B2B3A02 JTAG illegal end state

2B2B3A03 JTAG cannot read

2B2B3A04 JTAG illegal end of file

2B2B3A05 JTAG illegal transition state

2B2B3A06 JTAG illegal TAP state

2B2B3A07 JTAG TDO mismatch

2B2B3A08 JTAG max retries

2B2B3A09 JTAG XSVF command

2B2B3A0A JTAG error

2B2B3A0B JTAG XSVF file execution

2B2B3A0C JTAG XSVF file execution OK

2B2B3A0D JTAG cannot open XSVF file

2B2B3A0E JTAG method failed

2B2B3A0F JTAG TDO signal

2B2B3A10 Invalid JTAG target

2B2B3B00 PCI Interrupt

2B2B4000 Remote script error

2B2B4001 WEB Server error
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2B2B4002 XML node missing

2B2B4003 Web session initialization error

2B2B4004 Page loading error

2B2B4005 Error discarded

2B2B4006 Error loading an ASP page, generally due to a loading time limit

2B2B4007 Error occurred on the WEB Client

2B2B4008 Intervention report

2B2B400A WEB Session started

2B2B400B WEB Session ended

2B2B400C PAP shutdown

2B2B400D WEBServer trace

Table 83. PAM message list
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Glossary

A
AC: Alternating Current generated by the power
supply. See DC.

ACPI: Advanced Configuration and Power
Interface. An industry specification for the efficient
handling of power consumption in desktop and
mobile computers. ACPI specifies how a
computer’s BIOS, operating system, and peripheral
devices communicate with each other about power
usage.

Address: A label, name or number that identifies a
location in a computer memory.

AMI: American Megatrends Incorporated.

ANSI: American National Standards Institute.

API: Application Program Interface. The specific
method prescribed by a computer operating
system or by an application program by which a
programmer writing an application program can
make requests of the operating system or another
application.

Archive: (Archive file). A file that is a copy of a
history file. When a history file is archived, all
messages are removed from the history file.

ASCII: American National Standard Code for
Information Interchange. A standard number
assigned to each of the alphanumeric characters
and keyboard control code keys to enable the
transfer of information between different types of
computers and peripherals.

B
Backup: A copy of data for safe–keeping. The
data is copied form computer memory or disk to a
floppy disk, magnetic tape or other media.

Backup battery: The battery in a computer that
maintains real–time clock and configuration data
when power is removed.

Baud rate: The speed at which data is transmitted
during serial communication.

BIOS: Basic Input / Output System. A program
stored in flash EPROM or ROM that controls the
system startup process.

BIST: Built–In Self–Test. See POST.

Bit: Derived from BInary digiT. A bit is the smallest
unit of information a computer handles.

BTU: British Thermal Unit.

Byte: A group of eight binary digits (bit) long that
represents a letter, number, or typographic symbol.

C
Cache Memory: A very fast, limited portion of
RAM set aside for temporary storage of data for
direct access by the microprocessor.

CD-ROM: Compact DisK Read-Only Memory.
High-capacity read-only memory in the form of an
optically readable compact disk.

Cell: The smallest set of hardware components
allocated to a single OS. A cell is functionally
defined by:
– the number of available processors
– memory capacity
– I/O channel capacity.

CellBlock: A group of interconnected cells within a
single domain. See Central Subsystem.

Central Subsystem:  A group of interconnected
cells gathered within a single domain. See
CellBlock.

Chip: Synonym for integrated circuit. See IC.

Clipping: A PAM Event filter criterion. Clipping is
defined on a Count / Time basis aimed at routing a
pre–defined number of messages only. Identical
messages are counted and when the number of
messages indicated in the Count field is reached
within the period of time indicated in the Time field,
no other messages will be selected for routing.

CMC: Corrected Memory Check.

CMOS: Complementary Metal Oxide
Semiconductor. A type of low–power integrated
circuits. System startup parameters are stored in
CMOS memory. They can be changed via the
system setup utility.

COM: Component Object Model. Microsoft
technology for component based application
development under Windows.
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COM +: Component Object Model +.  Microsoft
technology for component based application
development under Windows. The external part of
the PAM software package is a COM+ application.

COM1 or COM2: The name assigned to a serial
port to set or change its address. See Serial Port.

Command: An instruction that directs the
computer to perform a specific operation.

Configuration: The way in which a computer is set
up to operate. Configurable options include CPU
speed, serial port designation, memory allocation,
...

Configuration Tasks: A PAM feature used to
configure and customize the server.

Control Pane: One of the three areas of the PAM
web page. When an item is selected in the PAM
Tree pane, details and related commands are
displayed in the Control pane. See PAM Tree pane
and Status pane.

Core Unit: A main CSS module unit
interconnecting the MIO, MQB, MSX and MFL
boards. See MIO, MQB, MSX, MFL.

COS: Cluster Operating System.

CPE: Corrected PCI Error.

CPU: Central Processing Unit. See
Microprocessor.

CSE: Customer Service Engineer.

CSS: Central Sub–System. See CellBlock.

CSS Module: A MidPlane with all its connected
components (QBBs, IO boards, PMB) and  utility
devices. See Module.

D
D2D: DC to DC converter.

DC: Direct Current generated by the power supply.
See AC.

Default Setting: The factory setting your server
uses unless instructed otherwise.

Density: The capacity of information (bytes) that
can be packed into a storage device.

Device Driver: A software program used by a
computer to recognize and operate hardware.

DIB: Device Interface Board. The DIB provides the
necessary electronics for the Internal Peripheral
Drawer. See IPD.

DIG64: Developer Interface Guide for IA64.

DIM Code: Device Initialization Manager. Initializes
different BUSes during the BIOS POST.

DIMM: Dual In-line Memory Module – the smallest
system memory component.

Disk Drive: A device that stores data on a hard or
floppy disk. A floppy disk drive requires a floppy
disk to be inserted. A hard disk drive has a
permanently encased hard disk.

DMA: Direct Memory Access. Allows data to be
sent directly from a component  (e.g. disk drive) to
the memory on the motherboard). The
microprocessor does not take part in data transfer
enhanced system performance.

DMI: Desktop Management Interface. An industry
framework for managing and keeping track of
hardware and software components in a system of
personal computers from a central location.

DNS: Domain Name Server. A server that retains
the addresses and routing information for TCP/IP
LAN users.

Domain: is the coherent set of resources allocated
to run a customer activity,  i.e. the association –at
boot time– of a Partition, an OS instance (including
applications) and associated LUNs and an
execution context including execution modes and
persistent information (e.g. time, date of the OS
instance). Domain definitions and initializations are
performed via PAM. A Domain can be modified to
run the same OS instance on a different Partition.
When a Domain is running,  its resources are
neither visible nor accessible to other running
Domains.

Domain Identity: a PAM Domain management
logical resource. This resource contains context
information related to the Customer activity running
in a domain. The most visible attribute of this
resource is the name that the Customer gives to
the activity. For each domain created, the Domain
management feature allows the operator to define
a new activity or choose an activity from the list of
existing activities. See Domain.

Domain Manager:  A PAM feature used to power
on / off and manage server domains. See Domain.

DPS: Distributed Power Supply.

DRAM: Dynamic Random Access Memory is the
most common type of random access memory
(RAM).

E
EEPROM: Electrically Erasable Programmable
Read-Only Memory. A type of memory device that
stores password and configuration data. See also
EPROM.

EFI: Extensible Firmware Interface.
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EFIMTA: EFI Modular Test Architecture.

EFI Shell: The EFI (Extensible Firmware Interface)
Shell is a simple, interactive user interface that
allows EFI device drivers to be loaded, EFI
applications to be launched, and operating systems
to be booted. In addition, the EFI Shell provides a
set of basic commands used to manage files and
the system environment variables. See Shell.

EMI: Electro–Magnetic Interference.

EPROM: Erasable Programmable Read-Only
Memory. A type of memory device that is used to
store the system BIOS code. This code is not lost
when the computer is powered off.

ERC: Error Recovery Check.

ERP: Error Recovery Procedure.

ESD: ElectroStatic Discharge. An undesirable
discharge of static electricity that can damage
equipment and degrade electrical circuitry.

Event: The generation of a message (event
message) by a software component and that is
directed to the Event Manager.

Event address: Defines the destination for a
message sent over a specified event channel. An
address is one of: the name of a history file (for the
HISTORY channel), an e–mail address (for the
EMAIL channel), the name of a user group (for the
WEB channel), the SNMP Manager IP address (for
the SNMP channel).

Event channel: Defines how the Event Manager
sends an event message. An event channel is one
of: HISTORY (the message is logged in a history
file), EMAIL (the message is sent to an e–mail
address), WEB (the message is stored for analysis
from the PAM web user interface), SNMP (the
message is sent as an SNMP trap to the selected
SNMP application).

Event filter: A list of selected messages among all
possible event messages. If an event message is
not included in the filter, the Event Manager
discards the message.

Event Manager: A PAM feature used to forward
event messages over a configured event channel.
See Event.

Event message: A message sent by a software
component to the Event Manager for routing to a
destination that is configured by an administrator.

Event subscription: An object that defines the
event channel, address, and filter for sending an
event message. If no such object is defined, the
event message is discarded.

F
Fail–over: Failover is a backup operational mode
in which the functions of a system component
(such as a processor, server, network, or database,
for example) are assumed by secondary system
components when the primary component
becomes unavailable through either failure or
scheduled down time.

FAME: Flexible Architecture for Multiple
Environments.

FAST WIDE: A standard 16–bit SCSI interface
providing synchronous data transfers of up to 10
MHz, with a transfer speed of 20M bytes per
second.

FC: Fibre Channel.

FCAL: Fibre Channel Arbitrated Loop.

FCA: Fibre Channel Adapter.

FCBQ: Fan Control Board for QBB.

FCBS: Fan Control Board for SPS.

FDA: Fibre Disk Array.

FDD: Floppy Disk Drive.

Flash EPROM: Flash Erasable Programmable
Read-Only Memory. A type of memory device that
is used to store the the system firmware code. This
code can be replaced by an updated code from a
floppy disk, but is not lost when the computer is
powered off.

Firewall:  A set of related programs, located at a
network gateway server, that protects the
resources of a private network from users from
other networks.

Firmware:  an ordered set of instructions and data
stored to be functionally independent of main
storage.

Format: The process used to organize a hard or
floppy disk into sectors so that it can accept data.
Formatting destroys all previous data on the disk.

FPB: FAME Power Board (FAME: Flexible
Architecture for Multiple Environments).

FPGA: Field Programmable Gate Array. A gate
array that can reprogrammed at run time.

FRB: Fault Resilient Boot. A server management
feature. FRB attempts to boot a system using the
alternate processor or DIMM.
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FRU: Field Replaceable Unit. A component that is
replaced or added by Customer Service Engineers
as a single entity.

FSS: FAME Scalability Switch. Each CSS Module
is equipped with 2 Scalability Port Switches
providing high speed bi–directional links between
server components. See SPS.

FTP: File Transfer Protocol. A standard Internet
protocol: the simplest way of exchanging files
between computers on the Internet. FTP is an
application protocol that uses Internet TCP/IP
protocols. FTP is commonly used to transfer Web
page files from their creator to the computer that
acts as their server for everyone on the Internet. It
is also commonly used to download programs and
other files from other servers.

FWH: FirmWare Hub.

G
GB: GigaByte: 1,073,741,824 bytes. See Byte.

GUI: Graphical User Interface.

GTS: Global Telecontrol Server.

H
HA: High Availability. Refers to a system or
component that is continuously operational for a
desirably long length of time.

HA CMP: High Availability Clustered
MultiProcessing.

Hard Disk Drive: HDD. See Disk Drive.

Hardware: The physical parts of a system,
including the keyboard, monitor, disk drives, cables
and circuit cards.

Hardware Monitor:  A PAM feature used to
supervise server operation.

HBA: Host Bus Adapter.

HDD: Hard Disk Drive. See Disk Drive.

History File: A file in which the History Manager
logs informative messages or error messages
relating to system activity. Messages are sent from
source components to target components.

History Manager: The component running on the
PAP Windows operating system that logs
messages to history files.

HPB: Hot Plug Board. This board provides an
interlock switch on each IO Box PCI slot for hot–
swapping PCI boards. See P–HPB.

HPC: High Performance Computing.

Hot plugging: The operation of adding a
component without interrupting system activity.

Hot swapping: The operation of removing and
replacing a faulty component without interrupting
system activity.

HTTP:  HyperText Transfer Protocol. In the World
Wide Web, a protocol that facilitates the transfer of
hypertext–based files between local and remote
systems.

HW Identifier: Number (0 – F) used to identify
Cellblock components. This number is identical to
PMB code–wheel position.

I
I2C: Intra Integrated Circuit. The I2C (Inter–IC) bus
is a bi–directional two–wire serial bus that provides
a communication link between integrated circuits
(ICs).
The I2C bus supports 7–bit and 10–bit address
space devices and devices that operate under
different voltages.

IA64: is a 64–bit Intel processor Architecture based
on Explicitly Parallel Instruction Computing (EPIC).
The Itanium processor is the first in the Intel line of
IA–64 processors.

IB: Infini Band.

IC: Integrated Circuit. An electronic device that
contains miniaturized circuitry. See Chip.

ICH4: I/O Control Hub.

ICMB: Intelligent Chassis Management Bus.

ID: A number which uniquely identifies a device on
a bus.

IDE: Integrated Drive Electronics. A type of hard
disk drive with the control circuitry located inside
the disk drive rather than on a drive controller card.

Identity: See Domain Identity.

IIS: Internet Information Server. A group of Internet
servers (including a Web or HTTP server and a
FTP server) with additional capabilities for
Microsoft)  Windows)  NT and Microsoft Windows
(and later) operating systems.

I/O: Input /Output. Describes any operation,
program, or device that transfers data to or from a
computer.

Interface: A connection between a computer and a
peripheral device enabling the exchange of data.
See Parallel Port and Serial Port.

IOB: Input / Output Board. The IOB connects up to
11 PCI–X boards.
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IOC: Input / Output Board Compact. The IOC
connects up to 6 PCI–X boards.

IOL: I/O Board Legacy. The IOL provides:
– I/O controller Hub
– USB ports
– 10/100/1000 Ethernet controller
– Video controller
– Serial / debug port

IOR: I/O Board Riser. The IOR provides:
– I/O controller Hub
– USB ports
– 10/100/1000 Ethernet controller
– Video controller
– Serial / debug port

IP: Internet Protocol. The protocol by which data is
sent from one computer to another via the Internet.
Each computer (known as a host) on the Internet
has at least one IP address that uniquely identifies
it from all other computers on the Internet.

IPD: Internal Peripheral Drawer. The IPD houses
legacy peripherals (DVD–Rom drive, USB port)
and SCSI system disks.

IPF: Itanium Processor Family.

IPL:  Initial Program Load. It defines the firmware
functional phases during the system initialization.

IPMB: Intelligent Platform Management Bus.

IPMI: Intelligent Platform Management Interface.

ISA: Industry Standard Architecture. An industry
standard for computers and circuit cards that
transfer 16 bits of data at a time.

J
Jumper: A small electrical connector used for
configuration on computer hardware.

K
KVM: Keyboard Video Monitor.

KVM switch: the Keyboard Video Monitor switch
allows the use of a single keyboard, monitor and
mouse for more than one module.

L
LAN: Local Area Network. A group of computers
linked together within a limited area to exchange
data.

LD: Logical Disk. A Storeway FDA 1300/2300
logical disk (or LUN) is visible to the OS as a Disk.
See LUN and PD (Physical Disk).

LED: Light Emitting Diode. A small electronic
device that glows when current flows through it.

Legacy Application: An application in which a
company or organization has already invested
considerable time and money. Typically, legacy
applications are database management systems
(DBMSs) running on mainframes or minicomputers.

LPT1 or LPT2: The name assigned to a parallel
port to specify its address. See Parallel Port.

LS240: Laser Servo super diskette holding up to
240 Mb.

LUN: Logical Unit Number. Term used to designate
Logical Storage Units (logical disks) defined
through the configuration of physical disks stored in
a mass storage cabinet.

LVDS: Low Voltage Differential SCSI.

M
MAESTRO: Machine Administration Embedded
Software Real Time Oriented. 
Part of the PAM software package embedded on
the PMB board.

MCA: Machine Check Abort.

Memory: Computer circuitry that stores data and
programs. See RAM and ROM.

Memory bank: The minimum quantity of memory
used by the system. It physically consists of four
memory DIMMs.

MFL: Midplane Fan & Logistics board. The MFL
houses the Fan Boxes and is connected to the MIO
and MQB. See MIO, MQB.

Microprocessor: An integrated circuit that
processes data and controls basic computer
functions.

Midplane: Mid–Plane. All system hardware
components are connected to the Midplane.

MIMD: Multiple Instruction Multiple Data

MIO: Midplane Input / Output board. The MIO
connects one or two IOC boards and the PMB. See
Core Unit.

Mirrored volumes: A mirrored volume is a
fault–tolerant volume that duplicates your data on
two physical disks. If one of the physical disks fails,
the data on the failed disk becomes unavailable,
but the system continues to operate using the
unaffected disk.

Module: a Midplane Board with all its connected
components and utility devices. See CSS Module
and MP.
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MQB: Midplane QBB board. The MQB connects
one or two QBBs and one or two IPDs. See QBB
and IPD.

MSX: Midplane SPS & XPS board. The MSX
houses a B–SPS switch and is connected to the
MIO and the MQB. There are two MSX boards in a
CSS module. All SP connections between a QBB
and an IOC use an MSX. See B–SPS, MIO, MQB.

MTBF: Mean Time Between Failure. An indicator
of expected system reliability calculated on a
statistical basis from the known failure rates of
various components of the system. Note: MTBF is
usually expressed in hours.

Multimedia: Information presented through more
than one type of media. On computer systems, this
media includes sound, graphics, animation and
text.

Multitasking: The ability to perform several tasks
simultaneously. Multitasking allows you to run
multiple applications at the same time and
exchange information among them.

N
NFS: Network File System. A proprietary
distributed file system that is widely used by
TCP/IP vendors. Note: NFS allows different
computer systems to share files, and uses user
datagram protocol (UDP) for data transfer.

NMI: Non–Maskable Interrupt.

NUMA: Non Uniform Memory Access. A method of
configuring a cluster of microprocessors in a
multiprocessing system so that they can share
memory locally, improving performance and the
ability of the system to be expanded.

nsh: nsh stands for new shell. See Shell and EFI
Shell.

NVRAM:  Non Volatile Random Access Memory. A
type of RAM that retains its contents even when
the computer is powered off. See RAM and SRAM.

O
OF:  Open Firmware. Firmware controlling a
computer prior to the Operating System.

Operating System: See OS.

OS: Operating System. The software which
manages computer resources and provides the
operating environment for application programs.

P
PAL: Processor Abstraction Layer. See SAL.

PAM: Platform Administration & Maintenance.

PAM software: Platform Administration &
Maintenance software. One part (PAP application
and the PamSite WEB site) runs on the PAP unit.
The other part (MAESTRO) is embedded on the
PMB board.

PAM Tree pane: One of the three areas of the
PAM web page. Server hardware presence and
functional status are displayed in the PAM Tree
pane. See Status pane and Control pane.

PAP unit: Platform Administration Processor unit.
The PC hosting all server administration software.

PAP application: Platform Administration
Processor application. Part of PAM software, PAP
application is a Windows COM+ application
running on PAP unit.

Parallel Port: Connector allowing the transfer of
data between the computer and a parallel device.

PARM request:  the PARM application is designed
to handle Requests issued by the CSE (Customer
Service Engineer)

Partition: Division of storage space on a hard disk
into separate areas so that the operating system
treats them as separate disk drives.

Password: A security feature that prevents an
unauthorized user from operating the system.

PCI: Peripheral Component Interconnect. Bus
architecture supporting high-performance
peripherals.

PD: Physical Disk. A Storeway FDA 1300/2300
physical disk is not visible to the OS. See LD.

PDU: Power Distribution Unit. Power bus used for
the connection of peripheral system components.

Permanence: Property of a history file that
determines whether or not the history file can be
modified or deleted from the PAM user interface.
Permanence is either Static (cannot be modified) or
Dynamic (can be modified).

P–HPB: PCI Hot Plug Board. This board provides
an interlock switch on each IO Box PCI slot for
hot–swapping PCI boards. See HPB.

PIC: Platform Instrumentation Control.



G-7Glossary

ping: A basic Internet program that lets you verify
that a particular IP address exists and can accept
requests. The verb “to ping” means the act of using
the ping utility or command.

PIROM: Processor Information ROM. Processor
Information ROM (PIROM) contains information
about the specific processor in which it resides.
This information includes robust addressing
headers to allow for flexible programming and
forward compatibility, core and L2 cache electrical
specifications, processor part and S–spec
numbers, and a 64–bit processor number.

PMB: Platform Management Board. Links the
server to the PAP unit.

PNP: Plug aNd Play. The ability to plug a device
into a computer and have the computer recognize
that the device is there.

POST: Power On Self Test. When power is turned
on, POST (Power–On Self–Test) is the diagnostic
testing sequence (or “starting program”) that a
computer runs to determine if hardware is working
correctly.

PROM: Programmable Read-Only Memory.

PUID:  PAM Universal/Unique IDentifier. PAM
software allocates a PUID (PAM Universal / Unique
Identifier) to each hardware / software object to
guarantee unambiguous identification. 
The PUID for each hardware element can be
obtained by hovering the mouse over the
corresponding element in the PAM tree,  e.g.:
PAM:/CELLSBLOCK_<NAME>/MODULE_x/QBB_
y/CPU_y.

Q
QBB: Quad Brick Board. The QBB is the heart of
the Bull NovaScale Server, housing 4 Itanium � 2
processors and 16 DIMMs. Each QBB
communicates with other CSS Module components
via 2 high–speed bidirectional Scalability Port
Switches. 
See SPS or FSS.

R
RAID: Redundant Array of Independent Disks. A
method of combining hard disk drives into one
logical storage unit for disk-fault tolerance.

RAM: Random Access Memory. A temporary
storage area for data and programs. This type of
memory must be periodically refreshed to maintain
valid data and is lost when the computer is
powered off. See NVRAM and SRAM.

RAS: Reliability, Availability, Serviceability.

Real–time clock: The Integrated Circuit in a
computer that maintains the time and date.

RFI: Radio Frequency Interference.

RJ45: 8–contact regular jack.

RMC: Remote Maintenance Console.

ROM: Read-Only Memory. A type of memory
device that is used to store the system BIOS code.
This code cannot be altered and is not lost when
the computer is powered off. See BIOS, EPROM
and Flash EPROM.

RS-232 Port: An industry standard serial port. See
Serial Port.

RSF: Remote Service Facilities.

RTC: Real Time Clock.

S
S@N.IT: SAN Administration Tool.

SAL: System Abstraction Layer. See PAL.

SAN: Storage Area Network. A high–speed
special–purpose network that interconnects
different kinds of data storage devices with
associated data servers on behalf of a larger
network of users.

SAPIC: Streamlined Advanced Programmable
Interrupt Controller message.

SBE: Single Bit Error.

Scheme: Configuration file ensuring optimum use
and compatibility of the physical and logical
resources used to simultaneously run multiple
domains.

SCI: Scalable Coherent Interface.

SCSI: Small Computer System Interface. An input
and output bus that provides a standard interface
used to connect peripherals such as disks or tape
drives in a daisy chain.

SDR: Sensor Data Record.

SDRAM: Synchronous Dynamic Random Access
Memory. A type of DRAM that runs at faster clock
speeds than conventional memory. See DRAM.

SEL: System Event Log. A record of system
management events. The information stored
includes the name of the event, the date and time
the event occurred and event data. Event data may
include POST error codes that reflect hardware
errors or software conflicts within the system.

Serial Communication: Data sent sequentially,
one bit at a time.
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Serial Port: Connector that allows the transfer of
data between the computer and a serial device.
See COM1 or COM 2.Shell is a Unix term for the
interactive user interface with an operating system.

SIO: Server I/O / Super I/O.

Shell: The Shell is the layer of programming that
understands and executes the commands a user
enters. As the outer layer of an operating system,
the Shell can be contrasted with the kernel, the
inmost layer or core of services of an operating
system. See EFI Shell.

SIOH: Server I/O Hub.

SMBIOS: System Management BIOS.

SM–BUS: System Management Bus.

SMIC: Server Management Interface Chip.

SMP: Symmetrical Multi Processor. The processing
of programs by multiple processors that share a
common operating system and memory.

SNC: Scalable Node Controller.

SNM: System Network Module.

SNMP: Simple Network Management Protocol.
The protocol governing network management and
the  monitoring of network devices and their
functions.

Source: Each message refers to a source (the
resource that generated the message) and a target
(the component referred to in the message). This
feature can be allows messages to be filtered
according to one or more Source string(s) and is
particularly useful for debugging and
troubleshooting. See Target.

SPS: Scalability Port Switch. Each CSS Module is
equipped with 2 Scalability Port Switches providing
high speed bi–directional links between system
components. See FSS.

SRAM: Static RAM.  A temporary storage area for
data and programs. This type of memory does not
need to be refreshed, but is lost when the system is
powered off. See NVRAM and RAM.

SSI: Server System Infrastructure.

Status Pane: One of the three areas of the PAM
web page. Provides quick access to CSS Module
availability status, server functional status, and
pending event message information. See also
Control pane and PAM Tree pane.

SVGA: Super Video Graphics Array.

T
Target:  Each message refers to a target (the
component referred to in the message), identified
by its PUID, and a source (the component that
generated the message).This feature allows
messages to be filtered according to one or more
Target string(s) and is particularly useful for
debugging and troubleshooting. See Source and
PUID.

TCP: Transmission Control Protocol. A set of rules
(protocol) used along with the Internet Protocol (IP)
to send data in the form of message units between
computers over the Internet.

TCP/IP: Transmission Control Protocol / Internet
Protocol. The basic communication language or
protocol of the Internet.

T&D: Tests and Diagnostics.

Thresholding: A PAM Event filter criterion.
Thresholding is defined on a Count / Time basis
aimed at routing significant messages only.
Identical messages are counted and when the
number of messages indicated in the Count field is
reached within the period of time indicated in the
Time field, this message is selected for routing.

U
UART: a Universal Asynchronous Receiver
Transmitter. The microchip with programming that
controls a computer interface to its attached serial
devices.

ULTRA SCSI: An enhanced standard 16–bit SCSI
interface providing synchronous data transfers of
up to 20 MHz, with a transfer speed of 40M bytes
per second. It is also called Fast-20 SCSI.

UML: Unified Modeling Language. A standard
notation for the modeling of real–world objects as a
first step in developing an object–oriented design
methodology.

UPS: Uninterruptible Power Supply. A device that
allows uninterrupted operation if the primary power
source is lost. It also provides protection from
power surges.

URL: Uniform / Universal Resource Locator. The
address of a file (resource) accessible on the
Internet.
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USB: Universal Serial Bus. A plug–and–play
interface between a computer and add–on devices.
The USB interface allows a new device to be
added to your computer without having to add an
adapter card or even having to turn the computer
off.

V
VCC: Voltage Continuous Current.

VGA: Video Graphics Array.

VI: Virtual Interface.

Visibility: A property of a history file. Visibility is
either System (the history file is predefined by the
PAM software and is visible only to an
administrator) or User (the history file is created by
an administrator and is visible to both an
administrator and an operator).

VLAN: Virtual Local Area Network. A local area
network with a definition that maps workstations on
some other basis than geographic location (for
example, by department, type of user, or primary
application).

VxWORKS: Platform Management Board
Operating System.

W
WAN: Wide Area Network. Geographically
dispersed telecommunications network. The term
distinguishes a broader telecommunication
structure from a local area network (LAN).

WBEM: Web Based Enterprise Management.

WMI: Windows Management Interface.

WOL: A feature that provides the ability to remotely
power on a system through a network connection.

X
XML: eXtended MarkUp Language. A flexible way
to create common information formats and share
both the format and the data on the World Wide
Web, intranets, and elsewhere.

XSP: eXtended Scalable Port.

Y
No entries.

Z
No entries.
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Index

A
Access, front door, 1-20
Alarm, tamper, 1-20
Archive

history, 4-31
viewing, online, 4-31

Array partition, creating, 5-7
Autocall settings, checking, 4-40
Autocalls

configuring, 5-24
FTP parameters, 5-24

B
Back Up, PAM software, 5-30
BIOS

error messages, C-2
POST codes, 3-48
post codes, C-1

BIOS info, domain, 3-24
Boot

error messages, C-33
options, 5-12

Boot LUN, changing, 3-42
Boot manager, EFI, 5-12

C
Cell

adding a cell to a domain, 3-35
removing a cell from a domain, 3-38

Channels, enabling / disabling, 5-96
Checking

environmental conditions, 4-38
events, 4-39
fault status, 4-39
hardware availability, 4-38
hardware connections, 4-39
histories, 4-39
PMB, 4-41
power status, 4-39
SNMP settings, 4-40
temperature status, 4-39

Checking
Autocall settings, 4-40
MAESTRO version, 4-40
PAM version, 4-40
writing rules, 4-40

Checks, server status, 2-6
Clipping, 5-105
CMOS, error messages, C-35
Components

5085, 1-8
6085, 1-10

Configuration
requirements, assessing, 5-35
saving the current snapshot, 3-11

Configuring, event messaging, 5-85
Connecting to, server domain

Enterprise LAN, 2-22

Web, 2-23
Connection, hardware, 3-48
Console, 1-14

opening / closing, 1-21
toggling, 2-8

CSS , functional status / domain state, 4-36
CSS hardware, functional status, 4-4
CSS Module, PMB, 4-42
CSS module, 1-12

availability status, 2-6, 4-4
power, 4-17
thermal zone, 4-15

Customer information, modifying, 5-23
Customizing, PAM settings, 5-26

D
Data cables

FDA 1x00 FC disk rack, B-5, B-9, B-15, B-21
FDA 1x00 FC extension disk rack, B-6, B-10,

B-15, B-22
FDA 2x00 FC disk rack, B-23
FDA 2x00 FC extension disk rack, B-24
SJ–0812 SCSI disk rack, B-4, B-8, B-13, B-18

Data disks (FC), configuring, 5-8
Data disks (SCSI), configuring, 5-5
Delivery, system, 1-2
Details pane, PAM, 2-7
DIMMs, 1-12
Disk array

creating a new array partition, 5-7
creating a new SCSI disk array, 5-6

Disk subsystem, data disks, 5-8
Disks

array partition, 5-7
configuring FC data disks, 5-8
configuring SCSI data disks, 5-5

Documentation
highlighting, xv
preface, iii
related publications, xvi

Domain
BIOS info, 3-24
deleting, 3-44
dump, 3-20, 3-48
force power OFF, 3-48
force power off, 3-18
functional status, 3-21
hardware resources, 3-26
incidents, 3-47
modyfying configuration, 3-33
power down, 2-9, 2-10, 2-11
power logs, 3-22
power OFF, 3-48
power off, 3-16
power on, 3-14
power ON , 3-48
power up, 2-9, 2-10, 2-11
powering sequences, 3-23
request logs, 3-25
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reset, 3-17, 3-48
Domain configuration, 3-33

adding a cell, 3-35
adding domains, 3-10
removing a cell, 3-38
replacing, 3-10

Domain identity. See identity
Domain manager, 3-2
Domain scheme. See scheme
Domains

configuring, 5-32
incidents, 3-48
managing, 3-1
powering ON / OFF, 4-40
synchronizing, 3-5

Dump, domain, 3-20
DVD/CD–ROM drive, 1-12

E
E–mail

creating an e–mail account, 5-90
creating an e–mail server, 5-88
deleting an e–mail account, 5-91
deleting an e–mail server, 5-89
editing e–mail account attributes, 5-91
editing e–mail server attributes, 5-89

EFI
boot manager, 5-12
boot manager options, 5-12
file transfer protocol, 5-19
manual network configuration, 5-18
network setup and configuration, 5-18
shell, 5-14

EFI boot, options, 5-12
EFI shell

command syntax, 5-14
commands, 5-16
script, 5-16
starting, 5-14

Electrical safety, xix
Enterprise LAN, server domain

Linux, connecting, 2-22
Windows, connecting, 2-22

Environmental conditions, checking, 4-38
Error messages

BIOS, C-2
boot, C-33
CMOS, C-35
miscellaneous, C-35
storage device, C-33
system configuration, C-34

Ethernet hub, 1-19
Ethernet ports, 1-12
Event filter

advanced filtering criteria, 5-105
creating a new filter, 5-111
deleting, 5-112
editing filter attributes, 5-112
preselecting, 5-110
standard filtering criteria, 5-102

Event message, status, 4-4
Event messages

acknowledging, 4-27
consulting, 4-26

customizing, 5-85
e–mail, viewing, 4-28
enabling / disabling channels, 5-96
managing, 4-24
severity, 5-105
severity levels, 4-25
sorting / locating, 4-28
source, 5-105
subscription, 5-85
target, 5-105
viewing, 4-24

Event subscription
See Subscriptions, 5-98
flowchart, 5-87

Events, checking, 4-39
Example scheme

mono–domain
all resources, 5-45
part of resources, 5-53

multi–domain
all resources, 5-61
part of resources, 5-69

Exclude / include, monitoring, 4-13
Excluding

hardware, 4-21
hardware element, 4-39

Excluding , hardware, 4-21
Exclusion, hardware, 3-48
Extended system, configuring, managing, 5-76

F
Fail–over, policy, 1-22
Fault list, monitoring, 4-13
Fault status, checking, 4-39
FDA 1300 disk rack, 1-17
FDA 1x00 FC Disk rack, data cables, B-5, B-9,

B-15, B-21
FDA 1x00 FC extension Disk rack, data cables,

B-6, B-10, B-15, B-22
FDA 2300 FC disk rack, 1-17
FDA 2x00 FC Disk rack, data cables, B-23
FDA 2x00 FC extension Disk rack, data cables,

B-24
Firmware information, 4-15
Force power off, domain, 3-18
Front door, opening, 1-20
FRU information, 4-14
Functional status, CSS hardware, 4-4
functional status, domain, 3-21

G
Getting to know, server, 1-8

H
Hardware

connections, 3-48
excluding, 4-21, 4-39
exclusion, 3-48
including, 4-21, 4-22
limiting access, 5-79

Hardware availability, checking, 4-38
Hardware connections, checking, 4-39
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Hardware faults list
consulting, 4-26
displaying, 4-28

Hardware monitor, CSS module power, 4-17
Hardware resources

checklist, 5-80
domain, 3-26

Highlighting, documentation, xv
Histories

checking, 4-39
creating a user history, 5-93
deleting, 5-95
editing parameters, 5-94

History
archiving, 4-31
viewing, online, 4-29

History / archive, viewing, offline, 4-33
History file, deleting, manually, 4-33
History files

archiving, 4-29
consulting, 4-26
deleting, 4-29
managing, 4-24
viewing, 4-24

I
Identity

checklist, 5-80
copying, 5-44
creating, 5-42
deleting, 5-44
editing, 5-43
managing, 5-42

Illegal characters, xxiii
Incident

investigating, 4-35
what to do, 4-35, 4-38

Incidents
dealing with, 3-48
domain, 3-47

Include / exclude, monitoring, 4-13
Including, hardware, 4-21, 4-22
Indicators

fault status, 4-13, 4-14
failure status, 4-13, 4-14
functional status, 4-7, 4-13
power status, 4-16
presence status, 4-6, 4-13
temperature status, 4-18

Initialization, C-16, C-22, C-23
IOB, 1-12
IOC

jumper status, 4-19
PCI slot status, 4-20

IOL, 1-12
iSM, 5-7, 5-9

K
Keyboard, 1-14
Keys, registry, xxiv
KVM switch, 1-15

L
Laser safety, xx
LEDs, PMB, 4-42
Linux, system users, 5-4
Linux domain, remote access, Web, 2-21
Linux Redhat, remote access, enterprise LAN, 2-19
Linux SuSE domain, remote access, enterprise

LAN, 2-20
LUN

changing the EFI boot, 3-42
creating, 5-9

LUN list, updating, 5-78
LUN properties, modifying, 4-41

M
MAESTRO version, checking, 4-40
Managing

domain configuration schemes, 5-36
domain schemes, 5-42
domains, 3-2

Memory boards, 1-12
Message, severity levels, C-36
Messages, PAM, C-36
MFL, firmware information, 4-15
Microsoft Windows, system users, 5-4
Mirroring, PAP unit, 1-22
Modem, 1-19
Modifying, customer information, 5-23
Modifying, LUN properties, 4-41
Monitor, 1-14
Monitoring

failure status, 4-13, 4-14
fan status, 4-19
fault list, 4-13
fault status, 4-13, 4-14
firmware information, 4-15
FRU information, 4-14
functional status, 4-13
Hardware Search engine, 4-9
hardware status, 4-13
include / exclude, 4-13
jumper status, 4-19
PAM Tree, 4-5
PCI slot status, 4-20
power status, 4-16
presence status, 4-13
server, 4-1, 4-2
Status pane, 4-3
temperature status, 4-18
thermal zones, 4-15

Mother boards, 1-12
Mouse, 1-14

N
Notices

electrical safety, xix
laser safety, xx
safety, xix

NPort Server, 1-19
NVRAM variables, clearing, loading, saving, 5-77
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P
PAM

connection, 2-2
customizing, 5-85
details pane, 2-7
event messaging, 5-85
messages, C-36
simultaneous connection, 2-4
software package, 1-22
status pane, 2-6, 4-3
toolbar, 2-7
tree pane, 4-5
user information, 4-10
user interface, 2-5
writing rules, xxiii

PAM settings, customizing, 5-26
PAM software

acivating a version, 5-28
back up / restore, 5-30
deploying a new release, 5-27
monitoring, 4-2

PAM tree pane, 2-7
PAM version, checking, 4-40
PAM version information, viewing, 4-11
PAP application, rebooting, 3-48, 4-40
PAP unit, 1-13

mirroring, 1-22
PAP users, setting up, 5-21
Partitioning, 5-33
Peripheral drawer, 1-12
PHPB, 1-12
PMB, 1-12

checking, 4-41
code wheels, 4-42
firmware information, 4-15
rebooting, 3-48
resetting, 4-41
testing, 4-41

POST codes
ACPI, C-26
BIOS, C-1
DIM checkpoints, C-24
EFI, C-26
IA–32, C-14
PAM – BIOS interface, C-30
PCI diagnostic, C-25
recovery, C-27
runtime, C-29
SAL–A, C-3
SAL–A hang, C-7
SAL–B, C-9
SAL–B hang, C-11
SAL–F, C-12
SAL–F hang, C-13

Power, CSS module, 4-17
Power cables, 1-13, 1-14, 1-15, 1-16, 1-17, 1-18
Power down, server domain, 2-9, 2-10, 2-11
Power logs, domain, 3-22
Power off, domain, 3-16
Power on, domain, 3-14
Power sequences, domain, 3-23
Power status, checking, 4-39
Power supply cables, server, B-11, B-25

Power–up
server domain, 2-9, 2-10, 2-11
system domains, 2-15, 2-18

Powering ON / OFF, domains, 4-40
Preface, documentation, iii
Processors, 1-12

Q
QBBs, 1-12

R
RAID controller, 1-16
Rebooting, PAP application, 4-40
Related publications, documentation, xvi
Remote access

Enterprise LAN, 2-19
Linux Redhat Domain, 2-19
Linux SuSE domain, 2-20
Windows domain, 2-19

Web, 2-21
Linux domain, 2-21
Windows domain, 2-21

Request logs, domain, 3-25
Reset, domain, 3-17
Resetting, PMB, 4-41
Resources, server, 1-22
Restoring, PAM software, 5-30

S
Safety, notices, xix
Scheme

checklist, 5-80
copying, 5-41
creating, 5-36
deleting, 5-41
editing, 5-39
loading, 3-8
managing, 3-5, 5-36
renaming, 5-41
viewing, 3-6

SCSI JBOD rack, 1-16
SCSI rack, 1-16
Search, hardware, 4-9
Serial ports, 1-12
Server

See also system
domain, 2-9, 2-10, 2-11
getting to know, 1-8
monitoring, 4-1, 4-2
partitioning, 5-33
power supply cables, B-11, B-25
resources, 1-22

Server components
accessing, 1-20
console, 1-14
core unit, 1-12
CSS module, 1-12
DIMMs, 1-12
Ethernet hub, 1-19
Ethernet ports, 1-12
FDA 1300 FC, 1-17
FDA 2300 FC, 1-17
internal peripheral drawer, 1-12
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IOB, 1-12
IOL, 1-12
keyboard, 1-14
KVM switch, 1-15
memory boards, 1-12
modem, 1-19
monitor, 1-14
mother boards, 1-12
mouse, 1-14
NPort Server, 1-19
PAP unit, 1-13
PHPB, 1-12
PMB, 1-12
power cables, 1-13, 1-14, 1-15, 1-16, 1-17,

1-18
processors, 1-12
QBBs, 1-12
RAID controller, 1-16
SCSI JBOD rack, 1-16
SCSI rack, 1-16
serial ports, 1-12
USB ports, 1-12
VGA port, 1-12

Server status, checking, 2-6
Setting up

PAP users, 5-21
system users, 5-4

Severity
event message, 4-25
message, C-36

SJ–0812 SCSI disk rack, data cables, B-4, B-8,
B-13, B-18

Snapshot, saving the current configuration, 3-11
SNMP settings, checking, 4-40
Specifications

NovaScale 5085 Servers, A-2
NovaScale 5165 Server, A-4
NovaScale 6085 Server, A-6
NovaScale 6165 Server, A-8
system, A-1

Status
CSS module, 2-6, 4-4
event message, 4-4
exclude / include, 4-13
failure indicators, 4-13, 4-14
fans, 4-19
fault indicators, 4-13, 4-14
functional, 4-7
functional indicators, 4-13
hardware information, 4-13
IOC jumper, 4-19
PCI slots, 4-20
power, 4-16
presence, 4-5, 4-6
presence indicators, 4-13
temperature indicators, 4-18

Status pane, PAM, 2-6
Storage device, error messages, C-33

String lengths, xxiii
Subscriptions

advanced filtering criteria, 5-105
channels, 5-96
creating, 5-98
deleting, 5-99
e–mail account, 5-90
e–mail server, 5-88
editing attributes, 5-99
filter, 5-111
filtering, 5-110
history, 5-93
prerequisites, 5-86
setting up, 5-86
standard filtering criteria, 5-102
understanding filters, 5-100

Synchronize, domains, 3-5
System

See also server
dimensions, A-1
domains, 2-15, 2-18
weight, A-1

System components, DVD/CD–ROM drive, 1-12
System configuration, error messages, C-34
System users

Linux, 5-4
Microsoft Windows, 5-4
setting up, 5-4

T
Tamper alarm, 1-20
Temperature status, checking, 4-39
Test scheme, 5-41
Testing, PMB, 4-41
Thermal zone, 4-15
Thresholding, 5-105
Toolbar, PAM, 2-7

U
USB ports, 1-12
User group, PAP, 5-21
User interface, PAM, 2-5

V
VGA port, 1-12

W
Web, server domain

Linux, connecting, 2-23
Windows, connecting, 2-23

Windows domain, remote access
enterprise LAN, 2-19
Web, 2-21

Writing rules
checking, 4-40
illegal characters, xxiii
string lengths, xxiii
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